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Renesas Synergy™ Software Package Introduction

Chapter 1 Renesas Synergy™
Software Package Introduction

1.1 Introduction to the SSP User's Manual

This manual describes how to use the Renesas Synergy Software Package for writing applications for
the Synergy microcontroller series. In the figure below, the APl Reference components of the SSP
User's Manual are indicated in blue. Additional components such as the description of the e2 studio
ISDE and tutorials and example applications are included in this manual to guide you through the
steps of programming with the SSP.
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Framework Interfaces '
ThreadX
RTOS Framework (ThreadX-aware

drivers)
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HAL Interfaces '

HAL Drivers

Board Support Package (BSP)

Board MCU
Configuration Configuration

Figure 1: Synergy Software Package (SSP) Documentation

1.2 Subjects Covered in this Manual

To learn about the SSP architecture and about board and chip-level support included in the SSP see:
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e SSP Architecture
e BSP Architecture

For programming with the SSP and an introduction to the e2 studio ISDE see:
e2 studio ISDE User Guide
For introductory tutorials and application examples see:

e Tutorial Blinky
e Application WDT

For Module Overviews describing the SSP Modules, see:

e Framework Layer
e HAL Layer

The API reference documentation of the following SSP components is included in this document:

e Framework Interfaces for Interfaces to the ThreadX-aware Framework Modules

e Framework Layer for ThreadX-aware Framework Driver Modules

e HAL Interfaces for Interfaces to the Hardware Abstraction Layer (HAL) Modules

e HAL Layer for the RTOS-independent HAL driver Modules

e Board Support Package for the Board Support Package (BSP) which includes board-specific
and microcontroller-specific configuration modules
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Chapter 2 SSP Overview

2.1 SSP Overview

% Synergy Software Package (SSP)

Application Programming Interface (API)
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Board Support Package (BSP)

Learn how to develop applications with the Synergy Software Package (SSP) using the SSP's module-
based architecture and the functional software layers. Integrate SSP applications with multiple
boards and Synergy devices using the Board Support Package (BSP).
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The following pages describe the fundamental SSP architecture:

e SSP Architecture
e BSP Architecture

2.1.1 Introduction
2.1.1.1 Purpose

The Renesas Synergy™ Software Package (SSP), part of the Renesas Synergy™ Platform, is a
complete integrated software package designed to provide easy to use, scalable, high quality
software for embedded system design. Using the Synergy Software Platform will reduce time to
market by providing a completely integrated and qualified embedded software platform comprising
of an industry leading, completely optimized and hardened Real-time Operating System (RTOS),
middleware, communication stacks, function libraries, application framework and hardware
abstracted low-level device drivers.

2.1.1.2 Overview
The SSP is divided into four main layers:

e Framework Interfaces The Framework Library connects to Synergy hardware peripherals
through common Interfaces, which abstract the hardware into functional use cases. The
Interface layer is a group of header files with definitions of functions and parameters, so it
consumes no code space.

e Framework Layer The Framework layer consists of RTOS integrated drivers and valuable
application code.

e HAL Interfaces HAL layer Interfaces connect to RTOS-independent HAL-level drivers.

e HAL Layer The HAL layer drivers with hardware registers implement Interfaces.

2.1.1.3 Ease of Use

The SSP provides uniform and intuitive APIs that are well documented. Each module is supported
with detailed user documentation and software datasheet including code size and execution time for
each function.

2.1.1.4 Scalability

Users have the choice to integrate with the platform capabilities using either the Framework
Interface or HAL layer, depending on which best meets the needs of the application. To further scale

each module, build time options such as parameter checking may be compiled out for smaller, more
efficient code.

2.1.2 SSP Architecture

2.1.2.1 Renesas Synergy Software Package (SSP) Architecture

This section describes the Renesas Synergy Software Package (SSP) architecture and how to use the
SSP Application Programming Interface (API).

Introduction to the SSP

As microcontrollers increase in complexity, so does the breadth of knowledge required to make them
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operate in the desired way. The SSP provides an innovative approach to embedded software for loT
applications. With the SSP, you have a new and extremely powerful software interface from the
ground up, making coding fast and providing you with a robust development processes. With this
software, you can create differentiated application code instead of spending months developing
baseline code to interface at the hardware level.

SSP Terms

Term Description Reference

Module Modules can be peripheral SSP Modules
drivers, purely software, or
anything in between. Each
Module consists of a folder with
source code, documentation,
and anything else that the
customer needs to use the code
effectively. Modules are
independent units, but they
may depend on other Modules.
Example SSP Modules are the
UART driver (UART Interface),
Audio Playback Framework,
which relies on timer, DMA, and
DAC drivers (Audio Framework
Interface), or the Messaging
Framework (Messaging
Framework Interface).
Applications can be built by
combining multiple modules to
provide the user with the
features they need.

BSP Short for Board Support BSP Architecture
Package. In the SSP the BSP
provides just enough
foundation to allow other SSP
modules to work together
without issue.
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User’s Manual

Callback Function

This term refers to a function
that is called when an event
occurs. For example, the bus
error interrupt handler is
implemented in the r_bsp. The
user will likely want to know
when a bus error occurs. To
alert the user, a callback
function can be supplied to the
r_bsp. When a bus error occurs
the r_bsp will jump to the
provided callback function and
the user can handle the error.
Interrupt callback functions
should be kept short and be
handled carefully because when
they are called the MCU will still
be inside of an interrupt and
therefore will be delaying any
pending interrupts.

Instances

Interface See SSP Interfaces section: SSP | SSP Interfaces
Interfaces. All interfaces in the
SSP are listed here: Framework
Interfaces and HAL Interfaces

Instance See SSP Instances section: SSP | SSP Instances

Module Instance

Single and independent
configuration of a Module.

designed such that Modules
work together to form a Stack.
Starting with the uppermost
Module and going to the
bottommost dependency forms
a specific Stack.

Application Code that is owned and An example for a simple
maintained by the user. application is included as
Application code may be based | tutorial in this manual: ref
off sample application code application-wdt
provided by Renesas, but is the
responsibility of the user.

Driver A Driver is a specific kind of -
Module that directly modifies
registers on the MCU.

Stacks The SSP architecture is SSP Stacks
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Layer/Level Stacks are made of multiple ref ssp-predefined-layers
layers of Modules. A Layer can
consist of one or multiple
Modules depending on the
requirements of the next Layer
up. Layer and Level are used
interchangeably.

2.1.2.2 SSP Modules

Modules are the core building block of SSP. Modules can do many different things, but all Modules
share the basic concept of providing functionality upwards and requiring functionality from below.

A

Provides

Requires

v

Figure 2: Modules

The amount of functionality provided by a Module is not limited though there are usually points
where separation makes sense. If too much functionality is provided, then reuse of the Module can
become difficult in the future. If not enough functionality is provided, then unnecessary complexity
and overhead may be added in order to make the Modules work as expected.

The simplest SSP application consists of one Module with the user application on top.

Application

SSP Layer 0

Figure 3: Module with application

For simplicity, ignore the Board Support Package (BSP) for now because it is a requirement of any
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SSP project. In the picture above, the BSP is located underneath the bottom layer, SSP Layer 0.

2.1.2.3 SSP Stacks

When modules are layered atop one another, an SSP stack is formed. The stacking process is
performed by matching what one module provides with what another module requires. For example,
the Audio Playback Framework Module requires a Transfer Interface, which can be fulfilled by the
Data Transfer Controller (DTC) Driver Module. Instead of including the DTC code in the Audio
Playback Module, we split these into two modules. This allows for reuse of the underlying modules,
which has many benefits.

Application

Provides: Audio Playback Provides: UART Provides: SD/MMC

Audio Playback UART Driver SD Card Driver

Requires: Transfer Requires: Transfer Requires: Transfer

Provides:lTra nsfer

Figure 4: Stacks - Audio playback

By continuing to add layers to the Stack using SSP Modules, you can interface with the Synergy
hardware at a high level.
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Application

SSP Layer 2 SSP Layer 2

SSP Layer 1 SSP Layer 1

SSP Layer 1

SSP Layer O

SSP Layer O

Figure 5: Stacks

The ability to stack modules has great benefit because it ensures the flexibility of the architecture
as a whole. If modules are directly dependent upon other modules, then issues arise when
application features must work across different user designs. To ensure that modules are reusable
the modules must be capable of being swapped out for other modules that provide the same
features. The SSP architecture provides this flexibility to swap modules in and out through the use of
SSP Interfaces.

2.1.2.4 SSP Interfaces

At the architecture level, Interfaces are the way that Modules provide common features. This
commonality allows Modules that adhere to the same Interface to be used interchangeably.
Interfaces can be thought of as a contract between two Modules. The Modules agree to work
together using the information that was agreed upon in the contract.

On Synergy hardware there is occasionally an overlap of features between different peripherals. For
example, 12C communications can be achieved through use of the IIC peripheral or the SCI
peripheral in its Simple I12C mode. There is a difference in the level of features provided by both
peripherals. In I2C mode the SCI peripheral will only support a subset of the features of the full-
featured IIC.

Interfaces aim to provide support for the common features that most users would expect. This
means that some of the advanced features of a peripheral, such as the IIC, might not be available in
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the Interface. In most cases these features are still available through Interface Extensions.

In design, Interfaces are implemented as header files. All Interface header filenames end with
' api.h'. The following sections detail what makes up an Interface.

SSP Interface Enumerations

Whenever possible, Interfaces use typed enumerations for function parameters and structure
members.

typedef enun e_i2c_addr _node

{
| 2C ADDR MODE 7BIT = 1, // Use 7-bit addressing node

| 2C_ADDR_MODE_10BIT // Use 10-bit addressing node

} i2c_addr_node_t;

Enumerations remove any uncertainty when deciding what values are available for a parameter. Also
note that enumeration options follow a strict naming convention where the name of the type is
prefixed on the available options. Combining the naming convention with the autocomplete feature
available in e? studio provides the benefits of rapid coding while maintaining highly readable code.

SSP Interface Data Structures

At a minimum, all SSP Interfaces include three data structures: a control structure, a configuration
structure, and an instance structure.

The control structure is used as a unique identifier for using the module. If SSP modules were only
peripheral drivers then this control structure might be replaced with a channel number. All function
calls for that module would then take a channel number so that the code could determine which
peripheral channel to operate on. SSP modules are not restricted to device drivers and therefore the
control structure is used. The user allocates storage for a control structure and then sends a pointer
to it into the open() call for a Module. At this point, the Module initializes the structure as needed.
You must then send in a pointer to the control structure for all subsequent module calls. The
contents of the control structure are used by the module and must not be altered. Reading data from
a control structure should also be avoided as the data structure is not guaranteed to remain the
same between SSP releases. In general, you should treat control structures like a black box.

The contents of a control structure are specific to an instance. This means that two instances of the
same interface will have two completely different control structure types. The control structures that

exist in an interface are named <interface>_ctrl_t. Below is an example of the interface control
structure for 12C:

typedef void i2c ctrl _t;

Since all interface control structures are of type void, they cannot be allocated. Instead, these types
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are placeholders for instance control structures. Instance control structures are defined in instance
header files and are named <instance>_instance_ctrl_t. Below are examples of 12C Instance
control structures for the IIC (r_riic) and SCI (r_sci_i2c) peripherals:

/[* riic Instance control structure to be used with |12C Interface. */
typedef struct st _riic_instance ctrl
{

i2c_cfg_t info; // Information describing |2C device

uint32_t open; // Flag to determine if the device is open

void * p_reg; // Base register for this channel

} riic_instance ctrl t;
/* sci _i2c Instance control structure to be used with |2C Interface. */
typedef struct st _sci _i2c_instance ctrl
{
i2c_cfg_t info; // Information describing |2C device
uint32 t open; // Flag to deternine if the device is open
void * p_reg; // Base register for this channel
/* More nenbers specific to sci_i2c Instance. */

} sci_i2c_instance ctrl t;

When using an interface, the instance control structure should be allocated and used in place of the
interface control structure. Using the example above, if the SCI-12C Instance was being used then
you would allocate a structure of type sci_i2c_instance_ctrl_t and use it wherever i2c_ctrl tis
referenced in the Interface. The ISDE will take care of allocating the correct control structure for you.

Dynamic memory allocation through use of the malloc() and free() functions are not used in SSP
modules.

The configuration structure is used for the initial configuration of a module during the open() call.
The structure consists of members such as: channel, interrupt priority, bitrate, and operating mode.
The structure is used purely for input into the module. This structure does not have to be unigque and
could be discarded by you after initialization, if desired.

typedef struct st _i2c cfg
{

/* Ceneric configuration */
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} i2c_cfg_t;

Above is an example configuration structure for the 12C Interface. The last three structure members
(p_callback, p_context, and p_extend) are common to almost all module configurations.

The p_callback and p_context members are described in the SSP Interface Callback Functions
section.

The p_extend member is used for extending the current Interface for a specific Instance. Interfaces
are designed to support the most common features. There are cases where an Instance of an
Interface requires extra information to properly configure itself. There are also cases where the extra
information is not required, but users might need it to adjust the module for their specific
application. When this is the case, the user can provide the underlying Instance with more
configuration information by passing it through the p_extend member. The information that is
passed through this member is defined by the underlying Instance, and therefore the user must
adhere to its structure. If invalid information is passed to the underlying driver, then the Instance is
not able to successfully use the data and proper operation cannot be guaranteed. Refer to the
Interface Extensions section for more information.

It is also important that configuration structures only have members that apply to the current
Interface. If multiple layers in the same stack define the same configuration parameters then it
becomes difficult to know where to modify the option. For example, the baud rate for a UART is only
be defined at the Driver layer. Any layers that use the UART Interface rely on the baud rate being
provided at the Driver layer and do not offer it in their own configuration structures.

SSP Interface Callback Functions

Callback functions allow Modules to asynchronously alert the user application when an event has
occurred. An example for an event is when a byte has been received over a UART channel. Callbacks
are required to allow user application code to react to interrupts. SSP Modules define and handle the
interrupts for Synergy MCU peripherals. If the user tries to define the interrupt service routine at the
same time as a SSP Module, then the code does not build. Therefore SSP Modules allow the user
application to respond to interrupts by registering a function to be called when an interrupt occurs.

Callback functions must be defined in the user application. They always return void and take a
structure for their one parameter. The structure typedef is provided in the Interface for the Module
and is named * _callback _args_t*. The contents of the structure may vary depending on the
Interface, but two members are common: event and p_context.

The event member is used by the application to determine why the callback was called. Using the
UART example again, the callback could have been triggered because a byte was received, all bytes
had been transmitted, or a framing error has occurred. The event member is an enumeration
provided by the Interface.

The p_context member is used for providing user-specified data to the callback function. In many
cases a callback function is shared between multiple channels or Module Instances. When the
callback occurs, the code handling the callback needs context information so that it can figure out
which Module Instance the callback is for. For example, if the callback wanted to make a SSP API call
in the callback, then at a minimum the callback must use the control structure. To make this easy,
the user can provide a pointer to the control structure as the p_context. When the callback occurs,
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the control structure is available as it will be passed in the callback structure.

Callback functions are called from within an interrupt service routine. For this reason callback
functions should be kept as short as possible so they do not affect the real time performance of the
user's system. An example skeleton function for the Flash Interface callback is shown below.

When a Module is not directly used in the user application (it is not the top layer of the stack) then
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its callback function will be handled by the Module above. If there is a Console Interface Module that
requires a UART Interface Module then the Console Module will control and use the UART's callback
function. In this case the user does not need to create a callback function for the UART Module in
their application code.

SSP Interface API Structure
All Interfaces include an API structure which contains function pointers for all the supported Interface

functions. An example structure, with the comments removed, for the Digital to Analog Convert
(DAC) is shown below.

typedef struct st _dac_api

{
ssp_err_t (* open)(dac_ctrl _t * p_ctrl, dac_cfg t const * const p_cfg);
ssp_err_t (* close)(dac_ctrl _t * p ctrl);
ssp_err_t (* wite)(dac_ctrl _t * p_ctrl, dac_size t * p_val ue);
ssp_err_t (* start)(dac_ctrl_t * p_ctrl);
ssp_err_t (* stop)(dac_ctrl _t * p_ctrl);
ssp_err_t (* versionGet)(ssp_version_t * p_version);

} dac_api _t;

The API structure is what allows for Modules to easily be swapped in and out for other Modules that
are Instances of the same Interface. Let's look at an example application using the DAC Interface
above.

Synergy MCUs have an internal DAC peripheral. If the DAC API structure in the DAC Interface were
not used, then the application could make calls directly into the module. In the example below the
application is making calls to the R_DAC_Write function which is provided in the r_dac module.

Application

r_dac
R_DAC_Write()

Figure 6: DAC Write example

Now let's assume that the user needs more DAC channels than are available on the MCU by adding a
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new external DAC module named r_dac_external. The external DAC uses I12C for communications.

The application must now distinguish between the two modules, which adds complexity and further
dependencies to the application.

Application

Ye s—

r dac
R_DAC_Write()

r dac_external
R_DACEXT Write()

Figure 7: DAC Write with two write modules

The use of Interfaces and the API structure allows for the use of an abstracted DAC. This means that
no extra logic is needed and the application no longer depends upon certain hard-coded Modules.

Instead the application now depends on the DAC Interface API which can be implemented by any
number of Modules.
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Application

Internal DAC External DAC1 External DAC 2

Figure 8: DAC Interface

Functions inside of the API structures follow common names. Most Modules will have a pair of open()
and close functions. The open() function must be called before any of the other functions. The only
exception is the versionGet() function which is not dependent upon any user provided information.

Other functions that will commonly be found are read(), write(), get(), and set(). Function names are
designed to be a noun followed by a verb. Example names include:

read(), write(), writeRead()

statusGet()

calendarAlarmSet(), calendarAlarmGet()
accessWindowSet(), accessWindowClear()

SSP Interface Version Information

All Interfaces supply a versionGet() function. This function fills in a structure of type ssp_version_t.
This structure is made up of two versions: one for the Interface (the API) and one for the underlying
Instance that is currently being used.

/* Commpn version structure */

typedef union st _ssp version

{
/* Version id */
uint32 t version_id;
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/* Code version paraneters */

struct

{

uint8 t code version_major; // Code nmmjor version
uint8 t code version_mnor; // Code m nor version
uint8_ t api_version_major; // APl major version
uint8 t api_version_mnor; // APl mnor version

I 5

} ssp_version_t;

The API version ideally never changes, and only rarely if it does. A change to the APl may require
users to go back and modify their code. The code version, the version of the current Instance, may
be updated more frequently. Bug fixes, enhancements, and additional features may all bump the
code version. Changes to the code version will only require changes to the user code if the user code
is using extended features provided by the Instance.

SSP Instances

While Interfaces dictate the features that are provided, Instances actually implement those features.
Each Instance is tied to a specific Interface. Instances use the enumerations, data structures, and API
prototypes from the Interface. This allows for an application that uses an Interface to swap out the
Instance when needed.

On Synergy MCUs some peripherals will have a one-to-one mapping between the Interface and
Instance, while others will have a one-to-many. In the example below the IIC and SPI peripherals map
to only one Interface each while the SCI peripheral implements three Interfaces.
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Interface: UART

Interface: 12C :
r_uart_api.h :

!
|
r_i2c_api.h :

Peripheral:RIIC Peripheral: SC Peripheral: SCl

Module: r _riic Module:r sci_i2c Module:r sci_uart

Interface: SPI
r spi_api.h

Peripheral: SC Peripheral: RSPI

Module:r_sci_spi Module:r_rspi

Figure 9: Instances

SSP Instances API Structure

Each Instance includes a constant global structure with its functions that implement the Interface's
API. The name of this structure is standardized as g__on_. Examples include g_spi_on_spi,
g_transfer_on_dtc, and g_adc_on_adc. This structure is available to be used through an extern in the
instances header file (r_spi.h, r_dtc.h, and r_adc.h respectively).

2.1.2.5 Build Time Configuration

All modules have a build-time configuration header file. Most configuration options are supplied at
run time. Some options that are rarely used, or apply to all instances of a module, may be moved to
build time. The advantage of using a build-time configuration option is to potentially reduce code
size reduction by removing an unused feature. Performance enhancements are also possible. All
modules have at least one build time option, which is whether to enable or disable parameter
checking for the module. SSP modules check function arguments for validity when possible. You may
want to disable this feature when your testing has concluded to save code space and to speed up
execution.

2.1.2.6 Interface Extensions

In some cases, Instances require more information than is provided in the Interface. This situation
can occur in the following two cases:
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e An Instance offers extra features that are not common to most Instances of the Interface.

¢ An Interface must be very generic out of necessity. As an Interface becomes more generic,
the number of possible Instances increases. A prime example of this is the Block Media
Interface.

typedef struct st _sf bl ock nedia cfg

{

ui nt32_t bl ock_size; // Block size in bytes
void * p_extend; // Instance dependent configuration

} sf _block nedia cfg t;

The configuration structure for the Block Media Interface is intentionally sparse. This allows for
nearly endless Instances. Possible Instances include SD card, SPI Flash, SDRAM, USB, and many
more. Different configuration information is needed for each Instance. This is accomplished by
supplying the information through the p_extend parameter. While the configuration data provided in
the p_extend is not the same between Instances, the API calls thereafter will be. This means that the
change is only required in one place.

Use of Interface extensions is not always necessary. Some Instances do not offer an extension since
all functionality is provided in the Interface. In many cases the p_extend member can be set to NULL.
If NULL is provided and the Instance does offer an extension then the Instance will take this to mean
that the default options should be used. The documentation for each Instance indicates whether an
Interface extension is provided and whether its use is mandatory or optional.

2.1.2.7 SSP Predefined Layers

The SSP comes with two predefined layers: the Driver layer and the Framework layer. The layers are
easily identifiable because the modules reside in different folders and have different prefixes. Driver
layer modules are located in the ssp/src/driver folder, while Framework level modules are located in
the ssp/src/framework folder. Modules in the Driver layer start with an r_ prefix, while Framework
level modules start with a sf_ prefix.

The core difference in the functionality between the layers is that Driver layer modules are restricted
to being peripheral drivers that are RTOS aware, but do not use any RTOS objects or make any RTOS
API calls. This means that Driver layer modules can be used in applications with, or without, an
RTOS.

Framework layer modules are free to use RTOS objects such as semaphores, mutexes, or event
flags. Framework modules may also create their own when needed. Framework layer modules that
need to access hardware typically do so through a Driver layer Interface. Exceptions can be granted
in special cases where multiple peripherals need to be used together in a way that would not be
practical through multiple individual Interfaces.

2.1.2.8 SSP File Structure

The high-level file structure of the SSP is shown below.
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ssp
+---inc

\| +---bsp

\'| \| +---cnsis

\'| +---driver

\'| \| +---api

\| \| \\---instances

\'| \\---framework

\'| +---api
\|  +---e€l
\| +---instances

V| \\---tes
---src
+---bsp
\| +---cnBis
\'| \\---ntu
+---driver
\| \\---r_nodul e
\\---framework
\\---sf nodul e
synergy cfg
+---ssp_cfg
+---bsp
+---driver

\\---franework

Directly underneath the base ssp folder the folders are split into the source and include folders.
Include folders are kept separate from the source for easy browsing and easy setup of include paths.
The same set of folders are located in the ssp/inc and ssp/src folders: bsp, driver, and framework.

Apart from the BSP, the SSP's two predefined layers, Driver and Framework, are present. Driver layer
modules are located in the ssp/src/driver folder and Framework layer modules are located in
ssp/src/framework. Under the include tree, the Driver and Framework layer folders contain two
folders each: api and instances. The api folder contains the Interface header files for that layer. The
instances folder contains the Instance header files for that layer. Both layers are flat internally which
limits the number of include paths required for a project.
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The ssp_cfg folder is where configuration header files are stored for each module. Its layout is the
same as the ssp folder where the BSP, Driver, and Framework layers have separate flat directories.
See the Build Time Configuration section for information on what is provided in these header files.

2.1.2.9 SSP Connecting Layers

SSP modules are meant to be both reusable and stackable. It is important to remember that modules
are not dependent upon other modules, but upon other Interfaces. The user is then free to fulfill the
Interface using the Instance that best fits their needs.

Interface: X
SSP Layer 2
Dependency: Y

Interface: Y
SSP Layer 1

Dependency: Z

Interface: Z
SSP Layer 0
Dependency: None

Figure 10: Connecting layers

In the image above Interface Y is a dependency of Interface X and has its own dependency on
Interface Z. Interface X only has a dependency on Interface Y. Interface X has no knowledge of

Interface Z. This is a requirement for ensuring that layers can easily be swapped out. This is shown in
the diagram below:
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FileX Dependency:
FileX 1/0

Interface: FileX I/O
sf_el_fx
Dependency: Block Media

Interface: Block Media Interface: Block Media

sf_block_media_sdmmc sf_block_media_spi_flash
Dependency: SDMMC Dependency: SPI Flash

Interface: SDMMC Interface: Block Media
r_sdmmc sf_spi_flash
Dependency: None Dependency: SPI

Interface: SPI
r_rspi
Dependency: None

Figure 11: Connecting layers with the FileX interface

In this example we are using the Azure RTOS. FileX file system on two storage mediums: SDMMC and
SPI Flash. The SPI Flash Interface takes care of the SPI flash protocol but requires a SPI Interface for
actual SPI bus communications. The SDMMC Interface takes care of the protocol and the bus
communications meaning that it does not have any dependencies.

2.1.2.10 SSP Architecture In Practice

Each layer in the SSP Stack is responsible for calling the API functions of its dependencies. This can
also be described by saying that users are only responsible for calling the API functions at the layer
at which they are interfacing. Using the FileX example above, the user is only responsible for calling
FileX functions in the application code. Internally, FileX then calls FileX 1/0, which in turn calls a Block
Media Interface Module. The Block Media Interface can call multiple drivers. At a minimum an upper
layer Module calls the open() function of the Interface it depends upon.

To write an application using a Module, you must determine the following:

1) Determine which open() function to call. Dependencies are based upon Interfaces which
means that a Module must have some way of discerning which Instance to call.

2) Determine the configuration parameters. The Module also needs to know what
configuration information to pass down. In some cases the Module requires certain
configuration parameters to be set. If this is the case then the module sets these
configuration structure members itself before passing on the rest of the structure. The rest
of the configuration structure members must be provided outside of the Module.
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3) Provide a control structure which is Module Instance specific and therefore can be
allocated by the upper layer module.

Putting this all together means that to interact with a Module Instance, the following is needed:

e A pointer to the Instance's API structure
* A pointer to the Module Instance's configuration structure
* A pointer to the Module Instance's control structure

This information is sufficient to use any module. Notice that the API structure is the only structure
that is Instance specific; not Module Instance specific. This is because the API structure will not vary
between multiple uses of the same Instance. If SPI is being used on SCI channels 0 and 2 then both
Module Instances will use the same API structure while the configuration and control structures will
vary.

To make Module Instances easier to use, all of these pieces are encapsulated in instance structures

found in each Interface. These structures have a standardized name of <interface>_instance_t. An
example from the WDT interface is shown below.

typedef struct st_wdt_instance

{
wdt _ctrl _t * p_ctrl; // Pointer to the control structure for this instance
wdt _cfg t const * p_cfg; // Pointer to the configuration structure for this
i nstance

wdt _api _t const * p_api; // Pointer to the APl structure for this instance

} wdt _instance_t;

Upper layer modules that have a dependency on an Interface can then use the instance structure to
hold everything needed to interact with an Instance of that Interface. Continuing with the WDT
example above, below is the Thread Monitor Framework Interface configuration structure. The
Thread Monitor Interface is dependent upon the WDT Interface.

typedef struct st _sf thread_nonitor_watchdog type

{
wdt _instance t * p_lower Ivl _wdt; // Pointer to | ower |evel watchdog instance
bool profiling node enabl ed; // Enables or disables profiling node
U NT priority; // Priority of thread nonitor thread

} sf _thread_nonitor_cfg t;
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The Thread Monitor module has everything it needs to work with the WDT Interface in the
p_lower Ivl _wdt structure member.

In some cases module dependencies are not be defined in the Interface, but instead in the Instance.
An example is the Block Media Interface could be implemented on SDMCC, SPI Flash, or many other
Instances (also see API Reference section). Because of the wide range of implementations, the
instance structure for a particular Interface cannot be used directly in the Block Media Interface's
configuration structure. The Block Media Interface's configuration structure is shown again below.

typedef struct st _sf bl ock nedia cfg
{
uint32 t block size; // Block size in bytes
void * p_extend; // Instance dependent configuration

} sf_block nedia cfg t;

Notice there are Instance structure pointers provided. The reason for this, as previously mentioned,
is that the Block Media Interface is too generic to enforce a dependency upon a particular Interface.
When a Module is an Instance of a generic Interface, such as Block Media, and it has dependencies
on other Modules, the module puts the lower-layer pointers in an extension structure that is
referenced through the Interface's p_extend configuration member. This is required to allow Module
stacking while not forcing Interfaces to expand and have many optional configuration members.

typedef struct st _block nedia on_sdmt_cfg

{
sdmmt_i nstance_t const * const p_lower |vl _sdmt; // Pointer to SDVMMC i nstance
structure

} sf_block nedia on_sdnmt_cfg_t;

2.1.2.11 Using SSP Modules
This section will give general information on how to use a SSP module.
Pick an Interface

Start by picking an Interface for the functionality that is required. For example, for UART
communications use the UART Interface.

Find a suitable Instance of the Interface

After picking an Interface, choose a suitable Instance. The list of known Instances of an Interface is
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listed in the documentation comments for an Interface. Include the header file of the selected
Instance in the source file of the application that uses the Instance.

Allocate control and configuration structures

The e? studio ISDE provides a graphical user interface for setting the parameters of the Interface and
Instance configuration structures. The ISDE also automatically includes those structures, once they
are configured in the GUI, in application-specific header files that you can include into your
application code.

To see how the ISDE handles the configuration, see Configuring a Project in the ISDE User’s Guide:
Using the e2 studio ISDE

The configuration and control structure types follow standard names of <interface>_ ctrl t and
<interface> cfg t respectively. The ISDE allocates storage for both structures in the application
specific header files, which the ISDE creates. Use the ISDE Properties view to set the values for the
members of the configuration structure as needed. Many members will be typed enumerations in
which case the enumeration can be referenced for available options.

If the Interface has a callback function option, then you first need to declare and define the function
in their source code. The return value is always of type void and the parameter to the function is a
typed structure of name <interface>_callback args_t. Once the function has been defined, assign its
name to the p_callback member of the configuration structure. If any context information is required
in the callback, then the user can provide a pointer to the p_context member. You can assign
callback function names through the ISDE Properties window for the selected Module.

Refer to the Instance documentation to see if an Interface extension is provided. If so, then it will be
found in the Instance's header file and named <interface>_on__cfg_t. It may have several members
just like the Interface's configuration structure. When you select a driver with a specific Instance, you
can select any parameter in the configuration structure of the instance in the ISDE property.

Interact using Interface’s Instance Structure

Once the instance structure has been defined, you can interact with the Instance as needed. Below is
code that builds up an instance structure for the UART Interface as implemented on SCI. Please note
that when using e? studio for Synergy, the following code is automatically generated for the user.
/* Include the header file of the Instance. */
#include "r_sci_uart.h" // This will in turn include the r_uart_api.h Interface
/* Allocate control structure. */
uart _ctrl _t ny uart _ctrl;
/* Setup extended UART configuration on SCI. */
uart_on_sci _cfg_t ny_uart_extended cfg =
{
/* Set extended configuration nenbers... */
I
/* Configure standard UART Interface. */

uart_cfg t ny uart_cfg =
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Now that the instance structure is ready, you can interact with the UART Interface. In e? studio, the
name of the instance structure is the *Name* that you provide when configuring the Module Instance
in the ISDE Properties window.

2.1.2.12 Coding Style
C99 Use

SSP uses the ISO/IEC 9899:1999 (C99) C programming language standard. Specific features
introduced in C99 that are used include standard integer types (stdint.h), booleans (stdbool.h),
designated initializers, and the ability to intermingle declarations and code.
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Use of const in APl parameters

The const qualifier is used with APl parameters whenever possible. An example case is shown below:

ssp_err_t (* open)(flash _ctrl _t * const p_ctrl, flash cfg t const * const p_cfg);

While not fool-proof by any means, this does provide some extra checking inside the SSP code to
ensure that arguments that should not be altered are treated as such.

Weak Symbols

Weak symbols are used occasionally in and with SSP. They are used to ensure that a project builds
even when you have not defined an optional function.

2.1.3 BSP Architecture

This section describes the BSP or Board Support Package. For the APl Reference see Board Support
Package. The BSP is board specific and as a result also MCU specific.

2.1.3.1 What Does the BSP Do?

The BSP is responsible for getting the MCU from reset to the user's application (that is, the main()
function). Before reaching the user's application the BSP sets up the stacks, heap, clocks, interrupts,
and C runtime environment. The BSP also configures and sets up the port I/O pins and performs any
board specific initializations.
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Callback Function This term refers to a function that is called when

an event occurs. For example, the NMI interrupt
handler is implemented in the BSP. The user will
likely want to know when an NMI system
exception occurs. To alert the user, a callback
function can be configured for the group
interrupts (a group of exceptions all of which are
tied to the NMI). When an NMI occurs the BSP
will jump to the provided callback function and
the user can handle the error. Interrupt callback
functions should be kept short and be handled
carefully because when they are called the MCU
will still be inside of an interrupt and therefore
will be delaying any pending interrupts.

2.1.3.3 BSP Directory Structure

The BSP is organized into folders containing MCU, board specific and CMSIS information.

Synergy is CMSIS-compliant and based on the CMSIS-Core. This requires that we follow CMSIS
requirements and naming standards.

Standardized definitions for processor peripherals

NVIC (Nested Vector Interrupt Controller)

Systick (System Tick Timer)

MPU (Memory Protection Unit)

Standardized access functions to access processor features
NVIC_SetPriority()

NVIC EnablelRQ

Standardized function names for system exception handlers
Reset Handler()

SysTick _Handler()

Standardized functions for system initialization.
Systemlnit() - defined in system_S7G2.c for S7G2 MCUs
Standardized software variables for clock speed information
SystemCoreClock

The BSP directory structure is shown below:
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Figure 13: BSP directory structure

2.1.3.4 Configuring the BSP

The BSP is heavily data driven with most features and functionality being configured based on the
content from configuration files. Configuration files represent the settings specified by the user and
are generated by the ISDE when the Generate Project Content button is clicked.

2.1.3.5 BSP Configuration Settings

The table below describes each of the configurable BSP settings. Many of these settings are MCU
specific and there are differences between the settings available for each of the supported MCUs.

Table: BSP Configuration options

BSP Property Description

Part number MCU part number

ram_size_bytes Available RAM in this MCU package

rom_size_bytes Available ROM in this MCU package

data_flash_size_bytes Available Data Flash in this MCU package

package_style Style of package (ie. BGA)

package_pins Number of pins in this MCU package
R11UMO0161EU0160 Revision 1.60 RLENESAS Page 57 /5,198

Mar.29.2024



Synergy Software Package

SSP Overview > SSP Overview > BSP Architecture > BSP Configuration Settings

User’s Manual

series

MCU part series

Main stack size (bytes)

Size of the Main Stack. Must be > 0.

Process stack size (bytes)

Size of the Process Stack. Use of this stack is
optional. If 0, then PSP use is disabled

Heap size (bytes)

Size of the heap in bytes. If 0, the heap is
disabled.

OFSO0 register settings: IWDT Start Mode, IWDT
Timeout Period, IWDT Dedicated Clock
Frequency Divisor, IWDT Window End Position,
IWDT Window Start Position, IWDT Reset
Interrupt Request Select, IWDT Stop Control,
WDT Start Mode Select , WDT Timeout Period,
WDT Clock Frequency Division Ratio, WDT
Window End Position, WDT Window Start
Position, WDT Reset Interrupt Request, WDT
Stop Control

The option-setting memory determines the state
of the MCU after a reset. It is allocated to the
configuration setting area and the program flash
area of the flash memory. See the MCU user
manual for details.

OFS1 register settings: Voltage Detection 0
Circuit Start, Voltage Detection 0 Level, HOCO
Oscillation Enable. S3 MPU has MPU
configuration settings.

See the MCU user manual for details.

MPU - Enable or disable PC Region 0

Start block address for access window protection

MPU - PCO Start, MPU - PCO End, MPU - Enable or
disable PC Region 1, MPU - PC1 Start, MPU - PC1
End, MPU - Enable or disable Memory Region O,
MPU -Memory Region 0 Start, MPU - Memory
Region 0 End, MPU - Enable or disable Memory
Region 1, MPU - Memory Region 1 Start, MPU -
Memory Region 1 End, MPU - Enable or disable
Memory Region 2, MPU - Memory Region 2 Start,
MPU - Memory Region 2 End, MPU - Enable or
disable Memory Region 3, MPU - Memory Region
3 Start, MPU - Memory Region 3 End

Secure MPU ROM register settings. See user
manual for details.

ID code 1, ID code 2, ID code 3, ID code 4

Sets the ID Code for boot mode and debugger
access protection.

MCU Vcc (mV)

Some Modules (e.g. LVD) need to know the
voltage supplied to the MCU. This information is
obtained from here.

Parameter checking

Defines whether the global setting for parameter
checking is enabled or disabled. Local modules
will take this value by default but can be locally
overridden.

Assert Failures

Defines what happens when an assertion failure
occurs.

Error Log

Defines whether or not errors are logged to
ssp_error_log.
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2.1.3.6 BSP Configuration Files

Configuration files are used by the BSP to set up ROM registers, clocks, interrupts, ELC events and
initial pin configurations. These configuration files can be found in ssp_cfg\bsp.

Bsp_cfg.h

This configuration file contains the values for BSP system settings. These are the settings that can
be modified from the ISDE BSP properties tab. They include ROM register settings, stack and heap
size, parameter checking and control of error logging.

Some registers are located in ROM and therefore must be set at compile-time. These include
some option-setting memory (OFS) registers as well as certain memory protection registers.

Option-setting memory determines the state of the MCU after a reset. For example, the IWDT can

be configured and enabled, voltage detection can be enabled, and HOCO oscillation can be

enabled. When these registers are set the operations are completed before the MCU’s reset vector is
fetched and execution begins.

Some Synergy MCUs include a Memory Protection Unit (MPU). The MPU is a programmable

device that can be used to define memory access permissions (i.e. privileged access only or full
access) and memory attributes (for example, bufferable, cacheable) for different memory regions.
The MPU can support up to eight programmable memory regions, each with their own programmable
starting addresses, sizes and settings.

The ISDE configures these memory areas by setting values for the provided MPU settings. You
must be careful when setting these registers. Incorrect settings can prevent access to required
memory areas or prevent access to the MCU entirely.

2.1.3.7 BSP Pin Configuration

You can configure the pins used in your application through the ISDE pin configurator. See
Configuring Pins.

Bsp_pin_cfg.h

This configuration file contains an array of pin configurations. During start-up, and before main()

is executed, the BSP iterates over this array and initializes the MCU's port pins based on the settings
in the array. Initially, before any pin configuration by the user, the ISDE Pins tab displays the initial
reference configuration defined for the selected board type (see Configuring Pins). Once the user
modifies the pin configuration and clicks Generate Project, a new bsp pin_cfg.h file is generated
containing the new pin configuration. The BSP always uses the bsp_pin_cfg.h file from ssp_cfg\bsp as
the source for its pin configuration information, but the pin information generated by clicking
Generate Project is written to a bsp_pin_cfg.h file in the hidden folder ssp_cfg\bsp\.out.

In this way, the user can manually edit the bsp_pin_cfg.h in ssp_cfg\bsp without the fear of the file
being overwritten by the project generation, while the Pin Configuration information generated by
the ISDE also remains available for view or merging with the user’s config file.

2.1.3.8 BSP Clock Configuration

All system clocks are set up during BSP initialization based on the settings in bsp_clock cfg.h. These
settings are derived from clock configuration information provided from the ISDE Clocks tab setting.

e Clock configuration is performed prior to initializing the C runtime environment to speed up

R11UMO0161EU0160 Revision 1.60 RENESANAS Page 59 /5,198
Mar.29.2024



Synergy Software Package

SSP Overview > SSP Overview > BSP Architecture > BSP Clock Configuration

the startup process, as it is possible to start up on a relatively slow (for example, 32 kHz)
clock.
e The BSP implements the required delays to allow the selected clock to stabilize.

Bsp_clock_cfg.h

This configuration file represents the values for system clock settings. These are the settings that
can be modified from the ISDE **Clocks** tab. See: Configuring Clocks

2.1.3.9 System Interrupts

As Synergy MCU’s are based on the Cortex-M ARM architecture, the NVIC Nested Vectored Interrupt
Controller (NVIC) handles exceptions and interrupt configuration, prioritization and interrupt
masking. In the ARM architecture, the NVIC handles exceptions. Some exceptions are known as
System Exceptions. System exceptions are statically located at the top of the vector table and
occupy vector numbers 1 to 15. Vector zero is reserved for the MSP Main Stack Pointer (MSP). The
remaining 15 system exceptions are shown below:

e Reset

e NMI

e Cortex-M4 Hard Fault Handler
e Cortex-M4 MPU Fault Handler
e Cortex-M4 Bus Fault Handler
e Cortex-M4 Usage Fault Handler
e Reserved

e Reserved

e Reserved

e Reserved

e Cortex-M4 SVCall Handler

e Cortex-M4 Debug Monitor Handler
e Reserved

e Cortex-M4 PendSV Handler

e Cortex-M4 SysTick Handler

NMI and Hard Fault exceptions are enabled out of reset and have fixed priorities. Other exceptions
have configurable priorities and some can be disabled.

2.1.3.10 Group Interrupts

Group interrupt is the term used to describe the 12 sources that can trigger the Non-Maskable
Interrupt (NMI). When an NMI occurs the NMI Handler examines the NMISR (status register) to
determine the source of the interrupt. NMI interrupts take precedence over all interrupts, are usable
only as CPU interrupts, and cannot activate the Synergy peripherals Data Transfer Controller (DTC)
or Direct Memory Access Controller (DMAC).

Possible group interrupt sources include:

e [WDT Underflow/Refresh Error
WDT Underflow/Refresh Error
Voltage-Monitoring 1 Interrupt
Voltage-Monitoring 2 Interrupt
VBATT monitor Interrupt
Oscillation Stop is detected
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e NMI pin

e RAM Parity Error

e RAM ECC Error

e MPU Bus Slave Error
e MPU Bus Master Error
e MPU Stack Error

A user may enable notification for one or more group interrupts by registering a callback using the
BSP API function R_BSP_GrouplrgWrite. When an NMI interrupt occurs, the NMI handler checks to see
if there is a callback registered for the cause of the interrupt and if so calls the registered callback
function.

As mentioned earlier, the first 16 slots in the vector table are already accounted for by the system
exceptions. Beginning with slot 16 are user configurable interrupts. These may be external, or
peripheral generated interrupts.

The size of the NVIC interrupt table varies across Synergy MCU types (shown below).

S$7G2 S3A7 S$124
([ initial stack ptr ([ Initial stack ptr Initial stack ptr
Reset Reset Reset
Exceptions NMI Exceptions NMI Exceptions NMI
215 -15 -15
< Hard Fault : < Hard Fault : < Hard Fault
1 1 1
U SysTick L SysTick S SysTick
(] IRQ0 (] IRQ0 (] IRQO
NVIC NVIC
NVIC IRQ 1 interrupts IRQ1 interrupts IRQ 1
interrupts 0 < 0 <
0 < -
. 31
) 63 _ IRQ 31
95 IRQ 63 ~
Q IRQ 95

Figure 14: NVIC Interrupt vector table

Although the number of available slots for the NVIC interrupt vector table may seem small, the BSP
defines up to 512 events that are capable of generating an interrupt. By using Event Mapping, the
BSP maps user enabled events to NVIC interrupts. For an S7G2 MCU, only 96 of these events may be
active at any one time, but the user has flexibility by choosing which events generate the active
event.

The diagram below shows the interrupt vector table for the S7G2:
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S7G2 NVIC
interrupt vector
table
Defined BSP events (T Initial stack ptr
Reset
7| Portoirg NI
Enabled BSP events < Hard Fault
Port 1 IRQ
SysTick
e A Icu IELSRO
0 RTC_ALM IELSR1 NVIC
. = IELSRn interrupts
. registers 3 0
. <
511 SCI0_RXI o .
. ’ 95
S0 e IELSR95
JPEG JDTI
Enabled BSP events

Figure 15: NVIC Interrupt vector table

By allowing the user to select only the events they are interested in as interrupt sources, we are
able to provide an interrupt service routine that is fast and event specific.

For example, on other microcontrollers a standard NVIC interrupt vector table might contain a single
vector entry for the SCIO (Serial Communications Interface) peripheral. The interrupt service routine
for this would have to check a status register for the 'real' source of the interrupt. In the Synergy

implementation there is a vector entry for each of the SCI0O events that we are interested in. The
difference between a standard NVIC table and the Synergy S7G2 NVIC table is shown below:

S7G2 NVIC Interrupt Vector Standard NVIC Interrupt Vector
Table Table

95

Sclo TEI Interrupt handler

Figure 16: NVIC Interrupt vector table example
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Configuration of interrupts is handled by the ISDE. Selecting an interrupt to be used by a module will
generate the code necessary to allocate its entry in the vector table, as well as link it to the proper
ICU ELC event.

When an interrupt occurs one of the very first operations must be to call R_BSP_IrgStatusClear() with
the interrupt number corresponding to the NVIC interrupt slot that was assigned by the BSP. R_BSP_
IrgStatusClear() clears the interrupt status flag (IR) for the given interrupt. When an interrupt is
triggered the IR bit is set. If it is not cleared in the ISR then the interrupt will trigger again
immediately.

Entries that have been assigned a priority (i.e. BSP_IRQ_CFG_ICU_IRQO) in our example, have their
corresponding ‘weak handler’ address placed in the next available vector slot. All of the possible
interrupt sources are iterated over in this manner. Defined interrupts are entered into the vector
table.

BSP Interrupt Configuration File

Bsp_irg_cfg.h is a legacy file that is no longer used and will be removed in the future. Interrupt
configuration is now completely handled by the ISDE.

Vector table entries

System exceptions such as the HardFault_Handler, are defined as weak references. This allows the
user to override the default handler for a particular exception and define their own handler.

All other entries in the vector table are generated by the ISDE using a macro which defines the
vector and a corresponding vector information structure to generate an entries in ROM table linker
sections (.vector.* for vectors and .vector_info.* for vector information).

Note that in CMSIS system_xxxx.c, there is also a weak definition (and a function body) for the Warm
Start callback function R_BSP_WarmStart(). Because this function is defined in the same file as the
weak declaration, it will be called as the ‘default’ implementation. The function may be overridden
by you by copying the body into your application and modifying it as necessary. The linker identifies
this as the ‘strong’ reference and uses it.

Warm start callbacks

As the BSP is in the process of bringing up the board out of reset, there are two points where the
user can request a callback. These are defined as the 'Pre C' and 'Post C' warm start callbacks.

As described above, this function is already weakly defined as R_BSP_WarmStart(), so it is a simple
matter of redefining the function or copying the existing body from CMSIS system_xxxx.c into the
application code to get a callback. R_BSP_Warmstart() takes an event parameter which describes the
type of warm start callback being made.

/* Different warmstart entry locations in the BSP. */

typedef enunm e _bsp warm start event

{
BSP_WARM START PRE C = 0, // Called al nost inmediately after reset.
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/* No C runtine environment, clocks, or IRQG. */
BSP_WARM START POST C // Called after clocks and C runtine environnment have been
set up.

} bsp warmstart_event t;

This function is not enabled/disabled and is always called for both events as part of the BSP startup.
Therefore it needs a function body, which will not be called if the user is overriding it. The function
body is located in system_xxxx. To use this function just copy this function into your own code and
modify it to meet your needs.

Pre C Warm start callback

This callback occurs almost immediately after reset and at this point no C runtime environment,
clocks, or IRQs have been setup.

Why would you be interested in a 'Pre C' warm start callback?
Below are a few examples.
e Execution of safety code (i.e. destructive memory tests) as part of the startup process.
e Examination of global memory as part of a crash dump investigation.
* Preventing re-initialization of an already running RTC.
Post C Warm start callback
This callback occurs after clocks and the C runtime environment have been setup.
Why would you be interested in a 'Post C' warm start callback?
Below are a few examples.
e Run tests that require that clocks have been setup.
e ADC diagnostics.
* ROM/External memory system checks.
2.1.3.11 Custom BSP Board support
Creating a Custom BSP for your own board is not supported in this version of the SSP. For
information on creating a Custom BSP with earlier versions, see application note R11ANOO71EU,
Creating a Custom Board Support Package for SSP v1.2.0 or Later.
2.1.3.12 BSP API functions

The BSP provides public functions, available to any project using the BSP, that allow access to
functionality that is common across BSP supported MCUs and boards.

e R BSP SoftwareLocklnit: The BSP provides API functions to implement atomic locking.
These locks can be used to protect critical areas of code as an RTOS semaphore or mutex
normally would. This function simply initializes a defined lock structure to
BSP_LOCK UNLOCKED

e R BSP_SoftwareLock: Attempts to acquire the lock that has been sent in. The Load-
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Exclusive and Store-Exclusive instructions are being used to perform an exclusive read-
modify-write on the input lock. This process is:
o Use a load-exclusive (LDREXB) to read the value of the lock.
o If the lock is available, then modify the lock value so it is reserved. If not
available, then issue CLREX.
o Use a store-exclusive to attempt to write the new value back to memory.
o Test the returned status bit to see if the write was performed or not.

e R_BSP_SoftwareUnlock: Releases the hold on an existing software lock.

e R_BSP_HardwareLock: Hardware locks are similar to Software locks. In fact, the BSP
Software lock functions are called by the Hardware lock functions. Hardware locks are
specific to a particular peripheral, the list of available hardware locks being defined in
bsp_hw_locks.h. Hardware locks can be used to prevent multiple threads from trying to use
a peripheral that is already in use by a process or thread. For example, when the Flash API
open() function is called, it takes the Flash Hardware lock and keeps it until the Flash API
close is called.

e R BSP HardwareUnlock: Releases the hold on an existing hardware lock. In the Flash
example above, the Flash API close function would call this function.

e R BSP_GrouplrgWrite: Registers a callback function for one of supported group interrupts.
As described earlier, there are 12 of these and they are all mapped to the NMI exception.
When an NMI occurs, the NMI_Handler looks at the NMISR (status register) to determine the
source of the interrupt. If a callback function has been registered for this group interrupt, it
will be called. If NULL is passed for the callback argument, then any previously registered
callbacks are unregistered.

* R BSP _IrgStatusClear: Clears the interrupt status flag (IR) for a given interrupt. When an
interrupt is triggered the IR bit is set. If it is not cleared in the ISR, then the interrupt will
trigger again immediately.

e R BSP SoftwareDelay: Implements a blocking software delay. A delay can be specified in
microseconds, milliseconds, or seconds. The delay is implemented based on the system
clock rate.

e R BSP VersionGet: Returns the version of the BSP.

e R BSP_LedsGet(): Returns information about the LEDs on the board.

e R_BSP_ModuleStop(): Specifies modules whose stop bit should be set.

e R_BSP_ModuleStart(): Specifies modules whose stop bit should be cleared.

e R_BSP_CacheOff(): Turns off the ROM cache, and return it's prior state.

e R BSP_CacheSet(): Sets the cache state to a specific state (on or off).

*» R BSP RegisterProtectEnable: Enables register protection. Registers that are protected
cannot be written to. Register protection is enabled by using the Protect Register (PRCR)
and the MPC's Write-Protect Register (PWPR). The registers that may be protected are
grouped together into one of three groups.

o BSP_REG PROTECT CGC - registers related to the clock generation circuit.

o BSP_REG_PROTECT _OM_LPC BATT - registers related to operating modes, low
power consumption, and battery backup function.

o BSP_REG_PROTECT _LVD - registers related to LVD (Low Voltage Detection)

The BSP register protection functions utilize reference counters to ensure that an application which
has specified a certain register and subsequently calls another function does not have its register
protection settings inadvertently modified.

e Each time RegisterProtectDisable() is called, the respective reference counter is
incremented.

e Each time RegisterProtectEnable() is called, the respective reference counter is
decremented.

Both functions will only modify the protection state if their reference counter is zero.
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As the example below shows, without reference counters, MODULE2 would re-protect the registers

that MODULE 1 had un-protected, preventing MODULE1 from writing them.

#1 - R_MODULEL Open()

[ #2 - R_BSP_RegislerProtectDisable() ] = Duiz T
[ s wnie 10 unprotected regisiors | [ s - r_8sP_Regsierrrowapisabien |
[ #4 - R_MODULEZ_Open() JZ l 6 - White 1o unprotected registers

i
l #7 - R_BSP _n-glslmpm-nsn-u-n J
J

Figure 17: Register protection

e R BSP RegisterProtectDisable: Disables register protection. Registers that are not protected
can be written to. Register protection is disabled by using the Protect Register (PRCR) and
the MPC's Write-Protect Register (PWPR). The register groupings described above still apply.

2.1.4 Key Features

This section describes the key features

2.1.4.1 Azure RTOS ThreadX® RTOS

Multithreaded, deeply embedded, real-time systems
Small, fast Picokernel™ architecture

Multitasking capabilities

Preemptive and cooperative scheduling

Flexible thread priority support (32-1024 priority levels)
Small memory footprint and fast response times
Optimized interrupt handling

Stack Pointer Overflow Monitor

2.1.4.2 Azure RTOS GUIX™

Supports 2D Graphics Acceleration in Hardware
Unlimited objects (screens, windows, widgets)
Dynamic object creation/deletion

Alpha blending and anti-aliasing at higher color depths
Canvas blending

Dithering support

Complete windowing support, including viewports and Z-order maintenance

Multiple canvases and physical displays

Window blending and fading

Screen transitions, sprites, and dynamic animations
Touchscreen and virtual keyboards

Multilingual support with UTF8 string encoding
Automatic size scaling
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8-bit Color Lookup Table (CLUT) support

Touch Rotation

Radial Progress Bar

Endian Neutral

Monochrome through 32-bit true-color with alpha graphics formats
Skinning and Themes

Bitmap compression

GUIX Studio desktop tool and Win32 simulation

Integrated with hardware JPEG/MJPEG decoder

2.1.4.3 Azure RTOS USBX™

e USB 2.0 Full Speed and High-Speed support

* Device class: MSC, HID, CDC-ACM

e Host class: MSC, HID, CDC-ACM, UVC, HUB, Printer, Video
e Supports fast DMA and isochronous transfers

2.1.4.4 Azure RTOS FileX®

MS-DOS compatible file system integrated with ThreadX
FAT12-, 16-, 32-bit support

exFAT

Fault-tolerant file system (uses journaling)

Multiple media instances

LevelX Flash block media driver

LevelX support for NOR Flash on QSPI

2.1.4.5 Azure RTOS NetX™

¢ Integrated with wired (Ethernet) and wireless (WiFi, Cellular) networking interfaces for

Synergy

IPv4 compliant TCP/IP Protocol Stack

Integrated with ThreadX

Zero-copy API

UDP Fast Path Technology

BSD-compatible socket layer

RFC 791 Internet Protocol (IP)

RFC 826 Address Resolution Protocol (ARP)

RFC 903 Reverse Address Resolution Protocol (RARP)
RFC 792 Internet Control Message Protocol (ICMP)
RFC 3376 Internet Group Management Protocol (IGMP)
RFC 768 User Datagram Protocol (UDP)

RFC 793 Transmission Control Protocol (TCP)

RFC 1112 Host Extensions for IP Multicasting

2.1.4.6 Application Frameworks

ADC Periodic framework

Audio Playback framework

Audio Playback HW DAC framework

Audio Playback HW I2S framework

Audio Record framework

Audio Recording HW ADC framework

Block Media Interface for SD Multi Media Card
Block Media LevelX NOR framework
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Block Media QSPI framework

Block Media RAM framework

Block Media SDMMC framework

Bluetooth Low Energy (BLE) framework

Deprecated - Capacitive Touch Sensing Unit framework
Capacitive Touch Sensing Unit framework Version 2
Deprecated - Capacitive Touch Sensing Unit Button framework
Deprecated - Capacitive Touch Sensing Unit Slider framework
Cellular framework

Communications framework on NetX
Communications framework on NetX Telnet
Deprecated - Communications framework on USBX
Communications Framework on USBX version2
Console framework

External Interrupt framework

I12C framework

Inter-Thread Messaging framework

JPEG Decode framework

Memory framework

Port LevelX framework

Periodic Sampling ADC framework

Power Profile Version 2 framework

SPI Framework

Synergy FileX® Port Block Media Interface framework
Synergy GUIX™ Interface framework

Synergy NetX™ Port framework

Synergy USBX™ Port framework

Thread Monitor framework

Deprecated - Touch Panel framework

Touch Panel Version 2 framework

UART framework

Wi-Fi Framework

2.1.4.7 Security Cryptographic (SCE) Library

e True RNG (TRNG)

e SHA1, SHA224/SHA256

e ECC P-192, P-224, P-256 and P-384 curves. Includes APIs for scalar multiplication, key
generation, ECDSA signature generation, and ECDSA signature verification operations
AES 128, 192, and 256-bits ECB, CBC, CTR, GCM, XTS

3DES, 192-bit key, ECB, CBC, CTR

ARC4

RSA up to 2048-bit keys

DLP, DSA up to 2048-bit keys

Encryption/Decryption

Key Generation (plaintext and wrapped keys) and Installation.

Signature Generation and Verification

MD5

2.1.4.8 CMSIS DSP Library

e Basic math functions
e Fast math functions
e Complex math functions
e Filters
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Convolution

Matrix functions
Transforms

Motor control functions
Statistical functions
Support functions
Interpolation functions
Bayes functions
Controller functions
Distance functions
Quaternion functions
SVM functions

Detailed CMSIS library details can be found on
Github: https://github.com/ARM-software/CMSIS 5/releases/tag/5.8.0

2.1.4.9 CMSIS Neural Network Library

Convolution functions
Activation functions
Fully-connected Layer functions
Pooling functions

Softmax functions

Basic math functions
Concatenation functions

NN Support functions

Reshape Functions

SVD Functions

Detailed CMSIS library details can be found on
Github: https://github.com/ARM-software/CMSIS 5/releases/tag/5.8.0

2.1.4.10 AzureRTOS NetX Duo™

e |Pv4 and IPv6 compliant TCP/IP Protocol Stack

* Integrated with ThreadX

* Integrated with wired (Ethernet) and wireless (WiFi, Cellular) networking interfaces for
Synergy

Zero-copy API

UDP Fast Path Technology

BSD-compatible socket layer

RFC 2460 IPv6 Specification

RFC 4861 Neighbor Discovery for IPv6

RFC 4862 IPv6 Stateless Address

RFC 1981 Path MTU Discovery for IPv6

RFC 4443 ICMPv6

RFC 791 Internet Protocol (IP)

RFC 826 Address Resolution Protocol (ARP)

RFC 903 Reverse Address Resolution Protocol (RARP)
RFC 792 Internet Control Message Protocol (ICMP)
RFC 3376 Internet Group Management Protocol (IGMP)
RFC 768 User Datagram Protocol (UDP)

RFC 793 Transmission Control Protocol (TCP)

RFC 1112 Host Extensions for IP Multicasting

RFC 1661 - The Point-to-Point Protocol (PPP)
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2.1.4.11 Azure RTOS NetX™ Applications (IPv4 Networking Services)

DHCP Client and Server

DNS Client

HTTP 1.0 Client and Webserver
HTTP 1.1 Client

FTP Client and Server

TFTP Client and Server

Telnet Client and Server

Auto IP

NAT

SMTP Client

POP3 Client and Server

SNMP Agent

SNTP Client

PPP (Not currently supported by Synergy Configuration tool)

2.1.4.12 Azure RTOS NetX Duo™ Applications (IPv4/v6 Networking Services)

DHCP Client and Server

DNS Client

HTTP 1.0 Client and Webserver
HTTP 1.1 Client

HTTPS Client and Server

FTP Client and Server

TFTP Client and Server

Telnet Client and Server

Auto IP

NAT

SMTP Client

POP3 Client and Server

SNMP Agent

SNTP Client

MDNS/DNS-SD

PPP (Not currently supported by Synergy Configuration tool)

2.1.4.13 Azure RTOS NetX Secure

e TLS v1.2 (RFC 5246) and v1.3 (RFC 8446)

e DTLS v1.2 (RFC 6347)

e RFC 5280 Internet X.509 Public Key Infrastructure Certificate and Certificate Revocation List
(CRL) Profile

e RFC 5280 X.509 PKI Certificates (v3)

e Supports X.509 extensions for Key Usage and Extended Key Usage

e RFC 3268 Advanced Encryption Standard (AES) Cipher suites for Transport Layer Security
(TLS)

e RFC 3447 Public-Key Cryptography Standards (PKCS) #1: RSA Cryptography Specifications
Version 2.1

e RFC 2104 HMAC: Keyed-Hashing for Message Authentication

e RFC 6234 US Secure Hash Algorithms (SHA and SHA-based HMAC and HKDF)

e RFC 8422 Elliptic Curve Cryptography (ECC) Cipher Suites for Transport Layer Security (TLS)
Versions 1.2 and Earlier

e RFC 4279 Pre-Shared Key Cipher suites for TLS

e Supports TLS extensions for:

o Secure Renegotiation Indication
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o Server Name Indication
o Signature Algorithms
e Subject Alternative Name
e Integrated with hardware accelerated Cryptographic library on Synergy

2.1.4.14 Azure RTOS MQTT client for NetX Duo

e Compliant with OASIS MQTT Version 3.1.1

* Provides option to enable/disable TLS for secure communications using NetX Secure in SSP
e Supports QoS and provides the ability to choose the levels that can be selected while

publishing the message
e Supports multiple Instances of MQTT Client Per Device

2.1.4.15 Memory Support

e Flash programming support via JTAG
e Code and Data Flash drivers
e External memory bus support

2.1.4.16 Human Machine Interface (HMI)

e Graphics LCD controller driver
e Segment LCD controller driver
e Capacitive Touch Sensing Unit (CTSU)

2.1.4.17 Hardware Abstract Layer (HAL) Driver Modules

Analog Comparator High-Speed (ACMPHS)
Analog Comparator Low Power (ACMPLP)

Analog Connect Module (ACM)

Analog to Digital Converter (ADC) (12-bit, 14-bit)
Asynchronous General Purpose Timer (AGT)
AGT Input Capture (AGT Input Capture)
Capacitive Touch Sensing Unit (CTSU)

Clock Frequency Accuracy Measurement (CAC)
Clock Generation Circuit (CGC)

Controller Area Network Interface (CAN)

Cyclic Redundancy Check calculator (CRC)

Data Operation Circuit (DOC)

Data Transfer Controller (DTC)

Digital to Analog converter (DAC)

Digital to Analog converter 8-bit (DACS8)

Direct Memory Access Controller (DMAC)

Event Link Controller (ELC)

Flash Memory-High Performance (FLASH_HP)
Flash Memory-Low Power (FLASH_LP)

General Purpose 1/0O Port (GPIO / IOPORT)
General Purpose Timer (GPT)

General PWM Timer with Input Capture (GPT_INPUT_CAPTURE)
Graphics LCD Controller (GLCD)

IEEE 1588 Precision Time Protocol (PTP)

121C (RIIC)

Independent Watchdog Timer (IWDT)

Interrupt Controller Unit (ICU)

JPEG Codec (JPEG_COMMON, JPEG_ENCODE, JPEG_DECODE)
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Keyboard Interrupt Interface (KINT)
Deprecated - Low Power Mode (LPM)

Low Power Mode Version 2 (LPMv?2)

Low Voltage Detection (LVD)

Parallel Data Capture Unit (PDC)

Quad SPI (QSPI)

Real Time clock (RTC)

SD Multi Media Card (SDMMC)

Segment LCD (SLCD)

Serial Communication Interface 12C (SCI_I12C)
Serial Communication Interface SPI (SCI_SPI)
Serial Communication Interface UART (SCI_UART)
Sigma-Delta ADC (SDADC)

Serial Peripheral Interface (SPI)

Serial Sound Interface (SSI)

Watchdog Timer (WDT)

2.1.4.18 GPIO and Key Interrupts

GPIO module
Key Interrupts module
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Chapter 3 Starting Development

To start development with the Renesas Synergy Software Package (SSP), download and install e2
studio, obtain a target Synergy development or evaluation board, and run through the tutorials in
this chapter. The e2 studio ISDE user guide and the tutorials include step-by-step instructions for
getting started with a simple application. To get started with the SSP, refer to these pages:

e e2 studio ISDE User Guide

e Tutorial: Your First Synergy Project - Blinky

e Tutorial: Using HAL Drivers - Programming the WDT
¢ |AR Embedded Workbench for Renesas

e What is Synergy Standalone Configurator (SSC)?

3.1 e2 studio ISDE User Guide

3.1.1 Using the e2 studio ISDE

This section describes how to use the Renesas e? studio Integrated Solutions Development
Environment (ISDE) to develop applications with the Renesas Synergy Software Package (SSP). The
architecture of the SSP directly determines how you use the e? studio ISDE to develop a Synergy
application. See the following documents for details on the SSP architecture included in this manual:

e SSP Architecture
e BSP Architecture

For simple example projects generated and built with e? studio, see:

e Tutorial: Using HAL Drivers - Programming the WDT
e Tutorial: Your First Synergy Project - Blinky

All User Guides in this manual show how to configure a driver and develop an application using the
e? studio ISDE. See:

e HAL Layer for HAL layer user guides
e Framework Layer for Framework layer user guides

3.1.2 What is the e2 studio ISDE?

The Renesas e? studio ISDE, or Integrated Solution Development Environment, is a development tool
encompassing code development, build, and debug. The ISDE is based on the open-source Eclipse
IDE and the associated C/C++ Development Tooling (CDT). Specifically for Synergy MCUs, the ISDE
provides a Graphical User Interface (GUI) with numerous wizards for configuring and auto-generating

R11UMO0161EU0160 Revision 1.60 RENESANS Page 73 /5,198
Mar.29.2024



Synergy Software Package User’s Manual

Starting Development > e2 studio ISDE User Guide > What is the e2 studio ISDE?

code using the Synergy Software Package (SSP). The ISDE also incorporates a smart manual so that
driver and device documentation is available in the form of tooltips right in the code.

e’ studio

2022-10

Starting & studio (E BUILTON
—
Figure 18: e2 studio Splash Screen

Note
The €” studio screens shown in this manual are examples. Some details may differ between different releases of the
€’ studio ISDE and the SSP.

The e? studio ISDE and the Synergy Project Configurator have been developed to make it as easy as
possible to quickly select the SSP modules required for a particular application, include them in a
project, and configure them. The ISDE provides a graphical user interface to configure all elements of
the SSP for the Synergy MCU applications. In addition to HAL and Framework modules, the ISDE can
add and configure RTOS threads, semaphores, mutexes, event flags, and queues. This makes adding
RTOS support to an application very straightforward. Once a project has been generated, you can go
back and reconfigure any of the modules and settings if required. The ISDE generates the complete
and correct configuration code from the selections in the configuration views, so you can focus on
writing the application code.

The elements of the SSP are shown in the Project Explorer view of the e? studio ISDE. All SSP
configuration structures and parameters are mapped to XML files. The XML files enable the ISDE to
present a visual list of configurable options that you can select from. In addition to generating code
to configure the modules, the XML also provides dependency information for modules.

When you add an SSP module to your project, the e? studio ISDE checks the dependencies of this
module and adds all necessary drivers and framework modules to create the appropriate stack. If
there is a dependency that requires you to make a choice, this module is highlighted in the Stack
window and the ISDE guides your selection by showing the available options.
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Threads Configuration _ s
Generate Project Content

Threads 4| New Thread 3| Remove [ MNew Thread Stacks 4| New Stack >
v & HAL/Common
] g_ioport 10 Port Driver on r_ioport P g_sf_audio_playbackD Audio Playback Framework on sf_audio_playback
42 g_fmi FMI Driver on r_fmi
42 g_cge CGC Driver on r_cge @
42 g_elc ELC Driver on r_elc =
~ g Mew Thread T
@ g_sf_audio_playback0 Audio Playback Framewark on s ¥ g_sf_audio_playback_commonl Audio Playback Framework Shared on sf_audio_playback
®
; A
47 g_sf_messaged g{— g_sf_audio_playback_hw{ Audio Playback Hardware Framework Shared on
Messaging sf_audio_playback_hw_dac
< > Framework on
@ sf_message @
New Thread Objects 4| New Object > T 3 T
4 g_transferD Transfer % Add Timer Driver % Add DAC Driver
9 N L]
Driver on r_dtc ELC
SOFTWARE EVENT O
Mew » < Timer Driver on r_agt
& Timer Driver on r_gpt

Figure 19: ISDE Dependency Checking

Errors are flagged next to the Driver name in the HAL/Common Modules or New Thread Modules
pane. You can also review errors in the Problems window.

3.1.3 e2 studio ISDE Prerequisites
3.1.3.1 Obtaining a Synergy Kit
To develop applications with the SSP, start with one of the Renesas Synergy Kits. The Renesas
Synergy Kits are designed to seamlessly integrate with the e? studio ISDE. Several types of kits are
available:

e Development Kit (DK)

e Starter Kit (SK)

e Product Example (PE)

e Target Board (TB)

Ordering information, Quick Start Guides, User Manuals, and other related documents for all Synergy
Kits are available at http://renesassynergy.com.

3.1.3.2 PC Requirements
To use the e? studio ISDE, ensure that your PC meets the following minimum requirements:

e Windows 7 with Intel i5 or i7, or AMD A10-7850K or FX

e Memory: 8 GB DDR3 or DDR4 DRAM (16 GB DDR4/2400 MHz RAM is preferred)

e Minimum 250 GB hard disk
3.1.3.3 Installing e2 studio and the SSP
Detailed installation instructions and installers for the e studio ISDE and the SSP are available on the
Renesas Synergy Gallery website https://synergygallery.renesas.com. Review the release notes for
e? studio to ensure that the e? studio version supports the selected SSP version.

3.1.3.4 Choosing a Toolchain

The e? studio ISDE can work with several toolchains and toolchain versions such as the GNU ARM
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compiler and the IAR toolchain. A version of the GNU ARM compiler is included in the e? studio
installer and has been verified to run with the SSP version.

To use the IAR toolchain for ARM, install IAR Embedded Workbench for Renesas Synergy (EWSYN) (a
license from IAR is required). Before starting a Synergy project with IAR, also install the IAR
Embedded Workbench for ARM Eclipse plugin (using the IAR Embedded Workbench plugin manager
in the 'Help' menu).

3.1.3.5 Adding the IAR Embedded Workbench for Renesas Synergy Compiler into e2
studio

The IAR Embedded Workbench for Renesas Synergy compiler (IAR compiler) can now be used from
within 2 studio. This allows the developer to have the advantages provided by the IAR compiler
without the need to also use the IAR EW for Renesas Synergy ISDE. The installation process involves
installing IAR EW for Renesas Synergy, installing e? studio, and installing the associated IAR plugins
for e? studio. The process is described in the application note found with this search:
https://www.renesas.com/eu/en/document/apn/installing-iar-compiler-e2-studio-application-note

The application note also includes a description of how to migrate a project that originally used e
studio and GCC. It also includes a description of how to migrate a project from IAR 7.x to IAR 8.x so it
will be successfully opened when using e? studio.

3.1.4 What is a Project?

In e? studio, all SSP applications are organized in Synergy projects. Setting up a Synergy project
involves:

1. Creating the project
2. Configuring the project

The e? studio ISDE has many project wizards and configuration windows specifically for Synergy
projects. You can create a new Synergy Project with the Synergy Project Generator or edit the
configuration of an existing project in the Synergy Project Editor.

When you launch e? studio and select a workspace, all projects previously saved in the selected
workspace are loaded and displayed in the Project Explorer view. Each project has an associated
configuration file named configuration.xml which is located in the project’s root directory.

& ProjectExplorer X 55 Y 8 £ O
~ =% blinky_dks7g2 [Debug]
[ Includes
(2 src
(£ synergy
(= seript
= synergy_cfg
x| blinky_dks7g2 Debug.launch
=| R7FS7G27H2AD1CBD.pincfg
5| 57G2-DK.pincfg
(7) Developer Assistance

Figure 20: e2 studio Project Configuration File

Double-click on the configuration.xml file to open the Synergy Project Editor and view or modify all
configuration settings associated with this project. To edit the project configuration, make sure that
the Synergy Configuration perspective is selected in the upper right hand corner of the e? studio
window.
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Note

B | HR C/C++ {5 Synergy Canfiguration

Figure 21: e2 studio Synergy Configuration Perspective

Whenever the Synergy project configuration (that is, the configuration.xml file) is saved, a verbose Synergy Project
Report file (synergy_cfg.txt) with all the project settingsis generated. The format is such that differences can be
easily viewed using a textual difference tool. The generated file islocated in the project root directory.

115 Project Explorer >

~ [z blinky_dks7g2 [Debug]
[ Includes
= sre
(2 synergy
(= script
(== synergy_cfg

LED

configurationxml

$762-DK.pincfg

) i) [ §

() Developer Assistance
1 MyProject

blinky_dks7g2 Debug.launch
RTFS7G27H2A0TCBD.pincfg

=) synergy_cfg.ixt ee—

= B | [E synergy_cfget X
bynergy Configuration
Board "57G2 DK"
R7F57G27H2AB1CED
part_number: R7FS7G27H2A@1CBD
rom_size_bytes: 4194384
ram_size_bytes: 65536@
data_flash_size_bytes: 65536
package_style: BGA
package_pins: 224

=
¥

==y

5762
series: 7

5762 Family
OFS@ register settings: Select fields below

IWDT Start Mode: IWDT is Disabled
IWDT Timeout Period: 2048 cycles
IWDT Dedicated Clock Frequency Divisor: 128
IWDT Window End Position: @% (no window end position)
IWDT Window Start Position: 1@8% (no window start position)
IWDT Reset Interrupt Request Select: Reset is enabled

o
PUMFEFOODR YOS WRNE W0~ WN

WDT Timeout Period: 16384 cycles

WDT Clock Frequency Division Ratio: 128

WDT Window End Position: ¥ (no window end position)

WDT Window Start Position: 188¥ (no window start position)

WDT Reset Interrupt Request: Reset

WDT Stop Control: Stop counting when entering Sleep mode
OFS1 register settings: Select fields below

Voltage Detection @ Level: 2.88 V

WL LR R R R R R R R R R

WRE®8@do 0

Figure 22: Synergy Project Report

HOCO Oscillation Enable: HOCO oscillation is disabled after reset

IWDT Stop Control: Stop counting when in Sleep, Sngoze mode, or Software Standby
WDT Start Mode Select: Stop WDT after a reset (register-start mode)

Voltage Detection @ Circuit Start: Voltage monitor @ reset is disabled after reset

The Synergy Project Editor has a number of tabs. The configuration steps and options for individual
tabs are discussed in the following sections.

Note

Which tabs are available with the Synergy Project Editor depends on the €” studio version.
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15} [blinky_dks7g2] Synergy Configuration < = 0

Summar
¥ Generate Project Content

Project Summary Renesas Synergyw
Board: 57G2 DK
Device: RTFS7TG2TH2A01CBD
Toolchain: GCC ARM Embedded S7G2
Toolchain Version: 10.3.1.20210824
SSP Version: 230
Selected software components
S55P Common Code v2.3.0
Clock Generation Circuit: Provides=[CGC] v23.0
Event Link Controller: Provides=[ELC] v2.3.0
Factory MCU Information Module: Provides=[FMI] v23.0
/0 Port: Provides=[10 Port] v2.3.0
S57G2_DK Board Support Files v2.3.0
Simple application that blinks an LED. No RTOS included v2.3.0
Board support package for RTFS7G27TH2A01CBD v2.3.0
Board support package for S7G2 v23.0
Board support package for STG2 v2.3.0

J;enmz @ @
mergy
Youl D st support i =

Summary | BSP | Clocks | Pins | Threads | Messaging | Components

Figure 23: e2 studio Project Editor

3.1.5 Creating a Project

This section includes step-by-step instructions for creating a Synergy Project. Once you have created
the project, you can easily configure the hardware (clocks, pins, interrupts) and the parameters of all
modules that are part of your application.

To create a new Synergy Project with the Synergy Project Generator, select the project name, select
the hardware for your application, select the toolchain and choose from preconfigured clock, pin, and
MCU related settings by selecting a project template.

3.1.5.1 Creating a New Project

For Synergy applications, always generate a new project as a Synergy Project in the following way:

1. Click on File > New > Synergy C/C++ Project

File Edit Mavigate Search Project RenesasViews Run Window Help

New Alt+Shift+N > Renesas C/C++ Project >
Open File... |~ Synergy C/C++ Project |
(., Open Projects from File System... 9 Project...
Recent Files > o Exemple..
se Edi w
Close Editor Crl+ 9 Other. CtrleN
oo P

Figure 24: New Synergy Project

Then click on the type of template for the type of project you are creating.
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Templates for New Synergy C/C++ Project

R Synergy C E ble Project 2

CCes qenesas A C Evscutable Project for Renesas Synergy.

Renesas Synergy C Library Project
aenesas A C Library Project for Renesas Synergy.

Renesas Synergy C Project Using Synergy Library
aenesas Creotes @ C application project which uses an
existing Synergy library project

Renesas Synergy C++ Executable Project
aenesas A C++ Executable Project for Renesas Synergy.

Renesas Synergy C++ Library Project
aenesas A C++ Library Project for Renesas Synergy.

< >

@ < Back Next > Finish Cancel

Figure 25: New Project Templates

2. Select a project name and location.

3. Click Next.

€2 studio - Project Configuration (Synergy C Executable Project) p—

Specify the new project details. |

Project Toolchains

Project name ‘ blinky_dks7g2] GNU ARM Embedded

Use default location
Location: | C\Users\a513710%\e2_studio\synergy\blinky_dks7g:| |Browse...

Choose file systern: | default

@ < Back Finish Cancel

Figure 26: Synergy Project Generator (Screen 1)

3.1.5.2 Selecting a Board and Toolchain

In the next Project Configuration window select the hardware and software environment:

1. Select the SSP version.

2. Select the Board for your application. You can select an existing Synergy Kit or select

Custom User Board for any of the Synergy devices with your own BSP definition.
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Note

To develop your own BSP, see the following Application Note: "Creating a Custom Board Support
Package" at http://renesassynergy.com.

3. Select the Toolchain version.
4., Select the Debugger. The J-Link ARM Debugger is preselected.

5. Click Next.

@2 studio - Project Configuration (Synergy C Executable Project)

e
Select the board support that you require.
Device Selection
SSP wersion: | 2.3.0 v Board Details
Board: 57G2 DK ~
Device: RTFSTGZ7THZADTCED
Select Tools Available Tools
Taolchain: GNU ARM Embedded ~ GNU ARM Embedded
Toolchain version: | 10.3.1.20210824 ~ 10:3.1.20210824
w Debuggers
Debugger J-Link ARM ~ J-Link ARM
~ RIOS
Express Logic ThreadX
~ Smart Manual
10 Registers Supported
Software Manual Supported
@ <Back Finish Cancel

Figure 27: Synergy Project Generator (Screen 2)

3.1.5.3 Selecting a Project Template

Note

In the next window, select a project template from the list of available templates and click Finish.

If you want to devel op your own application, select a basic template for your board, such as S/G2-DK BSP. You
can add RTOS support at any time while you configure the modules for your project.
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By default, this screen shows the templates that are included in your current SSP pack.

€3 Mo project template has been selected.

e2 studio - Project Configuration (Synergy C Executable Project)

Project Template Selection

[Renesas.Synergy.2.3.0.pack]

O “| Blinky
Q Blinky project.
[Renesas.Synergy.2.3.0.pack]

O *| Blinky with ThreadX
g Threaded version of Blinky project.
[Renesas.5ynergy.2.3.0.pack]

Code Generation Settings
Use Synergy Code Formatter

o “ BSP
g Base Board Support Package for the chosen Synergy family.

Mext >

Finish Cancel

Figure 28: Synergy Project Generator (Screen 3)

When the project is created, the ISDE displays a summary of the current project configuration in the
Synergy Project Editor.

8t [blinky_dks7g2] Synergy Configuration >

= O

Summary

Project Summary

Board: S57G2 DK

Device: R7FSTG2TH2A01CBD
Toolchain: GCC ARM Embedded
Toolchain Version: 10.3.1.20210824

SSP Version: 230

Threads Summary

Property Value
Priority Blinky Thread 1

Selected software components

SSP Commen Code

Clock Generation Circuit: Provides=[CGC]

Event Link Controller: Provides=[ELC]

Factory MCU Information Module: Provides=[FMI]

IO Port: Provides=[10 Port]

Express Logic ThreadX: Provides=[ThreadX]

Simple application that blinks an LED. ThreadX RTOS included
S57G2_DK Board Support Files

Board support package for RTFSTG27H2A01CBD

Board support package for S7G2

Renesas
Symergy @ @
Ylm Tuhg GJHQ'Y'/

v2.3.0
v2.3.0
v23.0
v2.3.0
v23.0
v2.3.0
v23.0
v2.3.0
v2.3.0
v2.3.0

Generate Project Content

Renesas Synergy™ »

Summaryl BSP | Clocks‘ Pins‘ Threadsl Massaging‘ Componentsl

Figure 29: Synergy Project Editor and Available Editor Tabs

R11UMO0161EU0160 Revision 1.60

Mar.29.2024

LLENESAS

Page 81/5,198



Synergy Software Package User’s Manual

Starting Development > e2 studio ISDE User Guide > Creating a Project > Selecting a Project Template

On the bottom of the Synergy Project Editor view, you can find the tabs for configuring multiple
aspects of your project:

e With the BSP tab, you can change board specific parameters from the initial project
selection.

e With the Clocks tab, you can configure the MCU clock settings for your project.

e With the Pins tab, you can configure the electrical characteristics and functions of each port
pin.

e With the Threads tab, you can add SSP modules and drivers for RTOS and non-RTOS
applications and configure the drivers. For each module or driver selected in this tab, the
Properties window provides access to the configuration parameters, interrupt priorities, and
pin selections.

* With the Messaging tab, you can configure the Messaging Framework for ThreadX-based
projects. The Messaging tab is included in e? studio version 5.0 and higher.

e The Components tab provides an overview of the selected modules. You can also add
drivers for specific SSP releases and application sample code here.

3.1.6 Configuring a Project
A project has two levels of configuration.

e The BSP, Clocks, and Pins tabs determine the initial configuration of the MCU after reset and
before any user code is executed. By selecting a project template during project creation,
the ISDE configures default values as appropriate for the selected board. You can change
those default values as needed.

e The Threads allows you to add SSP modules to the project and set the configuration
parameters of the module as needed by the application. Because the Messaging Framework
is an integral part of many ThreadX-based applications, you can configure the Messaging
Framework for each thread requiring messaging in the Messaging tab (for e? studio versions
5.0 and higher).

3.1.6.1 Configuring the BSP with the ISDE

The BSP tab shows the currently selected board (if any) and device. The Properties view is located
in the lower left of the Project Configurations view as shown below.

Note
If the Properties view is not visible, click Window > Show View > Properties in the top menu bar.
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]

Generate Project Content

Board Support Package Configuration
7 Restore Defaults

Device Selection

S5P version: |2.3.0 ~ Board Details
Board: S7G2 DK ~| | g2y
Device: R7FS7G2TH2AD1CBD
SummaCIﬂ{k; Pins | Threads | Messaging | Components
[T Properties < |[£] Problems| @ Smart Browser i = 0
5§7G2 DK
A
Settings Property Value
v R7FSTGZTHZADCED
part_number R7FS7TG2THZA0TCBD
rom_size_bytes 4194304
ram_size_bytes 633360
data_flash_size_bytes £3336
package_style BGA
package_pins 224
v 5762
series 7
v 57G2 Family
OFS0 register settings Select fields below
IWDT Start Mode IWDT is Disabled
IWDT Timeout Period 2048 cycles
IWDT Dedicated Clock Frequency Diviso 128
IWDT Window End Position 0% (ne window end position]
IWDT Window Start Position 100% (no window start position)
IWDT Reset Interrupt Request Select Reset is enabled
IWDT Step Centrol Stop counting when in Sleep, Snooze mode, or Software Standby
'WOT Start Mode Select Stop WOT after a reset (register-start mode)
'WDT Timeout Period 16384 cycles
'WDT Clock Frequency Division Ratio 128
'WOT Window End Position 0% (ne window end position]
'WDT Window Start Position 100% (no window start position) e
< >

Figure 30: ISDE BSP Tab

The Properties view shows the configurable options available for the BSP. These can be changed as
required. The BSP is the SSP layer above the MCU hardware. The ISDE checks the entry fields to flag
invalid entries. For example, only valid numeric values can be entered for the stack size.

When you press the Generate Project Content button, the BSP configuration contents are written
to

synergy cfg/ssp_cfg/bsp/bsp_cfg.h
This file is created if it does not already exist.

Warning
Do not edit this file as it is overwritten whenever the Generate Project Content button is

pressed.
3.1.6.2 Configuring Clocks

The Clocks tab presents a graphical view of the MCU's clock tree, allowing the various clock dividers
and sources to be modified. If a clock setting is invalid, the offending clock value is highlighted in
red. It is still possible to generate code with this setting, but correct operation cannot be guaranteed.
In the figure below, the USB clock UCLK divider has been changed so the resulting clock frequency is
60 MHz instead of the required 48 MHz. This parameter is colored red.
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Clocks Configuration
g Generate Project Content

F Restore Defaults

XTAL 24MHz |- & ICLK Diw /1 <

PLL Src: XTAL v |= PcLKA Div /2 -

PLL Div /2 v |= PCLKB Div 14 v

PLL Mul x20.¢0 v > PCLKC Div /4 <

[ USBMCLK 24MHz | | [PLL24oMbe ! Clock Sre: PLL ¢ PCLKD Div /2 -
HOCO 20MHz v SDCLKout On v

o o
o
\> FCLK Div /4 <

Summary ESPms Threads | Messaging | Components

Figure 31: ISDE Clocks Tab

When you press the Generate Project Content button, the clock configuration contents are
written to:

synergy_cfg/ssp_cfg/bsp/bsp_clock_cfg.h
This file will be created if it does not already exist.

Warning
Do not edit this file as it is overwritten whenever the Generate Project Content button is
pressed.

3.1.6.3 Configuring Pins

The Pins tab provides flexible configuration of the MCU’s pins. As many pins are able to provide
multiple functions, they can be configured on a peripheral basis. For example, selecting a serial
channel via the SCI peripheral offers multiple options for the location of the receive and transmit pins
for that module and channel. Once a pin is configured, it is shown as green in the Package view.

Note
If the Package view window is not open in the ISDE, select Window > Show View > Pin Configurator > Package
from the top menu bar to open it.

The Pins tab simplifies the configuration of large packages with highly multiplexed pins by
highlighting errors and presenting the options for each pin or for each peripheral. If you selected a
project template for a specific board such as the DK-S7G2, some peripherals connected on the board
are preselected.
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8 *[blinky_dks7g2] Synergy Configuration ><

Pins Configuration

Select pin configuration

57G2-DK.pincfg w Generate data: | g_bsp_pin_cfg

Pin Selection Pin Configuration

type filter text

Analog: ANALOG ~

= 8
Generate Project Content

Pins Tutoriel & v &),

me: 5CI8
AHEIOQ:D_AC When using Simple |2C mode, ensure port pins output type is n-ch
Connectivity:CAP open drain,
+ Connectivity:ETH When switching between 12C and other modes, first disable.
Connectivity:IIC
~ w Connectivity:5Cl Selection: Mixed i
scio Mode: Simple SPI v
sCI1
SCI2 it
SCI3 + Ipea i
SCl4
SCI5 ¥ |PBOS ~
SCIE
scir v [Pe03 -
v SClg v |PBOZ i
sClg
Connectivity:5P! Mone
Connectivity:551 Mone
+ Connectivity:USB
Graphics:GLCDC ¥
< > < >
Summary | BSP | Clocks |Pins| Threads | Messaging  Components
[T Properties [£] Problems| @ Smart Browser [ = [&; Pin Conflicts 3 ||E Console
0 itemns
Description
Properties are not available.

Figure 32: ISDE Pins Tab
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The pin configurator includes a built-in conflict checker, so if the same pin is allocated to another
peripheral or I/O function the pin will be shown as red in the package view and also with white cross
in a red square in the Pin Selection pane and Pin Configuration pane in the main Pins tab. The
Pin Conflicts view provides a list of conflicts, so conflicts can be quickly identified and fixed.

In the example shown below, port P105 is already used by the External Memory peripheral, and the
attempt to connect this port to the Serial Communications Interface (SCI) results in a dangling
connection error. To fix this error, select another port from the pin drop-down list or disable the
External Memory peripheral in the Pin Selection pane on the left side of the tab.
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& *[blinky_dks7g2] Synergy Configuration <

= O

Pins Configuration

Generate Project Content

& Package X = 0

CUCRIE R R

1 31 3 . a s
. .
Select pin configuration Pins Tutcna\& - El " Fo2 ||Pams | VsS | uss
o [ios [¥ass [[¥aon [ vee | vee
S$7G2-DK.pincfg &7 Generate data: | g_bsp_pin_cfg
<% v v . .
Fin1 |[Faen |[Frez |Faoe |Face
2 5 3 3 3 o |vee [ vss [|ees [ Vaos [[Face
Pin Selection Pin Configuration
© [Bean [Vone [[Buss || uee | poss
|typef\\tertaxt o 7 _v_Iv_ v
F (et ((Perz (|Pers (| Peoe (|Psoo
» v Ports ~ Module name: sCig < [pan | s | pase | o [ ens
v B Peripherals Usage: When using Simple 12C mode, ensure port pins output type is n-ch
» Analog:ACMP open drain. H voiE || vss || vee | paos | eac
> Analog:ADC When switching between 12C and other modes, first disable. 2 | o || e || s |[pacs | pac
> Analog:ANALOG
> Analog:DAC Pin Group Selection: Mixed ~ K ‘{5:5 ‘;sm fﬁm ‘ﬁm ren7
> Connectivity.CAN Operation Mode: Simple SPI b < %o (oo | eco oo | eoce
» v Connectivity: ETHERC =
» Connectivity:IC Input/Qutput ™ | ss | vee [|Paos f eeot ||Psos
v e COI;;IEOCtIVItyJSU THD: = w [V [[Bues || ¥ice [ Voo [[¥emm
scn RAD: > » [Feos |oon | Voo | oo | Vo
sciz SCK: o & [Furo [¥ao: || race [¥eo | Fo
sci T 2 3 a3 s
5Ci4 CTS: =
SCIs RTFST!
SClg DA Nene - Connertion status:
sci sCL MNone ~ = [y
8 SCi8
sCig
> Connectivity:5PI
> Connectivity: 551
» v Connectivitv:USB e < >
Summary|BSP |C\oc|fs { (<] Pinsl Thraads| Messagmg| Components < >
=

iS5 Properties “_:_ Problems|q;- Smart Brow;er|

Properties are not available,

Figure 33: ISDE Pin Configurator

&; Pin Conflicts > | B Console

v § T8

1 error, 0 warnings, 0 others
~
Description

@ Dangling connection

Module Pin
sCig TXD

The pin configurator also shows a package view and the selected electrical or functional

characteristics of each pin.

Connection Status

Drive Capacity

Output Type

Figure 34: ISDE Pin Configurator
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When you press the Generate Project Content button, the pin configuration contents are written
to:

synergy cfg/ssp_cfg/bsp/bsp_pin_cfg.h
This file will be created if it does not already exist.

Warning
Do not edit this file as it is overwritten whenever the Generate Project Content button is
pressed.

To make it easy to share pinning information for your project, the ISDE exports your pin
configuration settings to a csv format and copies the csv file to synergy _cfg/ssp_cfg/bsp/pincfg <
MCU package>.csv.

3.1.7 Adding Threads and Drivers

Every ThreadX-based Synergy Project includes at least one RTOS Thread and a stack of SSP modules
running in that thread. The Threads tab is a graphical user interface which helps you to add the
right modules to a thread and configure the properties of both the threads and the modules
associated with each thread. Once you have configured the thread, the ISDE automatically generates
the code reflecting your configuration choices.

For any driver or, more generally, any module that you add to a thread, the ISDE automatically
resolves all dependencies with other modules and creates the appropriate stack. This stack is
displayed in the Threads pane, which the ISDE populates with the selected modules and module
options for the selected thread. If there is more than one module that can fulfill a dependency
requirement, the ISDE prompts you to choose a module from a dropdown menu.

For example, when you add the Audio Playback Framework to a thread, you also must pick either the
DAC or the I12S framework for playback:

~

Threads Configuration _ R
Generate Project Content

Threads % New Thread 3] Remove | New Thread Stacks 4| New Stack =

v &% HAL/Common
42 g_elc ELC Driver on r_elc @ g_sf audio_playbackd Audio Playback Framework
- - on sf_audio_playback

42 g_cge CGC Driver on r_cge

42 g_ioport I/0 Port Driver on r_joport @

42 g_fmi FMI Driver on r_fmi ry
~ g Mew Thread I

@ g_sf_audio_playback0 Audio Playback Frame: @® g_sf_audio_playback_commenl Audic Playback
Framework Shared on sf_audio_playback

@
a
I I
< > 4 g_sf_messagell 5 Add Audio Playback
Messaging Hardware
New Thread Objects 4| New Object Framework on
L3 >
- e et @ o message New » @  Audio Playback Hardware Framework Shared on sf_audio_playback_hw_dac
=

& Audio Playback Hardware Framework Shared on sf_audio_playback_hw_i2s

Summary | BSP | Clocks Pins | @ Threads | Messaging | Components

Figure 35: ISDE Project Configurator - Overview

The default view of the Threads tab includes a Common Thread called HAL/Common. This thread
includes the drivers for 1/O control (IOPORT), clock generation circuit (CGC), and the event link

controller (ELC). The default stack is shown in the HAL/Common Stacks pane. The default modules
added to the HAL/Common thread are special in that the SSP only requires a single instance of each,
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which the ISDE then includes in every user-defined thread by default.

In applications that do not use an RTOS or run outside of the RTOS, the HAL/Common thread
becomes the default location where you can add additional drivers to your application.

For a detailed description on how to add and configure modules and threads, see the following
sections:

e Adding and Configuring HAL Drivers
e Adding Drivers to a Thread and Configuring the Drivers

Once you have added a module either to HAL/Common or to a new thread, you can access the
driver’s configuration options in the Properties view. If you added thread objects, you can access
the objects configuration options in the Properties view in the same way.
You can find details about how to configure threads here: Configuring Threads
Note
Driver and module selections and configuration options are defined in the SSP pack and can therefore change
when the SSP version changes.

3.1.7.1 Adding and Configuring HAL Drivers

For applications that run outside or without the RTOS, you can add additional HAL drivers to your
application using the HAL/Common thread. To add drivers, follow these steps:

1. Click on the HAL/Common icon in the Threads pane. The Modules pane changes to
HAL/Common Stacks.

Threads Configuration

o
Click here to add Generate Project Content
new modules.
Threads =] New Thread = HAL/Common Stacks %] MNew Stack >

)
— :E‘HA:_{S:mE mtoﬁnm.e, Thelc 4% g_elc ELC Driver on 4% g_cge CGC Driver on 4% g_ioport /0 Port 4% g_fmi FMI Driver on
42 g_cge CGC Driver on rele r_cge Driver on r_ioport r_fmi
k) g_ioport 17O Port Driver g @ @ @ @
& g_fmi FMI Driver on r_fmi

HAL/Common Objects

Summary | BSP | Clocks PinMassaging Components
Figure 36: ISDE Project Configurator - Adding Drivers

2. Click New Stack to see a drop-down list of HAL level drivers available in the SSP.

3. Select a driver from the menu New Stack > Driver. In addition, you can select a subset of
Framework modules for RTOS independent applications. All other modules can only be
added to a thread when ThreadX is present.
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Threads Configuration

Threads &) Mew Thread = HAL/Common Stacks

~ & HAL/Comman

Generate Project Content

&) Mew Stack

£ g_cge CGC Driver on r_cge
42 g_fmi FMI Driver on r_frmi
¥ g elc ELC Driveron r_elc ®© @

42 g_ioport /0 Port Driver on r_ioport

HAL/Common Objects

<

Summary | BSP | Clacks | Pins | Threads | Messaging| Components

Driver > Analag
4 g.cgc CGC Driveron | | 42 g_fmi FMI Driver on 49 g elcELCD Framework N Conncetivy
- i rele X-Ware > Crypto
@ 4 Search... Graphics
e Input
Monitering
Power
Storage
Systern
Timers

Transfer

Figure 37: Select a Driver

>
>
>
>
>
>
>

> < Flash Driver on r_flash_hp
> 4 QSPI Driver on QSPI
> 4 SD/MMC Driver on r_sdmmc

.

The ISDE creates the stack for the selected driver and alerts you when the driver needs
additional resources that must be enabled. In the case below, you can configure the

interrupt in the Properties view.

Threads Configuration

Threads 4] New Thread = | HAL/Common Stacks &) New Stack >

Generate Project Content

) Remove

~ ¢ HAL/Common
¥ g_cge CGC Driver on r_cge
42 g_fmi FMI Driver on r_fmi
47 g_elc ELC Driver on r_elc [6) @ )

42 g_elc ELC Driveron 42 g ioport 1/0 Port
relc Driver on r_ioport

@ g_flashO Flash Driver
on r_flash_hp

A stack element with a bar of this color indicates 'g_flash0 Flash Driver on r_flash_hp' is a Synergy module instance.

42 g_ioport 1/O Port Driver on r_ioport

This instance may be referenced by ene other Synergy module instance only.

@ g_flashO Flash Driver on r_flash_hp

< >

HAL/Common Objects

<

Summary | 85P | Clocks |Pins | @ Threads | Messaging| Components

[T Properties % |2l Problems| @ Smart Browser 3§
g_flashO Flash Driver on r_flash_hp
0 items

Settings  Property Value
APIInfq | ¥ Commen

Parameter Checking Default (BSP)

Code Flash Programming Enable Disabled

~ Module g_flash0 Flash Driver on r_flash_hp

Name q flashd

Data Flash Background Operation Enabled

Callback NULL

Flash Ready Interrupt Priority Disabled

Flash Error Interrupt Priority Disabled

Figure 38: Dependency Checking on the Threads Tab

Description

Error: Interrupts must be enabled if BGO is enabled.

= B || PinConflicts x| = O

7 8

4. Select the driver module in the HAL/Common Modules pane and configure the driver

properties in the Properties view.

The ISDE adds the following files when you click the Generate Project Content button:

e The selected driver module and its files to the synergy/ssp directory.
e The main() function and configuration structures and header files for your application as

shown in the table below.
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File Contents Overwritten by Generate
Project Content?
src/synergy_gen/main.c Contains main() calling Yes
generated and user code. When
called, the BSP already has
initialized the MCU.
src/synergy_gen/hal_data.c Configuration structures for HAL | Yes
Driver only modules.
src/synergy_gen/hal_data.h Header file for HAL driver only | Yes
modules.
src/hal_entry.c User entry point for HAL Driver |No
only code. Add your code here.

The configuration header files for all included modules are created or overwritten in this folder:

synergy_cfg/ssp_cfg/driver

3.1.7.2 Adding Drivers to a Thread and Configuring the Drivers

For an application that uses the ThreadX RTOS, you can add one or more threads, and for each
thread at least one module that runs in the thread. You can select modules from either the Driver or
Framework dropdown menu. To add modules to a thread, follow these steps:

1. In the Threads pane, click New Thread to add a Thread.

Threads Configuration

Threads

| 4| New Thread |5U Remove = MNew Thread Stacks

v & HAL/Common
42 g_cge CGC Driver on r_cge
42 g_fmi FMI Driver on r_fmi
42 g_elc ELC Driver on r_elc

48
g

<

£ l/0 Port Driver on r_ioport

| L) ) pasting here from the clipboard.

New Thread Objects

4| Mew Object >

Summary | BSP | Clocks | Pins | Threads | Messaging | Components

=) Properties [£! Problems @ Smart Browser

New Thread

Property
~ Thread
Symbol
MName
Stack size (bytes)
Priority
Auto start

Settings

B4

Value

new threadd
1024

]

Enabled

Time slicing interval (ticks) 1

Figure 39: Adding a new RTOS Thread on the Threads Tab

Enter the name of your
Thread here. Example:
My Thread

o

Generate Project Content

&) New Stack >

Add Synergy stacks to the selected thread by using the ‘New Stack > toolbar button (above), or by

Module

2. In the Properties view, click on the Name and Symbol entries and enter a distinctive
name and symbol for the new thread.
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Note
The ISDE updates the name of the thread stacks pane to My Thread Stacks.
3. In the My Thread Stacks pane, click on New to see a list of modules and drivers. Both

Framework-level Modules and HAL-level drivers can be added here.
My Thread Stacks

Add Synergy stacks to the selected thread by using the 'New Stack >' toolbar buttor

Driver > |

| cipboard. Framework > Analog >
- 4+ Audio Playback Framework Shared on sf_audio_playback Audio »
I+ Audio Playback Framework on sf_audio_playback Connectivity >

4 Audio Playback Hardware Framework Shared on sf_audio_playback_hw_dac Crypto 3

4 Audio Playback Hardware Framework Shared on sf_audio_playback_hw_i2s File System »

4 Audio Record ADC Framework on sf_audio_record_adc Graphics »

4 Audio Record 125 Framework on sf_audio_record_i2s Input 3

LevelX >

Memory »

Networking >

Services »

Figure 40: Adding Modules and Drivers to a Thread

4. Select a module or driver from the list.
5. If the module or driver indicates a dependency, select the missing resources.

My Thread Stacks 4| Mew Stack >

& g_sf_audio_playback Audio Playback Framework
on sf_audio_playback

@

-
I

ﬂbu g_sf_audio_playback_comrmon0 Audio Playback
Framewaork Shared on sf_audio_playback

@

[ I
42 g_sf_messagel 5 Add Audio Playback
Messaging Hardware
Framework on
@ sf_message

Mew s 4 Audio Playback Hardware Framework Shared on sf_audio_playback_hw_dac
3 & Audio Playback Hardware Framework Shared on sf_audio_playback_hw_i2s

Figure 41: Identifying Module or Driver Dependencies on the Threads Tab

6. Click on the added driver and configure the driver as required by the application by
updating the configuration parameters in the Properties view. To see the selected module
or driver and be able to edit its properties, make sure the Thread containing the driver is
highlighted in the Threads pane.
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Threads &) New Thread 52 Remove [5] | My Thread Stacks &) New Stack > ) Remave
v & HAL/Common A
4 g_cge CGC Driver on r_cge @
4% g_fmi FMI Driver on r_fmi
4 g_elc ELC Driver onr_glc T - T
4 g_ioport I/0 Port Driver on r_ioport 49 g_sf_messagel @ g_sf_audio_playback_hw0 Audio Playback Hardware Framework Shared on
~ g My Thread Messaging sf_audio_playback_hw_i2s
@ 9_sf_audio_playbackl Audio Playback Framework on sf_audio Framework on
@ sf_message @
Y
I
E’ﬂj g_i2s0 [25 Driver on r_ssi
< >
X ® A stack element with a bar of this color indicates 'g_i2s0 125 Driver on r_ssi' is a Synergy module instance,
My Thread Objects 4] New Object > L This instance may be referenced by one other Synergy module instance only.
£ g Error: Requires Transmit Interrupt (TXI) enabled or Receive Interrupt (RXI) enabled
- = TP
SOFTWARE EVENT O SOFTWARE EVENTO
@
v
Summary | BSP | Clocks | Pins | @ Threads | Messaging | Components
[ Properties ¢ |[Z] Problems @ Smart Browser 4 § = O ||[&s Pin Conflicts = g
P ]
: : : 0it
g_i2s0 125 Driver on r_ssi fems =
. = - Description Module Pin Location Re
Settings Data Bits 168!6
Word Length 16 Bits
ABLnfoy W5 Continue Mode Disabled
Audio Clock External
Mame of (25 callback function to be de (51 NULL
Transmit Interrupt Pricrity Disabled
Receive Interrupt Priority Disabled
Idle/Error Interrupt Priority Priority 12

Figure 42: Configuring Module or Driver Properties

7. If needed, add another thread by clicking New in the Threads pane.

When you press the Generate Project Content button for the example above, the ISDE creates the
files as shown in the following table:

File Contents Overwritten by Generate
Project Content?

src/synergy_gen/main.c Contains main() calling Yes
generated and user code. When
called the BSP will have
initialized the MCU.

src/synergy_gen/my_thread.c Generated thread “my_thread” |Yes
and configuration structures for
modules added to this thread.

src/synergy_gen/my_thread.h Header file for thread Yes
“my_thread”

src/synergy_gen/hal_data.c Configuration structures for HAL | Yes
Driver only modules.

src/synergy_gen/hal_data.h Header file for HAL Driver only |Yes
modules.

src/hal_entry.c User entry point for HAL Driver | No
only code. Add your code here.

src/my_thread_entry.c User entry point for thread No
“my_thread”. Add your code
here.
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The configuration header files for all included modules and drivers are created or overwritten in the
following folders:

synergy cfg/ssp_cfg/driver
synergy cfg/ssp_cfg/framework
3.1.7.3 Configuring Threads

If the application uses the ThreadX RTOS, the Threads tab can be used to simplify the creation of
ThreadX threads, semaphores, mutexes, and event flags.

The components of each thread can be configured from the Properties view as shown below.

[ Properties < | [2 Problems @ Smart Browser

My Thread

Settings Property Value
w Thread
Symbol new_thread(
Mame My Thread
Stack size (bytes) 1024
Priority 1

Auto start Enabled
Time slicing interval (ticks) 1

Figure 43: ISDE Thread Properties

The Properties view contains settings common for all Threads (Common) and settings for this
particular thread (Thread).

For this thread instance, the thread’s name and properties (such as priority level or stack size) can
be easily configured. The ISDE checks that the entries in the property field are valid. For example,
the ISDE ensures that the field Priority, which requires an integer value, only contains numeric
values between 0 and 9.

To add ThreadX resources to a Thread, select a thread and click on New Object in the Thread
Objects pane. The pane takes on the name of the selected thread, in this case My Thread Objects.
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Threads Configuration
9 Generate Project Co

Threads 4] New Thread -] Remove [ My Thread Stacks 4] New Stack »
~ gt HAL/Common
4 q_cqc CGC Driver on r_cge & g_sf_audio_playback0 Audic Playback Framework on sf_audio_playback
42 g_fmi FMI Driver on r_fmi
47 g_elc ELC Driver on r_elc @
42 g_joport |/0 Port Driver on r_ioport =
~ & My Thread I
da i i 4% g_sf_audio_playback_common0 Audio Playback Framework Shared on sf_audio_playback
4 g_sf_audio_playbackd Audio Playback Framework on f_g 9 playl y playl
Click to add new \‘
Thread Objects to I - T
My Thread. 4 g_sf_audio_playback_hw0 Audia Playback Hardware Framework Shared on
sf_audio_playback_hw_i2s
< Framewaork on
@ sf_message @
My Thread Objects | 4] New Obin-+ | 5 B T
& | Event Flags P .
& g_i2s0 125 Driver on r_ssi
& g_new_event_flags0 Event Flags ® Mutex
@ g_new_queuel Queue s G
@ g_new_queue] Queue HELS €3]
@® Semaphore Y
[ [ [
| 4% g_transferD Transfer | | 4% g_transfer! Transfer | | & Add Timer Driver |

Summary | BSP | Clocks |Pins | Threads | Messaging | Components

[ Praperties > |[2] Problems| @ Smart Browser r# & = O | [%4Pin Conflicts 7 §
Dit
g_new_queuel Queue fems =
Description Module Pin Locat
Settings Property Value
| Name New Queue |
Symbol g_new_queuel
Message Size (Words) 1
Queue Size (Bytes) 20

Figure 44: Configuring Thread Object Properties

Make sure to give each thread object a unique name and symbol by updating the Name and
Symbol entries in the Properties view.

3.1.7.4 Configuring Interrupts

You can use the Properties view in the Threads tab to enable interrupts by setting the interrupt
priority. Select the thread in the Threads pane to view and edit its properties.

R11UMO0161EU0160 Revision 1.60 RENESANS Page 94 /5,198
Mar.29.2024



Synergy Software Package

User’s Manual

Starting Development > e2 studio ISDE User Guide > Adding Threads and Drivers > Configuring Interrupts

Threads Configuration

Threads 4| Mew Thread

#-| Remove [

N !':3' HAL/Common

¥ g_cgc CGC Driver on r_cge

4 g_fmi FMI Driver en r_fmi

42 g_elc ELC Driver on r_elc

4 g_ioport |/0 Port Driver on r_ioport
~ g My Thread

<

E.ﬂ— g_sf_audio_playbackl Audio Playback Framework on sf_g

2>

My Thread Objects &) New Object > 5] Remove

® g_new_event_flags0 Event Flags
@ g_new_queuel Queue
@ g_new_queuel Queue

Summary BSP | Clocks |Pins | €3 Threads| Messaging Compenents

[T Properties < |[£] Problems| @ Smart Browser

g_i2s0 125 Driver on r_ssi

— ‘Word Length
Settings ‘W5 Continue Mode
APl Info Audio Clock

16 Bits
Disabled
External

Name of 125 callback function to | (51 NULL

Transmit Interrupt Priority Disabled
Receive Interrupt Priority Disabled
Idle/Error Interrupt Pricrity Priority 12

0

Generate Project Content

My Thread Stacks 4| Mew Stack > | Remove

4 g_sf_audio_playback0 Audic Playback Framework on sf_audio_playback

@

Y
I

42 g_sf_audio_playback_commen0 Audio Playback Framework Shared on sf_audio_playback

@
A
[ [
-7 g_sf_messagel b g_sf_audio_playback_hw0 Audic Playback Hardware Framework Shared on
Messaging sf_audio_playback_hw_i2s
Framework on
@ sf_message @
Y

é{% g_i2s0 125 Driver on r_ssi

@
=1 A stack element with a bar of this color indicates 'g_i2s0 125 Driver on r_ssi' is a Synergy module instance.
— | Thisinstance may be referenced by one other Synergy module instance only.
@ Error: Requires Transmit Interrupt (TXI) enabled or Receive Interrupt (RXI) enabled I
SOFTWARE EVENTO SOFTWARE EVENTO
@ @

r# § = B | [%Pin Conflics % N
Ditems
Description Module Pin Location

Figure 45: Configuring Interrupt on the Threads Tab

3.1.8 Configuring the SSP Messaging Framework

The Messaging Framework extends the ThreadX messaging queue functionality and is one of the
most important SSP modules. It provides the mechanism for threads to communicate with each other
through exchanging messages. The Messaging Framework allows threads to send (publish) or listen
to (pend on) messages when preconfigured or user-configured Events happen. Any thread can
publish a message with an attached Event Class that all threads subscribing to this Event class can
listen to and act upon. The list of Threads that can listen to a specific Event Class is called the

Subscriber List for that Event Class.

To use the Messaging Framework, you first must add one Messaging Framework instance in the
Threads tab. You may add the Messaging Framework to any thread which is not the HAL/Common
thread. All threads in your project can use this instance to communicate with each other. Some
modules like the Audio Playback Framework require the Messaging Framework and add it
automatically to the stack as shown below for the Audio Playback Framework. If your project includes
a thread with such a module, you do not need to add another instance of the Messaging Framework
even if you add more threads to your application. All threads can share one instance of the

Messaging framework.
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Threads & 5 My audio thread Stacks &
My audio thread -
ii g_sf_audio_playback Audio Playback Framen g_sf_audio_playbackl Audio Playback Framework on sf_audio_playback
My thread
= I
g_sf_audio_playback_commonl Audio Playback Framework Shared on sf_audio_p|
] n 3
I
My audio thread Objects & g_sf_messagel g_sf_audio_playback_hw Audio Playback Hardware Fran
Messaging Shared on sf_audio_playback_hw_dac
Framework on
sf_message
I I
g_dac0 DAC Driver Add Timer Driver Add Trg
onr_dac

4 1 +

Figure 46: Adding the Messaging Module to a Thread

Once you have added a Messaging Framework instance in the Threads tab, you can use the
Messaging tab to define your own event classes and events and determine which threads can listen
to which event class. The SSP contains a predefined event class and events for the Audio Playback
Framework module. If you have added the Audio Playback Framework module, the predefined event
class and events appear in the Messaging tab as well, as shown below.

Messaging Configuration

Event Classes 4| New Event Class...

@ Audio Playback

Events 4] New Event...

@ Audio Playback Start

@ Audio Playback Stop

@® Audio Playback Pause
@ Audio Playback Resume
@ Unused

@ New Data

Summary | BSP | Clocks | Pins | Threads | Messaging | Components

Figure 47: Audio Playback Framework Predefined Event Class

3.1.8.1 Adding an Event Class
To add your own user-defined Event Class to the messaging system, follow these steps:

1. In the Messaging tab, select the Event Classes Pane, and click the add button.
2. Enter a unique name for your event class.

3. Click OK.

R11UMO0161EU0160 Revision 1.60 RENESANS Page 96 / 5,198
Mar.29.2024



Synergy Software Package

Starting Development > e2 studio ISDE User Guide > Configuring the SSP Messaging Framework > Adding an Event Class

User’s Manual

Note

User-defined Event Classes are marked with a golden sguare on the upper right of the Event Classicon.

Messaging Configuration

Event Classes

4| New Event Class... 3] Fernove

Audio Playback Subscribers

3 Audio Playback

Events

New Event Class

Enter new messaging event class details

@ Audio Playback Start

@ Audio Playback Stop

@® Audio Playback Pause
@ Audio Playback Resume
@ Unused

@ New Data

|
Name: | My event clasg] I

Symbol: | SF_MESSAGE_EVENT_CLASS MY_EVENT CLASS
Payload: | my_event_class_payload

Payload header: | my_event_class_api.h

Payload type: | my_event_class_payload_t

Cancel

Summary | BSP |C\oclfs ‘ Pins ‘ThreadslMessaging] Components |

Figure 48: Messaging - Add an Event Class

3.1.8.2 Adding an Event

To add your own user-defined Event to the messaging system, follow these steps:

1. In the Messaging tab, select the Event Pane, and click the add button.
2. Enter a unique name for your event class.

3. Click OK.

Note

User-defined Events are marked with a golden square on the upper right of the Eventsicon.

Messaging Configuration

Event Classes

4| New Event Class... 3| Remove

My event class Subscribers

® Audio Playback
(] My event class

Events

New Event

Enter a new messaging event name and symbol

@ Audio Playback Start

@ Audio Playback Stop

@® Audio Playback Pause
@ Audio Playback Resume
@ Unused

@ New Data

Name: | My event]

Symbol: | SF_MESSAGE_EVENT_MY_EVENT

Cancel

Summary | BSP |C\5cks ‘ Pins ‘Thread;lMe;saging] Component;l

Figure 49: Messaging - Add an Event

3.1.8.3 Configuring the Messaging Subscriber List
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In the Subscriber List, you select the threads that are listening to messages from the message
publisher. The connection between the publishing thread and the listening thread is established
through the Event Class. Therefore you define a subscriber list for each of the Event Classes in your
project. All threads in the Subscriber List then can listen and act upon messages belonging to the
selected Event Class.

To following assumes that you have two threads defined in the Threads tab, one of which uses the
Audio Playback Framework:

Threads 4| Mew Thread #| Remove [

~v @it HAL/Common
4 g_cgec CGC Driver on r_cge
4% g_fmi FMI Driver on r_fmi
4 g_elc ELC Driveron r_elc
47 g ioport |/O Port Driver on r_ioport

v & My audio thread
g_sf_audio_playbackD Audio Playback Framework on sf_g
i My thread

< >

Figure 50: Messaging - Example Threads

To configure the Subscriber List for an Event Class, follow these steps:
1. In the Messaging tab, select the Event Classes in the Event Classes Pane.
The Subscriber List pane takes its name from the selected Event Class.
2. Click the Add Icon.
The New Subscriber Dialog box opens.

3. Select the Thread to add to the Subscriber List from the Thread dropdown menu.

4. Fill out the instance range by selecting Start and End.

If you only have one instance of an Event Class, keep the Start and End values at their
default value (0). See the Messaging Framework User Guide for selecting an instance range
if you have more than one Event Class instance. Multiple Event Class instances can be
useful in an application that uses the same Event Class multiple times for example for audio
streaming on multiple channels.

5. Repeat steps 3 and 4 for each thread that you want to add to the Subscriber List for the
selected Event Class.
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Messaging Configuration
ging g Generate Project Content

Event Classes 4| New Event Class... Audio Playback Subscribers | 4| New Subscriber... |

© Audio Playback | Thread Start End
& My event class

New Subscriber

Select a new subscriber thread and instance range

Events

Thread: |Mythread \/‘
@ Audio Playback Start H ead

@ Audio Playback Stop Ha

@ Audio Playback Pause End:

@ Audio Playback Resume
@ Unused

@ New Data

Summary |BSP | Clocks |Pins | Threads Messaging | Components

Figure 51: Messaging - Configuring the Subscriber List

3.1.8.4 Generating Files for the Messaging Framework

The ISDE generates the following files for the configured Messaging Framework when you click the
Generate Project button:

File Contents Overwritten by Generate
Project Content?
synergy cfg/ssp_cfg/framework/ | Contains the event class and Yes
sf message_port.h event enumerations

synergy_cfg/ssp_cfg/framework/ | Contains pointers to the event |Yes

sf message_payloads.h class payloads.
synergy cfg/ssp_cfg/framework/ | Compiler options for the Yes
sf message_payloads.h Messaging Framework

3.1.9 Reviewing and Adding Components

The Components tab enables the individual modules required by the application to be included or
excluded. Modules common to all Synergy projects are preselected (for example: BSP > BSP > Board-
specific BSP and HAL Drivers > all > r_cgc). All modules that are necessary for the modules selected
in the Threads tab are included automatically. You can include or exclude additional modules by
ticking the box next to the required component.
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Component Wersion Description Wariant
~ % BSP
w @ Board
custom 230 CUSTOM Board Support Files
5124_dk 230 5124 DK Board Support Files
5128_dk 230 5128 DK Board Support Files
slja_tb 230 51JA_TB Board Support Files
s3al_tb 230 S3A1_TB Board Support Files
s3a3_tb 230 S3A3_TB Board Support Files
s3af_tb 230 S3A6_TB Board Support Files
s3a7_dk 230 S3A7 DK Board Support Files
s5d3_th 230 5503 _TB Board Support Files
s5d5_th 230 5505_TB Board Support Files
s5d9_pk 230 55D9_PK Board Support Files
V| s7g2_dk 230 57G2_DK Board Support Files

s7g2_pe_hmil 230 57G2_PE_HMI1 Board Support Files
s7g2_sk 230 57G2_SK Board Support Files

v s124

v s128

¢ slja b

Summary | BSP | Clocks | Pins | Threads Messagmg
Figure 52: Components Tab

Components at the HAL and Framework layers are available as are components from Azure RTOS
such as the RTOS ThreadX, file system FileX, TCP/IP networking NetX. In addition, you can select
documentation to be added to a project or include complete projects.

While the components tab selects modules for a project, you must configure the modules themselves
in the other tabs. Pressing the Generate Project Content button copies the .c and .h files for each
component for a Pack file into the following folders:

synergy/ssp/inc/bsp

synergy/ssp/inc/driver

synergy/ssp/inc/framework

synergy/ssp/src/bsp

synergy/ssp/src/driver

synergy/ssp/src/framework

The ISDE also creates configuration files in the synergy_cfg/ssp_cfg folder with configuration options
included from the remaining Threads tabs.

3.1.10 Writing the Application

Once you have added Modules and drivers and set their configuration parameters in the Threads tab,
you can add the application code that calls the Modules and drivers.

Note
To check your configuration, build the project once without errors before adding any of your own application code.

3.1.10.1 RTOS-independent Applications
To write application code:
1. Add all drivers and modules in the Threads tab and resolve all dependencies flagged by

the ISDE such as missing interrupts or drivers.
2. Configure the drivers in the Properties view.
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3. In the Project Configuration view, press the Generate Project Content button.
4. In the Project Explorer view, double-click on the src/hal_entry.c file to edit the source file.

I Project Explorer 0% Y 8 = 08
+ 1% MyProject [Debug]
[ Includes
v [ src
w = synergy_gen
|c] common_data.c
common_data.h
|c] hal_data.c
hal_data.h
|.c] main.c
|c] pin_data.c
l€] hal_entry.c
(2 synergy
= script
(= synergy_cfg
i} configuration.xml
X MyProject Debug.launch
=| RTFS1JATE3A01CFM.pincfg
=| TB_S1JA.pincfg
(?) Developer Assistance

Figure 53: hal_entry.c

Note

All configuration structures necessary for the driver to be called in the application are initialized in
src/synergy_gen/hal_data.c.

Do not modify the filesin the directory src/synergy_gen. These files are overwritten every time you push
the Generate Project Content button.
5. Add your application code here:

58 [MyProject] Synergy Configuration Lgl hal_entry.c X
2

/* HAL-only entry function */
#include "hal data.h”
= woid hal_entry(void)

{

= 5 I r* : add your own code here */ I

}

Figure 54: Adding User Code to hal_entry.c

6. Build the project without errors by clicking on Project > Build Project.

The following tutorial shows how execute the steps above and add application code: Tutorial: Using
HAL Drivers - Programming the WDT

The WDT example is a HAL level application which does not use an RTOS. The user guides for each
module also include basic application code that you can add to hal_entry.c.

3.1.10.2 ThreadX Applications
To write RTOS-aware application code using ThreadX, follow these steps:

1. Add a thread using the Threads tab.

2. Provide a unique name for the thread in the Properties view for this thread.

3. Configure all drivers and resources for this thread and resolve all dependencies flagged by
the ISDE such as missing interrupts or drivers.

4. Configure the thread objects.

5. Provide unique names for each thread object in the Properties view for each object.

6. Add more threads if needed and repeat steps 1 to 5.

7. In the Synergy Project Editor, press the Generate Project Content button.

8. In the Project Explorer view, double-click on the src/my_thread_1_entry.c file to edit the
source file.
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75 Project Explorer 3 E% 7Y 8§ =0
v S blinky._dksTg2
[ Includes
v [ src

[ synergy_gen
€] commeon_data.c
common_data.h
l€| hal data.c
hal_data.h
£ main.c
|.€] message_data.c
€] new_threadl.c
new_thread0.h
€] new_threadl.c
new_thread1.h
l.g] pin_data.c
\.g| hal_entry.c
|.£] new_thread0_entry.c
|.£] new_thread_entry.c
[ synergy
(= script
(= synergy_cfg
%| blinky_dks7g2 Debug.launch
45k configurationxml
=| R7FS7G27TH2ADTCBD. pincfg
=| 57G2-DK.pincfg
=| synergy_cfg.ixt
(7) Developer Assistance

Figure 55: ISDE Generated Files for an RTOS Application

Note
All configuration structures necessary for the driver to be called in the application are initialized in
synergy_gen/my_thread 1.c and my thread 2.c
Do not modify the filesin the directory src/synergy _gen. These files are overwritten every time you push
the Generate Project Content button.
9. Add your application code here:
5} [blinky_dks7g2] Synergy Canfiguration

Minclude "new_threadl.h”

/* My thread entry function */
= void new_threadl_entry(void)

1
/ ; add your own code here I
= while (1)
i

¥
1

tx_thread_sleep (1);

S—
N R - T T e

o
[ S

Figure 56: Adding User Code to my _thread 1.entry
10. Repeat steps 1 to 9 for the next thread.
11. Build your project without errors by clicking on Project > Build Project.
3.1.11 Debugging the Project

Once your project builds without errors, you can use the Debugger to download your application to
the board and execute it.

To debug an application follow these steps:

1. click Run > Debug Configurations.

R11UMO0161EU0160 Revision 1.60 RENESANAS Page 102 /5,198
Mar.29.2024



Synergy Software Package User’s Manual

Starting Development > e2 studio ISDE User Guide > Debugging the Project

Window Help

Renesas Debug Tools >
@, Run Ctrl+F11
4% Debug F11

Run History >
Q RunAs >

Run Configurations...

Debug History >

45 Debug As >
I Debug Configurations... I
@ External Tools >

Figure 57: Invoking the Debug Configurations Dialog

2. In the Debug Configurations view, click on your project listed as MyProject Debug.

Create, ge, and run fig!
CEeERX BT~ Name: | MyProject Debug
|t~,fpef\\tertaxt | %5 Debugger | > Startup | 1 Source | ] Common
[T C/C++ Application T
[T] C/C++ Remote Application
(=" EASE Script |N|34’mJ'Ect Browse...
[E] GDB Hardware Debugging C/C++ Application:
[£] GDB Open0OCD Debugging | Debug/MyProject.lf

[c7] GDB Simulator Debugging (RHA50)
[ Java Applet Variables... Search Project... Browse...
[T] Java Application
g Launch Group

Build (if required) before launching

T Remote Java Application Build Configuration: | Use Active ~
w [c7] Renesas GDB Hardware Debuggin
[ MyProject Debug Beng (O Enable auto build () Disable auto build
[c T Renesas Simulator Debugging (RX, RL78) (® Use warkspace settings Configure Workspace Settings...

Revert Apply
Filter matched 13 of 15 items -

Figure 58: Debug Configuration

3. Connect the board to your PC via either a standalone Segger J-Link debugger or a Segger J-
Link On-Board (included on all Synergy DKs and SKs) and click Debug.

Note
For details on using J-Link and connecting the board to the PC, see the Quick Sart Guide included in the Synergy
Kit.

3.1.12 Using TraceX with a Synergy Project

Precondition
Before you can use TraceX with your Synergy Project, you must download the TraceX
executable file from the Microsoft Store.

TraceX™ is a host-based analysis tool that provides a graphical view of real-time system events.
TraceX collects data on the target device and displays the data for inspection and analysis. A TraceX
version for Synergy devices is available for downloading from the Microsoft Store.

To use TraceX, do the following:
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1. In e2 studio, add the ThreadX source code to your project by going to the Threads tab,
clicking the New Stack button in the Stacks pane, and selecting X-Ware > ThreadX >
ThreadX Source.

] New 5=

Driver »

T‘ F Framework ¥ m

X-Ware > ThreadX 5 b ThreadX Source
G 4" Search... 6

Figure 59: Add TraceX to your Source

2. Enable TraceX in the Properties Window of the Thread using the Threads tab. Keep the
default name for the TraceX buffer as g_tx_trace buffer.

S| Properties = |'_ Problems Q Smart Browser

ThreadX Source
Settings Property Value
w Common
Error Checking Enabled (default)
Timer Ticks Per Second

Max Priorities
Minimum Stack

Timer Thread Stack Size
Timer Thread Priority

Trace Time Mask
Mo FileX Pointer Disabled (default)
Timer Process In ISR Enabled (default)
Reactivate Inline Disabled (default)
Stack Filling Enabled (default)
Stack Checking Disabled (default)
Preemption Threshold Disabled (default)
Redundant Clearing Enabled (default)
Mo Timer Disabled (default)
Motify Callbacks Disabled (default)
Inline Thread Resume Suspend Disabled (default)
Mot Interruptable Disabled (default)
I Event Trace Enabled I
Trace Buffer Name g_tx_trace_buffer
Memory section for Trace Buffer bss
Trace Buffer Size 65536

Trace Buffer Number of Registries 30
<

Figure 60: ISDE TraceX Configuration

3. Set the path to the TraceX application in Window > Preferences > Renesas > TraceX

type filter text Traoex = - E

Java Specify options for TraceX Debugging
Language Servers

Library Hover [[] Use TraceX installed from Microsoft Store
mcu | TraceX Command or Path: | |
Qomph
Remote Development
w Renesas

Breakpoints

Device add-ins Suppc
FsSP

Launch Settings
Logging

My Renesas
Renesas QF

Renesas Toolchain Mi
Smart Browser
Smart Demo

Smart Manual
Support Folders

Synergy Configuratio
Tracealyzer
TraceX
Run/Deb
¢ un/Debug 5 v Restore Defaults Apply

@' \Q‘ £ @ Cancel
Figure 61: ISDE TraceX Path

4. Build your project (Project > Build All).
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5. Connect your Synergy target board.
6. Start a debug session (Run > Debug)
7. In Run > Renesas Debug Tools > TraceX, select Launch TraceX Debugging.

Run  Window Help

Renesas Debug Tools > Renesas Device Partition Manager I BiR | @~ %~ q-
i Instruction Stepping Mode E TraceX » E Launch TraceX Debugging...
3. Moveto Line (C/C++) [Bh  Tracealyzer > | [i) Update TraceX Data

Figure 62: ISDE TraceX Launch

8. In the TraceX Debugging window, set Buffer Start Address to &g_tx_trace_buffer.

In the TraceX Debugging window, set Buffer Size (bytes) to the buffer size selected in the
Properties Window in step 2. The default is 65536.

TraceX Debugging @

Buffer Start Address: | &g te_trace buffer \/|

Buffer Size (bytes): ~ |

Use TraceX installed from Microsoft Store

TraceX Command or Path: | tracex

Update Existing File

@ Cancel
Figure 63: ISDE TraceX Debug

9. Click OK.
10. Run your code (Run > Resume) to collect TraceX data.
11. Suspend execution of your code (Run > Suspend).
12. Observe the collected data in TraceX.

File View Options Help
WO dEIEwR 7O MAA O fx PPP [ o

Sequential View | Time View
Context Summary

Event Summary

Event ID

‘ Interrupt
| Initialize/ldle
| Blinky Thread (0x20000328) [Pricrity: 1]

Figure 64: TraceX Collected Data

13. To collect further TraceX data:
o Resume execution of your code
o Suspend execution of your code
o Click Run > TraceX and select Update TraceX Data.

You can find more information on using TraceX on the Renesas TraceX webpage
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https://www.renesas.com/synergy/tracex.
3.1.13 Modifying Toolchain Settings

There are instances where it may be necessary to make changes to the toolchain being used (for
example, to change optimization level of the compiler or add a library to the linker). Such
modifications can be made from within the ISDE through the menu Project > Renesas C/C++
Project Settings when the project is selected. The following screenshot shows the settings dialog
for the GNU ARM toolchain. This dialog will look slightly different depending upon the toolchain being
used.

] settings v -3
Resource
Builders

~ C/C++ Build Configuration: Debug [ Active] | | Manage Configurations...

Build Variables
Environment

Logging B Tool Settings B Toolchain & Build Steps Build Artifact Binary Parsers 3 Error Parsers
Settings
Tool Chain Editor [ Target Processor Arm family (-mcpu) | cortex-m23 ~
C/C++ G I 5 Optimization
N;IICL:+ ener g Warnings Architecture (-march) | Tecolchain default ~
Project Matures (% Debugging Instruction set Thumb (-mthumb) w
GMU Arm Cross A: bl
Project References v® 0 T ross Assemier [ Thumb interwork (-mthumb-interwork)
Renesas QF (2 Preprocessor
Run/Debug Settings 22 Includes Endianness Toolchain default ~
B W,
Task Tags ¢ amings Float ABI Toolchain default v
Validation (2 Miscellaneous
~ B GMNU Arm Cross C Compiler FPU Type Toolchain default ~
(%% Preprocessor : 8
3 Includes Unaligned access Toolchain default ~
(% Optimization [J TrustZone (-mcmse)

# Warnings
(# Miscellaneous
~ 3 GNU Arm Cross C Linker Toolchain default
# General
(22 Libraries
(# Miscellaneous Toolchain default
~ BB GMU Arm Cross Create Flash Image
# General
~ B GMU Arm Cross Print Size Small (-mcmodel=small)
# General

Generic (-mcpu=generic)

Toolchain default

Enabled (+simd)

Strict align (-mstrict-align)

Other target flags ‘

Restore Defaults Apply
@ Apply and Close Cancel

Figure 65: ISDE Project Toolchain Settings

The scope for the settings is project scope which means that the settings are valid only for the
project being modified.

The settings for the linker which control the location of the various memory sections are contained in

a script file specific for the device being used. This script file is included in the project when it is
created and is found in the script folder (for example, /script/S7G2.1d).

3.1.14 e2 studio ISDE Usage Notes
3.1.14.1 Including ThreadX sources

You can use the Theads tab to include ThreadX source code in your project as follows:
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1. Click on the HAL/Common icon in the Threads pane. The Modules pane changes to
HAL/Common Modules.

2. Select New Stack > X-Ware > ThreadX > ThreadX Source.

3. Check the Properties window to configure the TheadX RTOS properties.

4. Click Generate Project.

The e? studio ISDE extracts the ThreadX source code into the following directory:
synergy/ssp/src/framework/el/tx

Note
Extracting the ThreadX sources increases the compile time for your project.

3.1.14.2 Using Synergy Developer Assistance

This section describes a new feature, “Synergy Developer Assistance” included in e? studio.
Developer Assistance Node

A new node Developer Assistance is now available in the project explorer. When expanded, the
Developer Assistance tree shows you the threads and module stacks and their respective API
information of the saved Synergy configuration.

The Developer Assistance node is available regardless of whether the Synergy Configuration Editor is
open. This allows a user to easily consult the Developer Assistance for a project’s stack modules
while application code is being written. It assists by providing code templates and an autocompletion
tool.

Configure Threads

Create a new project. In the Synergy configurator thread’s tab create a thread and add a new stack.

For example, Framework Device on sf_i2c:

Threads Configuration

@

Threads | New Thread | Remove [— New Thread Stacks | New Stack >
v g HAL/Common
& g_fmi FMI Driver on r_fmi & g_sf_i2c_deviceD 12C Framework Device on sf_i2c
7 g_elc ELC Driver on r_elc
7 g_ioport I/O Port Driver on r_ioport @
7 g_cge CGC Driver on r_cgc ry

w & Blinky Thread I
42 ThreadX Source 48 g_sf_i2c_busD 12C Framework Shared Bus on sf_i2c
w & New Thread
b g_sf_i2c_devicel I2C Framework De| ®

Y
[

a4 g_i2cl 12C Master Driver on r_sci_i2c

< s ©)

%] New Object > & g_transfer) Transfer & g_transfer] Transfer
Driver on r_dte SCI0 Driver on r_dte SCI0
™ RXl

New Thread Objects

Project Explorer View

Once the project is saved, expand the Developer Assistance node. Notice that the node is updated
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with the new thread New Thread Information. Clicking on the module instance under the thread will
expand all the child nodes and show the API information of the modules.

w (7) Developer Assistance

& HAL/Common

@ Blinky Thread

~ @& New Thread

~ @ g sf i2c_deviced 12C Framework Device on sf_i2c

Properties View

v

v

v

v

v

v

v

v

v

v

@ ssp_err_t (*open) (sf_iZc_ctrl_t *p_ctrl, sf_i2c_cfg_t const *const p_cfg)

= Call open()

@ ssp_err_t (*read) (sf_i2c_ctrl_t *const p_ctrl, uint8_t *const p_dest, uint32_t const bytes, bool const restart, uint32_t const timeout)
B2 Call read()

@ ssp_err_t (*write) (sf_i2c_ctrl_t *const p_ctrl, uint8_t *const p_src, uint32_t const bytes, bool const restart, uint32_t const timeout)
i Call write()

@ ssp_err_t (*reset) (sf_i2c_ctrl_t *const p_ctrl, uint32_t const timeout)
B Call reset()

@ ssp_err_t (*close) (sf_iZc_ctrl_t *const p_ctrl)
= Call close()

@ ssp_err_t (*lock) (sf_i2c_ctrl_t *const p_ctrl)
= Call lock()

@ ssp_err_t (funlock) (sf_i2c_ctrl_t *const p_ctrl)
= Call unlock()
@ ssp_err_t (*version) (ssp_version_t *const p_version)
= Call version()
@ ssp_err_t (lockWait) (sf_i2c_ctrl_t *const p_ctrl, uint32_t const timeout)
B2 Call lockWait()
48 g_sf_i2c_busD 12C Framework Shared Bus on sf_i2c
~ @ g.i2c012C Master Driver on r_sci_i2c
w @ ssp_err_t ("open) (i2c_ctrl_t *const p_ctrl, i2c_cfg_t const *const p_cfg)
B2 Call open()
w @ ssp_err_t (*close) (i2c_ctrl_t *const p_ctrl)
B2 Call close)
~w @ ssp_err_t (*read) (i2c_ctrl_t *const p_ctrl, uint8_t *const p_dest, uint32_t const bytes, bool const restart)
= Call read()
w @ ssp_err_t (“write) (i2c_ctrl_t *const p_ctrl, uint8_t *const p_src, uint32_t const bytes, bool const restart)
B2 Call write()
w @ ssp_err_t (*reset) (i2c_ctrl t *const p_ctrl)
= Call reset()

Selecting the module instance in the thread tab or in the project explorer will show the module and
module API information in the API info tab of properties view.

Tip: If the Properties view is not present in the current e? studio perspective, you can open it by
selecting Window -> Show View -> Properties
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K]

APl Info

MyProject Debug,jlink
MyProject Debug.launch
R7FS1ATE3A0TCFM.pincfg
synergy_cfg.bet
TB_51)A.pincfg

w (7) Developer Assistance
2% HAL/Common
% Blinky Thread
~ 4 New Thread
~ 4 g_sf_i2c_deviceD 12C Framework Device on sf_i2c
w @ ssp_err_t (*open) (sf_i2c_ctrl_t *p_ctrl, sf_iZc_cfg_t const *const p_cfg)
B2 Call open()
w @ ssp_err_t (*read) (sf_i2c_ctrl_t *const p_ctrl, uint®_t *const p_dest, uint32_t const bytes, bool const re:
B2 Call read()
w @ ssp_err_t (*write) (sf_i2c_ctrl_t *const p_ctrl, uintd_t *const p_src, uint32_t const bytes, bool const res
B2 Call write()
w @ ssp_err_t (*reset) (sf_iZc_ctrl_t *const p_ctr, uint32_t const timeout)
B2 Call reset()
< che bt wrem e A 5
iS| Properties > \'_ Problems Q Smart Browser

g_sf i2c_device0 12C Framework Device on sf_i2c

- S e un o

* RIC

Resource APl

@ ssp_err_t (*open) (sf_i2c_ctrl_t *p_ctrl, sf_i2c_cfg_t const *const p_cfg)
Open a designated 12C device on a bus.

Implemented as

» SF_I2C_Open()

Parameters

5 Project Explorer X = 5 % § = B || MyProject] Synergy Configuration X
(= synergy_cfg ) .
% configuration.xml Threads Configuration

4| Mew Thread 5| Remove
Threads - 2

New Thread Stacks

Generatt

& New Stack >

~ !‘?f% HAL/Common
4% g_fmi FMI Driver on r_fmi
47 g_elc ELC Driver onr_elc
4% g_ioport IO Port Driver onr_
& g_cgc CGC Driver on r_cge
w Blinky Thread
4% ThreadX Source
kg >

4 g_sf_i2c_deviceD |2C Framework Device on sf_i2c

@

ry

New Thread '] Mew Object >

Objects

48 g_sf_i2c_busD 12C Framework Shared Bus on sf_i2c

@

& g_i2c0 12C Master Driver on r_sci_i2c

@

Summary | BSP | Clocks | Pins | Threads | Messaging | Components

# p_ctrl; Control handle for [2C framework driver context for a device (Value returns from this function), This value must be cleared by user,

» p_cfg:12C configuration includes [2C bus and low level configuration

@ ssp_err_t (*read) (sf_i2c_ctrl_t *const p_ctrl, uint8_t *const p_dest, wint32_t const bytes, bool const restart, wint32_t const timeout)

Receive data from [2C device.
Implemented as
* SF_T2C_Read()

Parameters

p_ctrl: Pointer to previously opened I12C SF control structure.

p_dest: Pointer to location to store read data.
bytes ;: Number of bytes to read.

restart : Indicates whether the restart condition should be issued after reading.

‘timeout : ThreadX timeout. Options include TX_NO_WAIT (0x00000000), TX_WAIT_FOREVER (0xFFFFFFFF), and timeout value (0x00000001 through 0xFFFFFFFE] in ThreadX tick counts.

Selecting the code template node shows the preview of the function in the Properties view

v MNew Thread

k2 Call open()
B2 Call read()
B2 Call write()

B2 Call reset()

<
iS| Properties IL Problems Q Smart Browser

Call read()

Preview
Resource

status = <not yet known>
instance = g_sf i2c devicel
p_dest = <not yet known>
bytes = <not yet known>
restart = <not yet known>
timeout = <not yet known>

Drag and drop to source File

~ & g_sf_i2c_devicel 12C Framework Device on sf_i2c
v @ ssp_er_t ("open) (sfLi2c_ctrl_t "p_ctrl, sf_i2c_cfg_t const *const p_cfg)

v @ ssp_em_t ("reset) (sf_i2c_ctrl_t "const p_ctrl, uint32_t const timeout)

v @ ssp_er_t ("read) (sf_i2c_ctrl_t "const p_ctrl, uint8_t *const p_dest, uint32_t const bytes, bool const re:

v @ ssp_er_t ("write) (sf_i2c_ctrl_t *const p_ctrl, uint8_t *const p_src, uint32_t const bytes, bool const res

status = instance.p_api->read(instance.p_ctrl, p dest, bytes, restart, timeout);
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The API function code templates or callbacks can be dragged and dropped to the source file. This will
autofill the parameters and return type of the function

v (%) Developer Assistance
& HAL/Common
@ Blinky Thread
v i@ Mew Thread

~ & g_sf_i2c_devicel 12C Framework Device on sf_i2c

/ : add your own code here */
while (1)

tx_thread_sleep (1);
¥

v @ ssp_em_t ("open) (sf_i2c_ctrl_t *p_ctrl, sf_i2c_cfg_t const *con mp- statys = g_sT_i2c_deviceB.p_api->open(g_sf iZc_device®.p_ctrl, g_sf_i2c_deviceB.p_cfg);
=2 Call open()

v @ ssp_er_t ("read) (sf_i2c_ctrl_t "const p_ctrl, uint8_t *const p_c }
B2 Call read()

v @ ssp_er_t ("write) (sf_i2c_ctrl_t *const p_ctrl, uint8_t *const p_:
B Call writel)

v @ ssp_em_t ("reset) (sf_i2c_ctrl_t “const p_ctrl, uint32_t const tin
B Call reset()

v @ ssp_er_t ("close) (sf_i2c_ctrl_t "const p_ctrl)
B Call close()

v @ ssp_er_t ("lock) (sf_i2c_ctrl_t "const p_ctrl)

Please also refer to Help-> Help Contents -> Synergy Contents -> Synergy Developer
Assistance page in e’ studio for any further information.

3.2 Tutorial: Your First Synergy Project - Blinky

3.2.1 Tutorial Blinky
The goal of this tutorial is to quickly get acquainted with the Synergy Platform by moving through

the steps of creating a simple application using e2 studio and running that application on a Synergy
board.

3.2.2 What Does Blinky Do?

The application used in this tutorial is Blinky, traditionally the first program run in a new embedded
development environment.

Blinky is the “Hello World” of microcontrollers. If the LED blinks you know that:

The toolchain is setup correctly and builds a working executable image for your chip.

e The debugger has installed with working drivers and is properly connected to the board.
The board is powered up and its jumper and switch settings are probably correct.

e The microcontroller is alive, the clocks are running, and the memory is initialized.

The Blinky example application used in this tutorial is designed to run the same way on all boards
offered by Renesas that hold the Synergy microcontroller. The code in Blinky is completely board
independent. It does the work by calling into the BSP (board support package) for the particular
board it is running on. This works because:

e Every board has at least one LED connected to a GPIO pin.
e That one LED is always labeled LED1 on the silk screen.
e Every BSP supports an API that returns a list of LEDs on a board, and their port and pin
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assignments.
3.2.3 Prerequisites

To follow this tutorial, you need:

Windows based PC

e? studio

Synergy Software Package
A Synergy board kit

3.2.4 Create a New Project for Blinky

The creation and configuration of a Synergy project is the first step in the creation of an application.
The base SSP pack includes a pre-written Blinky example application that is simple and works on all
Renesas Synergy boards.

Note
The € studio screens shown in this manual are examples. Some details may differ between different releases of the
€” studio 1SDE and the SSP.
Follow these steps to create a Synergy project:
1. In e2 studio ISDE, click File > New > Synergy C/C++ Project, select Renesas Synergy

C Executable Project, and click Next.
2. Assign a name to this new project. Blinky is a good name to use for this tutorial.

3. Click Next. The Project Configuration window shows your selection.

@2 studio - Project Config ion (Synergy CE ble Project) —

Specify the new project details.

Project Toolchains

Project name | Blinky| GMNU ARM Embedded

Use default location

C:\Users\a5137109\e2_studio\synergy\Blinky Browse...
default

@ <Back Finish Cancel

Figure 66: e2 studio ISDE Project Configuration Window (Part 1)
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4. Select the board support package by selecting the name of your board from the Device
Selection drop-down list and click Next.

e2 studio - Project Config| ion (Synergy CE: ble Project) —

Select the board support that you require.

Device Selection

S5P version: |2.3.0 Ecanilelals

Board: SUATB ~

Device: R7FS1UATA3ADTCFM
Select Tools Available Tools
Toolchain: GNU ARM Embedded ~ GMU ARM Embedded
Toolchain version: | 10.3.1.20210824 - 10.3.1.20210824

~ Debuggers

Debugger: J-Link ARM ~ J-Link ARM

~ RTOS
Express Logic ThreadX

~ Smart Manual
10 Registers Supported
Software Manual Supported

@ <Back Finish Cancel

Figure 67: e2 studio ISDE Project Configuration Window (Part 2)

5. Select the Blinky template for your board and click Finish.

2 studio - Project C

Select the type of project you wish to create.

figuration (Synergy C E: ble Project) p—

Project Template Selection

o BSP
Q Base Board Support Package for the chosen Synergy family.
[Renesas.Synergy.2.3.0.pack]
® " Blinky
Q Blinky project.

[Renesas.Synergy.2.3.0.pack]

o " Blinky with ThreadX
Q Threaded version of Blinky project.
[Renesas.Synergy.2.3.0.pack]

Code Generation Settings
Use Synergy Code Formatter

@ <Back Next > Cancel

Figure 68: e2 studio ISDE Project Configuration Window (Part 3)

Once the project has been created, the name of the project will show up in the Project
Explorer window of the ISDE. Now press the Generate Project Content button in the top
right corner of the Project Configuration window to generate your board specific files.
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8 [Blinky] Synergy Configuration >

Summary

Project Summary Renesas Synergy™ A

Board: S1JATB

Device: R7TFS1JAT83A01CFM

Toolchain: GCC ARM Embedded 81
Toolchain Version: 10.3.1.20210824

SSP Version: 230

Selected software components

S1JA_TB Board Support Files v23.0
S5P Common Code v2.3.0
Clock Generation Circuit: Provides=[CGC] v2.3.0
Event Link Controller: Provides=[ELC] v2.3.0
Factory MCU Information Module: Provides=[FMI] v2.3.0
/0 Port: Provides=[IO Port] v23.0 ¥
Board support package for RTFS1JATE3A01CFM v2.3.0

Figure 69: e2 studio ISDE Project Configuration Tab

Your new project is now created, configured, and ready to build.
3.2.4.1 Details about the Blinky Configuration

The Generate Project Content button creates configuration header files, copies source files from
templates, and generally configures the project based on the state of the Project Configuration
screen.

For example, if you check a box next to a module in the Components tab and press the Generate
Project Content button all the files necessary for the inclusion of that module into the project will
be copied or created. If that same check box is then unchecked those files will be deleted.

3.2.4.2 Configuring the Blinky Clocks

By selecting the Blinky template, the clocks are configured by the ISDE for the Blinky application.
The ISDE clock configuration tab (see Configuring Clocks) shows the Blinky clock configuration. The
Blinky clock configuration is stored in the BSP clock configuration file (see BSP Clock Configuration).

3.2.4.3 Configuring the Blinky Pins

By selecting the Blinky template, the GPIO pins used to toggle the LED1 are configured by the ISDE
for the Blinky application. The ISDE pin configuration tab shows the pin configuration for the Blinky
application (see Configuring Pins). The Blinky pin configuration is stored in the BSP configuration file
(see BSP Pin Configuration).

3.2.4.4 Configuring the Parameters for Blinky Components

The Blinky project automatically selects the following HAL components in the ISDE Component:
* r cgc
° r elc
e r fmi

e r_ioport

To see the configuration parameters for any of the components, check the Properties tab in the HAL
window for the respective driver (see Adding and Configuring HAL Drivers).

3.2.4.5 Where is main()?
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The main function is located in < project >/src/synergy_gen/main.c. It is one of the files that are
generated during the project creation stage and only contains a call to hal_entry(). For more
information on generated files Adding and Configuring HAL Drivers .

3.2.4.6 Blinky Example Code

The blinky application is stored in the hal_entry.c file. This file is generated by the ISDE when you
select the Blinky Project template and is located in the project's src/ folder.

The application performs the following steps:

1. Get the LED information for the selected board by calling the BSP HAL function

R _BSP_LedsGet().
. Define the output level HIGH for the GPIO pins controlling the LEDs for the selected board.

N

3. Get the selected system clock speed and scale down the clock, so the LED toggling can be

observed.

4. Toggle the LED by writing to the GPIO pin with
g_ioport.p_api->pinWite()

3.2.5 Build the Blinky Project

Highlight your new project in the Project Explorer window and build it.

There are three ways to build a project:

a. Click on Project in the menu bar and select Build Project.

b. Click on the hammer icon.

c. Right-click on the project and select Build Project.

(=5 Blinky [Debug]

File Edit Navigate SearchRenesasV\Ews Run
II L] .Hl t5- Debug

[c7 Blinky Det

- - - v‘=f
-

rer X 0% Y ! = O ||&Ei

Sum

Pr¢

Bo:
De
Tot

a. Project->Build Project

b. Click

c. Right-click->Build Project

Figure 70: e2 studio ISDE Project Explorer Window

Once the build is complete a message is displayed in the build Console window that displays the
final image file name and section sizes in that image.

R11UMO0161EU0160 Revision 1.60
Mar.29.2024

RLENESAS

Page 114 /5,198



Synergy Software Package User’s Manual

Starting Development > Tutorial: Your First Synergy Project - Blinky > Build the Blinky Project

[%2 Pin Conflicts| B Console X R|&ﬁ*§,| H &b =N @lda'ﬁ'n =}
CDT Build Censole [Blinky]

s e e e e

Building file: ../synergy/ssp/src/bsp/mcu/all/bsp_delay.c s

Building file: ../synergy/ssp/src/bsp/mcu/all/bsp_irqg.c
Building file: ../synergy/ssp/src/bsp/mcu/all/bsp locking.c
Building file: ../synergy/ssp/src/bsp/mcu/all/bsp register protection.c
Building file: ../synergy/ssp/src/bsp/mcu/all/bsp_shrk.c
Building file: ../synergy/ssp/src/bsp/cmsis/Device/RENESAS/S1IA/Source/startup S1JA.c
Building file: ../synergy/ssp/src/bsp/cmsis/Device/RENESAS/S1IA/Source/system S1JA.c
Building file: ../synergy/board/slja_tb/bsp_init.c
Building file: ../synergy/board/slja_tb/bsp leds.c
Building file: ../src/synergy_gen/common_data.c
Building file: ../src/synergy_gen/hal_data.c
Building file: ../src/synergy_gen/main.c
Building file: ../src/synergy_gen/pin_data.c
Building file: ../src/hal_entry.c
Building target: Blinky.elf
arm-none-eabi-objcopy -0 srec "Blinky.elf" "Blinky.srec”
arm-none-eabi-size --format=berkeley "Blinky.elf™
text data bss dec hex filename
196@8 176 8544 28320 6ea@ Blinky.elf

18:28:14 Build Finished. @ errors, @ warnings. (tock 6s.2@8ms)

Figure 71: e2 studio ISDE Project Build Console

3.2.6 Debug the Blinky Project
3.2.6.1 Debug prerequisites

To debug the project on a board, you need:
e The board to be connected to the ISDE
e The debugger to be configured to talk to the board

* The application to be programmed to the microcontroller

Applications run from the internal flash of your microcontroller. To run or debug the application, the
application must first be programmed to the microcontroller’s flash. There are two ways to do this:

e |JTAG debugger
e Built-in boot-loader via UART or USB

Some boards have an on-board JTAG debugger and others require an external JTAG debugger
connected to a header on the board.

Refer to your board’s user manual to learn how to connect the JTAG debugger to your ISDE.
3.2.6.2 Debug steps
To debug the Blinky application, follow these steps:

1. Configure the debugger for your project by clicking Run > Debugger Configurations ...

File Edit MNavigate Search_ Project Renesas!
& || % || ® | G5 Debug

Figure 72: e2 studio ISDE Debug Icon

... or by selecting the drop-down menu next to the bug icon and selecting Debugger
Configurations ...
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Create, fi

ge, and run

(| B Y~

Ouﬁ’ @

‘ type filter text

[£] C/C++ Application

[E] C/C++ Remote Application
= EASE Script

[£] GDB Hardware Debugging

[£] GDB OpenOCD Debugging

[E7] GDB Simulator Debugging (RHA50)
Java Applet

Java Application

Configure launcl

- Press the 'New

- Press the 'New

- Pressthe 'l

[

| - Pressthe '|

3 - Pressthe |
T -

7 - Pressthe |

- Select launch ¢

R Launch Group
[T Remote Java Application - Select launch ¢
« [t Rengsas GDB Hardware Debugging .

(& Blinky Debug

[c7] Renesas Simulator Debugging (RX, RL78)
Edit or view an &

Filter matched 13 of 13 items

@

Figure 73: e2 studio ISDE Debugger Configurations Window

2. Select your debugger configuration in the window. If it is not visible then it must be created
by clicking the New icon in the top left corner of the window. Once selected, the Debug
Configuration window displays the Debug configuration for your Blinky project.

Create, ge, and run fig ﬁ“
CE@aEX| BV~ Name: | Blinky Debug |
| type filter text ‘ =3 Debuggar‘ "3 Startup‘ By Sourcel [C] Common

[€] C/C++ Application P

[€] C/C++ Remote Application

=/ EASE Script | Blinky Browse...

[£] GDB Hardware Debugging C/C++ Application:

[£] GDB QpanOCD Debugglng | Debug/Blinky.clf

[E¥] GDB Simulator Debugging (RHE50)

Java Applet Variables... Search Project... Browse...

Java Application Build (if required) before launching

R Launch Group

T Remote Java Application Build Configuration: | Use Active ~
~ [c7] Renesas GDB Hardware Debugging . ’

& Blinky Debug () Enable auto build () Disable auto build
[ Renesas Simulator Debugging (RX, RL78) (®) Use workspace settings Configure Workspace Settings...
Revert Appl

Filter matched 13 of 15 items o ilie/
@

Figure 74: e2 studio ISDE Debugger Configurations Window with Blinky Project

3. Press Debug to begin debugging the application.

3.2.6.3 Details about the Debug Process

In debug mode, the ISDE executes the following tasks:

1. Downloading the application image to the microcontroller and programming the image to

the internal flash memory.

2. Setting a breakpoint at main().
3. Setting the stack pointer register to the stack.
4. Loading the program counter register with the address of the reset vector.
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5. Displaying the startup code where the program counter points to.

Program Counter

=% [Blinky] SynergyConfiguration Le] startup S1JA.c X

/* Initialize system using BSP. */
SystemInit();

/* Call user application. */
main();

while (1)

/* Infinite Loop. */

Figure 75: e2 studio ISDE Debugger Memory Window

3.2.7 Run the Blinky Project
While in Debug mode, click Run > Resume or click on the Play icon twice.

‘uD

Figure 76: e2 studio ISDE Debugger Play Icon

The LED on the board marked LED1 should now be blinking.

3.3 Tutorial: Using HAL Drivers - Programming the WDT

3.3.1 Application WDT

This application uses the WDT Interface implemented by the WDT HAL Driver WDT. This document
describes how to use the ISDE and SSP to create an application for the Synergy MCU Watchdog

Timer (WDT) peripheral. This application makes use of the following SSP modules:

e Board Support Package (Board Support Package)
e CGC (Clock Generation Circuit)

e WDT (Watchdog Timer)

e |OPORT (GPIO)

3.3.2 Creating a WDT Application Using the Synergy SSP and ISDE

3.3.2.1 Using the SSP and the e2 studio ISDE

The Synergy Software Package (SSP) from Renesas provides a complete driver library for developing
Synergy applications. The SSP provides Hardware Abstraction Layer (HAL) drivers, Board Support
Package (BSP) drivers and higher level Framework applications for the developer to use to create
applications. The SSP is integrated into the Renesas e2 studio Integrated Solution Development
Environment (ISDE) based on eclipse providing build (editor, compiler and linker) and debug phases
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with an extended GNU Debug (GDB) interface.
3.3.2.2 The WDT Application

The flowchart for the WDT application is shown below.
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BSP initialises
docks, pins etc

hal_entry()

2 Initialise \WOT

3 Start WDT

Loop Count = 30

4 Turn on red LED and deday T

i

Tum off red LED and delay

m o
Loop %1”“ g Decrement Loop Count

Turn on green LED and delay .‘T

Turmn off green LED and delay

.

Figure 77: WDT Application Flow Diagram
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3.3.2.3 WDT Application flow

These are the main parts of the WDT application:

1. main() calls hal_entry(). The function hal_entry() is created by the SSP with a placeholder

for user code. The code for the WDT will be added to this function.
. Initialize the WDT, but do not start it.

N

3. Start the WDT by refreshin

g it.

4. The red LED is flashed 30 times and refreshes the watchdog each time the LED state is

changed.

5. Flash the green LED but DO NOT refresh the watchdog. After the timeout period of the
watchdog the device will reset which can be observed by the flashing red LED again as the

sequence repeats.

3.3.3 Creating the Project with the ISDE

Start the ISDE and choose a workspace folder in the Workspace Launcher. Configure a new Synergy

project as follows.

Note

The €’ studio screens shown in this manual are examples. Some details may differ between different releases of the

€” studio | SDE and the SSP.

1. Select File > New > Synergy C/C++ Project. Then select the template for the project.

File Edit Mavigate Search Project RenesasViews Run Window Help

New Alt+Shift+N » Renesas C/C++ Project

Open File... |- synergy C/C++ Project |
Open Projects from File System... 4 Project...

Recent Files » [ Example...

Close Editor

P -

Templates for New Synergy C/C++ Project

Renesas Synergy C Executable Project

Gt W | o gther..

Renesas A C Executable Project for Renesas Synergy.

Renesas Synergy C Library Project
Renesas A C Library Project for Renesas Synergy.

Renesas Synergy C Project Using Synergy Library
Renesas Creates a C application project which uses an
existing Synergy library project

Renesas Synergy C++ Executable Project
Renesas A C++ Executable Project for Renesas Synergy.

Renesas Synergy C++ Library Project
2enesas A C++ Library Project for Renesas Synergy.

<

< Back Mext > Finish Cancel

Figure 78: Creating a New Project

2. In the ISDE Project Configuration (Synergy Project) window, enter a project name (for
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example, WDT_Application). Select the toolchain. If you want to choose a new location for
the project, deselect Use default location. Click Next.

e2 studio - Project Config| ion (Synergy CE: ble Project)
Specify the new project details, |

—>

Project Toolchains

Project name | WDT_Application| GNU ARM Embedded

Use default location

Location: | CA\Users\a5137109\e2_studio\synergy\WDT_Applical | Browse...

Choose file system: |default

@ < Back Finish Cancel
Figure 79: Project Configuration (Part 1)

3. This application runs on the Synergy S7G2 based DK-S7G2 board. So, for the Board select
S7G2 DK.

This will automatically populate the Device drop-down with the correct device used on this
board. Select the Toolchain version. Select J-Link ARM as the Debugger. No RTOS is

being used in this application but it can be left at the default. Click Next to configure the
project.

e2 studio - Project Config| ion (Synergy CE: ble Project)
Select the board support that you require. |

Device Selection

S5P version: |2.3.0 ~ Ecanilelals
Board: S7G2 DK ~
Device: R7FS7G2TH2ZAD1CBD
Select Tools Available Tools
Toolchain: GNU ARM Embedded ~ GNU ARM Embedded
Toolchain version: | 10.3.1.20210824 - 10.3.1.20210824
~ Debuggers
Debugger: J-Link ARM ~ J-Link ARM
~ RIOS

Express Logic ThreadX
~ Smart Manual

@ <Back B Cancel
Figure 80: Project Configuration (Part 2)

The project template is now selected. As no RTOS is required select BSP.
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e2 studio - Project Config| ion (Synergy CE ble Project) —
Select the type of project you wish to create,

Project Template Selection

® o} BSP
K Base Board Support Package for the chosen Synergy family.
[Renesas.Synergy.2.3.0.pack]

o d Blinky
v Blinky project.
[Renesas.Synergy.2.3.0.pack]

o d’ Blinky with ThreadX
. Threaded version of Blinky project.
[Renesas.Synergy.2.3.0.pack]

Code Generation Settings
Use Synergy Code Formatter

"?;‘ < Back Next » Cancel

Figure 81: Project Configuration (Part 3)

4. Click Finish.

The ISDE creates the project and opens the Project Explorer and Project Configuration Settings
views with the Summary page showing a summary of the project configuration.

3.3.4 Configuring the Project with the ISDE

The e2 studio ISDE simplifies and accelerates the project configuration process by providing a GUI
interface for selecting the options to configure the project.

The ISDE offers a selection of perspectives presenting different windows to the user depending on
the operation in progress. The default perspectives are C/C++ , Synergy Configuration and
Debug. The perspective can be changed by selecting a new one from the buttons at the top right of
the ISDE.

T | Bd C/Cr+ |k Synergy Configuration 4 Debug

Figure 82: Selecting a Perspective

The C/C++ perspective provides a layout selected for code editing. The Synergy Configuration
perspective provides elements for configuring a Synergy project, and the Debug perspective
provides a view suited for debugging.

1. In order to configure the project settings ensure the Synergy Configuration perspective is
selected.

2. Ensure the Project Configuration [WDT Application] is open. It is already open if the
Summary information is visible. To open the Project Configuration now or at any time make
sure the Synergy Configuration perspective is selected and double-click on the
configuration.xml file in the Project Explorer pane on the right side of the ISDE.
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1 Project Explorer
v I% WDT_Application
[ Includes

v [ src
(&= synergy_gen
€] hal_entry.c
w [ synergy
(= board
&= ssp
(= script
= synergy_cfg
=| R7FS7G27TH2ADTCBD. pincfg
=| 57G2-DK.pincfg
%| WDT_Application Debug.launch
(7) Developer Assistance

Figure 83: Synergy Project Configuration Settings

At the base of the Project Configuration view there are several tabs for configuring the
project. A project may require changes to some or all of these tabs. The tabs are shown

below.

Summasy Generate Project Content

Project Summary ™
Renesas Synergy ~

Board: S7G2 DK
Device: RYFSTG27H2A01CBD
Toolchain; GCC ARM Embedded 8762
Toolchain Version: 10.3.1.20210824
S5P Version: 230

Selected software components

SSP Common Code v2.3.0
Clock Generation Circuit: Provides=[CGC] v2.3.0
Event Link Controller: Provides=[ELC] v2.3.0
Factory MCU Information Module: Provides=[FMI] v2.3.0
/O Port: Provides=[IO Port] v2.3.0
87G2_DK Board Support Files v2.3.0
Board support package for RTFS7TG27H2A01CBD v2.3.0
Board support package for S7G2 v2.3.0
Board support package for 57G2 v2.3.0

l;len:sz:: @ ﬁ
< @EC

ISummary BSP | Clocks | Pins | Threads | Messaging Componentsl

Figure 84: Project Configuration Tabs

3.3.4.1 BSP Tab

The BSP tab allows the Board Support Package (BSP) options to be modified from their defaults. For
this particular WDT project no changes are required. However, if you want to use the WDT in auto-
start mode, you can configure the settings of the OFS0 (Option Function Select Register 0) register in
the BSP tab. See the Synergy Hardware User’'s Manual for details on the WDT autostart mode.

3.3.4.2 Clocks Tab

The clocks tab presents a graphical view of the clock tree of the device. Using the drop down boxes
in the GUI enables configuration of the various clocks. The WDT uses PCLCKB. The default output
frequency for this clock is 60 MHz. Ensure this clock is outputting this value.
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3.3.4.3 Pins Tab

Clocks Configuration

KTAL 24MHz |—\
PLL Src: XTAL

! Clock Sre: PLL

PLL Div /2 k ~
PLL Mul x20.0 v
| USBMCLK 24MHz | |PLLZ4DMHZ¢
HOCO 20MHz v

LOCO 32768Hz
MOCO 8MHz
SUBCLK 32768Hz

= ICLK Div /1

= PCLKA Div /2

Generate Project Content

7 Restore Defaults

~ ICLK 240MHz

~ PCLKA 120MHz

= PCLKB Div /4

~ PCLKE 60MHz

= PCLKC Div /4
~ —6= PCLKD Div /2

SDCLKout On
[ BCLK Div IZT

BCK/2

[ UCLK Div /5

"= FCLK Div /4

~ PCLKC 60MHz

~ PCLKD 120MHz

~ SDCLKout 120MHz

~ BCLK 120MHz

~ BCLKout 60MHz

~ UCLK 48MHz

~ FCLK 60MHz

Figure 85: Clock Configuration

The Pins tab provides a graphical tool for configuring the functionality of the pins of the device. For
the WDT project no pin configuration is required. Although the project uses two LEDs connected to
pins on the device, these pins are pre-configured as output GPIO pins by the BSP.

3.3.4.4 Threads Tab

You can add any driver to the project using the Threads tab. The HAL drivers for the Clock
Generation Circuit, the Event Link Controller, and the 10 port pins are added automatically by the
ISDE when the project is configured. The WDT application uses no ThreadX Resources, so you only
need to add the HAL WDT driver.

Threads Configuration

Threads

4 New Thread

& [WDT_Application] Synergy Configuration

v gt HAL/Commen

4% g_fmi FMI Driver on r_fmi

4% g_cge CGC Driver on r_cge

4% g_elc ELC Driver on r_elc

42 g_ioport 1/0 Port Driver on r_ioport

HAL/Common Objects

HAL/Common Stacks

&) New Stack >

8

Generate Project Content

4% g_fmi FMI Driver on
r_fmi

@

42 g_cge CGC Driver on
r_cge

@

42 g_elcELC Driver on
r_ele

@

47 g ioport /0 Port
Driver on r_ioport

@

Summary | BSP | Clocks | Pins | Threads | Messaging | Components.

Figure 86: Threads Tab

The HAL/Common Stacks panel and is populated with the modules preselected by the ISDE.
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1. Click on New Stack to find a pop-up window with the available HAL level drivers.
2. Select Watchdog Driver on r_wdt.

&) New Stack >

Driver > Analog >
Iriver or Framework > Connectivity >
X-Ware > Crypto >
# Search.. Graphics >
Input >
Monitoring > 4 CRC Driver onr_crc
Power > | & Clock Accuracy Circuit Driver on r_cac
Storage > & Data Operation Circuit Driver on r_doc
System > 4  Watchdog Driver on r_iwdt
Timers ¥ I 4% Watchdog Driver on r_wdt I
Transfer >

Figure 87: Module Selection

The selected HAL WDT driver is added to the HAL/Common Stacks Panel and the
Property Window shows all configuration options for the selected module. The Property
tab for the WDT should be visible at the bottom left of the screen. If it is not visible check
that the Synergy Configuration perspective is selected.

{5} "[WDT_Application] Synergy Configuration =5

o

Threads Configuration e
Generate Project Content

Threads 4| Mew Thread =] HAL/Common Stacks 4| Mew Stack > % | Remove

v g HAL/Common
42 g_fmi FMI Driver on r_fmi
4% g_cgc CGC Driver on r_cge
47 g_elc ELC Driver on r_elc @ @ @ (O]
42 g_joport |/0 Port Driver on r_ioport
4 g_wdtD Watchdog Driver on r_wdt

& g wdtD Watchdog
Driver on r_wdt

47 g_cgc CGC Driver on 47 g_elc ELC Driver on
r_cgc r_elc

47 g_ioport1/0 Port
Driver on r_ioport

Il Driver on

HAL/Common Objects

Summary | BSP | Clocks |Pins | Threads | Messaging | Components

[T Properties < |1 Problems| @ Smart Browser ™3 =0

g_wdt0 Watchdog Driver on r_wdt

Property

w Common
Parameter Checking

v Module g_wdt) Watchdog Driver on r_wdt
Name
Start Mode
Start Watchdog After Configuration
Timeout

Settings
APl Info

Clock Division Ratio
‘Window Start Position
Window End Position

Value

Default (BSP)

g_wdtl

Register

True

16,384 Cycles

PCLK/8182

100% (Window Pasition Mot Specified)
0% (Window Position Not Specified)

Reset Control Reset Qutput
Stop Control ‘WDT Count Disabled in Low Power Mode
NMI Callback NULL

Figure 88: Module Properties

Change parameter Start Watchdog After Configuration from True to False. The other
parameters can be left with their default values. Setting Start Watchdog After Configuration to
False instructs the WDT driver (via its open API call) to configure the WDT but not to start it. It will
be started later by refreshing it.
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g wdt0 Watchdog Driver on r wdt

Settings Property
AP Info ~ Common
Parameter Checking

Name
Start Mode

Timeout

Clock Division Ratio
Window Start Position
Window End Position
Reset Control

Stop Control

NMI Callback

i=| Properties 1#! Problems Q Smart Browser

~ Module g_wdt) Watchdog Driver on r_wdt

Start Watchdog After Configuration

Value

Default (BSP)

g_wdtl

Register

False

16,384 Cycles

PCLK/B192

100% (Window Position Not Specified)
0% (Window Position Not Specified)
Reset Output

'WDT Count Disabled in Low Power Mode
NULL

G

Figure 89: g wdt Watchdog Driver on WDT Properties

With PCLKB running at 60 MHz the WDT will reset the device 2.23 seconds after the last refresh.

WDT clock

Cycle time

60 MHz / 8192 = 7.32 kHz

1/7.324 kHz = 136.53 us

Timeout = 136.53 us x 16384 = 2.23 seconds

Save the Project Configuration file and click the Generate Project Content button in the top
right corner of the Project Configuration pane.

Figure 90: Generate Project Content Button

The ISDE generates the project files.

3.3.4.5 Components Tab

Generate Project Content

The components tab is included for reference to see which modules are included in the project.
Modules are selected automatically in the Components view when after they are added in the
Threads Tab.

For the WDT project ensure that the following modules are selected:

O WNHF

. HAL_Drivers -> r_cgc

. HAL_Drivers ->r_elc

. HAL_Drivers -> r_ioport
. HAL_Drivers -> r_wdt

. HAL_Drivers -> r_fmi
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Components Configuration

Component Wersion  Description
~ #p HAL Drivers
w o all

r_acmphs 230 High Speed Analog Comparator: Provides=[Comparator]
r_acmplp 230 Low Power Analog Comparator: Provides=[Comparator]
r_adec 23.0 A/D Converter: Provides=[ADC]
r_agt 230 Asynchronous General Purpose Timer: Provides=[TIMER]
r_agt_input_capture 230 Asynchronous Timer Input Capture: Provides=[Input Capture] , Requires=[AGT]
r_analog_connect 230 Analog Connections: Provides=[Analog Connect]
r_cac 230 Clock Accuracy Check: Provides=[CAC]
r_can 23.0 Controller Area Network: Provides=[CAN]

V| r_cge 230 Clock Generation Circuit: Provides=[CGC]
r_cre 230 Cyclic Redundancy Check: Provides=[CRC]
r_ctsu 230 Capacitive Touch Sensing Unit: Provides=[CT5U], Requires=[Transfer]
r_ctsuv2 230 Capacitive Touch Sensing Unit: Provides=[CT5U], Requires=[Transfer]
r_dac 230 D/A Converter: Provides=[DAC]
r_dac8 23.0 8 Bit D/A Converter: Provides=[DAC]
r_dmac 230 Direct Memory Access Controller: Provides=[Transfer]
r_doc 230 Data Operation Circuit: Provides=[DOC]
r_dtc 23.0 Data Transfer Controller: Provides=[Transfer]

| r_elc 23.0 Event Link Controller: Provides=[ELC]
r_flash_hp 230 Flash Memory: Provides=[Flash]
r_flash_lp 230 Flash Memory: Provides=[Flash]

| r_fmi 230 Factory MCU Information Module: Provides=[FMI]
r_gled 230 Graphics LCD: Provides=[Display]
r_gpt 230 General Purpose Timer: Provides=[Timer ,GPT]
r_gpt_input_capture 230 Timer Input Capture: Provides=[Input Capture] , Requires=[GPT]
r_icu 23.0 External IRQ: Provides=[External IRQ]

V| rioport 230 1/0 Port: Provides=[IO Port]
r_iwdt 230 Independent Watchdog Timer: Provides=[WDT]
r_jpeg_common 230 JPEG Common
r_jpeg_decode 230 JPEG Decode: Provides=[JPEG Decode]
r_jpeg_encode 230 JPEG Encode: Provides=[JPEG Encode]
r_kint 230 Key Input: Provides=[Key Matrix]
r_lpmv2_s124 230 Low Power Module V2 for 5124: Provides=[LPMY2]

Summary | BSP | Clocks |Pins | Threads Messaging | Components

Figure 91: Component Selection

Note
The list of modules displayed in the Components tab depends on the installed SSP version.

3.3.5 WDT Generated Project Files

Pressing the Generate Project Content button performs the following tasks.

e r_wdt folder and WDT driver contents created at:
o synergy/ssp/src/driver/

e r_wdt_api.h created in:
o synergy/ssp/inc/driver/api

e r_wdt.h created in:
o synergy/ssp/inc/driver/instances

The above files are the standard files for the WDT HAL module. They contain no specific project
contents. They are the driver files for the WDT. Further information on the contents of these files can
be found in the documentation for the WDT HAL module.
Configuration information for the WDT HAL module in the WDT project is found in:

» synergy cfg/ssp_cfg/driver/r_wdt_cfg.h

The above file’s contents are based upon the Common settings in the g_wdt Watchdog Driver on
WDT Properties pane.
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Property Value

w Common
Parameter Checking Default (B5P) i) [WDT_Application] Synergy Configuration [ r_wdt_cfgh X

~ Module g_wdt0 Watchdog Driver on r_wdt 1 [+ generated configuration header file - do not edit */
Hame g_wdtd 5 = #ifndef R_WDT_CFG_H_
Start Mode Register 3 #define R_WDT_CFG_H_
Start Watchdag After Configuration False 4 #define WDT_CFG_PARAM_CHECKING_ENABLE (BSP_CFG_PARAM_CHECKING_ENABLE)
Timeout 16,384 Cycles 5 #endif /* R_WDT_CFGH_ ™/
Clock Division Ratio PCLK/B192 ?
‘Window Start Position 100% (Window Position Not Specified)
‘Window End Position 0% (Window Position Not Specified)
Reset Control Reset Output
Stop Control WDT Count Disabled in Low Power Mode
NMI Callback NULL

Figure 92: r_wdt_cfg.h Contents
Warning

Do not edit any of these files as they are recreated every time the Generate Project Content
button is pressed and so any changes will be overwritten.

r_ioport folder is not created at ssp/src/driver as this module is required by the BSP and so already
exists. It is included in the WDT project in order to include the correct header file in
src/synergy_gen/hal_data.h - see later in this document for further details. For the same reason the
other IOPORT header files - synergy/ssp/inc/api/r_ioport_api.h and
synergy/ssp/inc/instances/r_ioport.h are not created as they already exist.

In addition to generating the HAL driver files for the WDT and IOPORT files the ISDE also generates
files containing configuration data for the WDT and a file where user code can safely be added.
These files are shown below.

{5 Project Explorer O S 78
~ 2% WDT Application
5 Includes
w [ sre
v [ synergy_gen
|£] common_data.c
[n] common_data.h
|£] hal_data.c
[h] hal_data.h
\.g] main.c
\.£] pin_data.c
|c] hal_entry.c

Figure 93: WDT Project Files

iy
I}
o

3.3.5.1 WDT hal_data.h

The contents of hal_data.h are shown below.

/* generated HAL header file - do not edit */
#i f ndef HAL_DATA H_

#defi ne HAL_DATA H_

#i ncl ude <stdint.h>

#i ncl ude "bsp_api.h"

#i ncl ude "comon_dat a. h"

#i nclude "r_wdt.h"

#i nclude "r_wdt _api . h"
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hal_data.h contains the header files required by the ISDE generated project. In addition this file
includes external references to the g_wdt instance structure which contains pointers to the
configuration, control, api structures used for WDT HAL driver.

Warning

This file is regenerated each time Generate Project Content is pressed and must not be
edited.

3.3.5.2 WDT hal_data.c

The contents of hal_data.c are shown below.
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.stop_control = WDT_STOP_CONTROL_ENABLE,
. p_cal I back = NULL, };
/* Instance structure to use this nodule. */
const wdt_instance t g wdt0 =
{ .p_ctrl = & wdtO _ctrl, .p cfg = & _wdtO cfg, .p_api = & wdt _on_wdt };
void g_hal _init(void)
{

g_conmon_init ();

hal data.c contains g_wdt ctrl which is the control structure for this instance of the WDT HAL driver.
This structure should not be initialised as this is done by the driver when it is opened.

The contents of g_wdt_cfg are populated in this file using the g_wdt Watchdog Driver on WDT
Properties pane in the ISDE Project Configuration HAL tab. If the contents of this structure do
not reflect the settings made in the ISDE, ensure the Project Configuration settings are saved in
the ISDE before pressing the Generate Project Content button.

Warning
This file is regenerated each time Generate Project Content is pressed and so should not be
edited.

3.3.5.3 WDT main.c

Contains main() called by the BSP start-up code. main() calls hal_entry() which contains user
developed code (see next file). Here are the contents of main.c.

/* generated main source file - do not edit */

extern void hal _entry(void);

i nt mai n(voi d)

{
hal _entry ();
return O;
}
Warning
This file is regenerated each time Generate Project Content is pressed and so should not be
edited.

3.3.5.4 WDT hal_entry.c
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This file contains the function hal_entry() called from main(). User developed code should be placed

in this file and function.

For the WDT project edit the contents of this file to contain the code below. This code implements

the flowchart in overview section of this document.

/* HAL-only entry function */
#i ncl ude "hal data. h"
#defi ne RED LED NO OF FLASHES 30
#define RED LED PIN | OPORT _PORT 06 PIN 01 ? In case of SK-S7TQ&
#defi ne GREEN _LED PIN | OPORT _PORT 06 _PIN 00 ? In case of SK-S7&
#def i ne RED_LED DELAY_COUNT 1500000
#defi ne GRN_LED DELAY_COUNT 1200000
volatile uint32_t delay counter;
vol atile uintl16_t | oop_counter;
voi d hal _entry(void)
{
/* TODO add your own code here */
/* Open the WDT */
g_wdt 0. p_api - >open(g_wdt 0. p_ctrl, (wdt_cfg t *const)g wdtO.p_cfg);
/* Start the WDT by refreshing it */
g_wdt 0. p_api ->refresh(g wdtO.p_ctrl);
/* Flash the red LED and tickle the WDT for a few seconds */

for(l oop_counter=0; | oop_counter<RED LED NO OF FLASHES; | oop_counter ++)

{
/* Turn red LED on */

g_ioport.p_api->pinWite(RED LED PIN, | OPORT_LEVEL H GH);
[* Delay */

for(del ay_counter=0; del ay_ counter<RED LED DELAY COUNT; del ay_ counter ++);

/* Refresh WDT */
g_wdt 0. p_api ->refresh(g wdtO0.p_ctrl);
[* Turn red off */
g_ioport.p_api->pinWite(RED LED PIN, | OPORT_LEVEL_LOV);
/* Delay */

for(del ay_counter=0; del ay_ counter<RED LED DELAY COUNT; del ay_ counter ++);

/* Refresh WDT */
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g_wdt 0. p_api - >refresh(g_wdt 0. p_ctrl);
}
/* Flash green LED but STOP tickling the WDT. WDT shoul d reset the
devi ce */
whi | e(1)
{
/[* Turn green LED on */
g_ioport.p_api->pinWite(GREEN LED PIN, | OPORT _LEVEL H GH);
/* Delay */
for(del ay_counter=0; delay counter<GRN LED DELAY COUNT; del ay counter ++);
/* Turn green off */
g_ioport.p_api->pinWite(GREEN LED PIN, | OPORT_LEVEL LOW);
/* Delay */
for(del ay_counter=0; delay counter<GRN LED DELAY COUNT; del ay counter ++);
}

The WDT HAL driver is called through the interface g_wdt_on_wdt defined in r_wdt.h. The WDT
HAL driver is opened through the open API call using the instance defined in r_wdt_api.h:

g_wdt 0. p_api - >open(g_wdt 0. p_ctrl, (wdt_cfg t *const)g wdtO.p_cfg);

The first passed parameter is the pointer to the control structure g_wdt_ctrl instantiated in
hal_data.c. The second parameter is the pointer to the configuration data g_wdt_cfg instantiated in
the same hal_data.c file.

The WDT is started and refreshed through the API call:

g_wdt 0. p_api - >refresh(g_wdt 0. p_ctrl);

Again the first (and only in this case) parameter passed to this API is the pointer to the control
structure of this instance of the driver.

3.3.6 Building and Testing the Project

Build the project in the ISDE Build > Build Project. The project should build without errors.

To debug the project
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1. Connect the JLink debugger between the target board and host PC. Apply power to the
board.

2. In the Project Explorer pane on the right side of the ISDE right-click on the WDT project
WDT _Application and select Debug As > Debug Configurations.

3. Under Renesas GDB Hardware Debugging select WDT_Application Debug as shown

below.

Create, manage, and run configurations @

EiE =| x| B v - Mame: |WDT_AppI|cat\Dn Debug |

‘t}'PEmtEftE’(t | %5 Debugger | = Startup | % Source| ] Common
[c] C/C++ Application
[£] C/C++ Remote Application
= EASE Script ‘ WOT_Application Browse...
[&] GDB Hardware Debugging C/C++ Application:
[E] 6DB OpenOCD Debugging | Debug/WDT_Application.elf
[c7] GDB Simulator Debugging (RHS50)
¥ Java Applet Variables... Search Project... Browse..,
[T Java Application
@ Launch Group
[T Remote Java Application Build Configuration: |Use Active ~

v [£7 Renesas GDB Hardware Debugging

Project:

Build (if required) before launching

[©] WDT_Application Debug (O Enable auto build () Disable auto build
[£9 Renesas Simulator Debugging (RX, RL78) (®) Use workspace settings Configure Workspace Settings...
Revert Apply
Filter matched 13 of 15 items ever pply
=)

Figure 94: Debug Configuration

4. Press the Debug button. Switch (Yes) to the Debug perspective if asked.

5. The code should run to the Reset _Handler() function.

6. Resume execution via Run > Resume. Execution will stop in main() at the call to
hal_entry().

7. Resume execution again.

The red LED should start flashing. After 30 flashes the green LED will start flashing and the red LED
will stop flashing.

While the green LED is flashing the WDT will underflow and reset the device resulting in the red LED
to flash again as the sequence repeats. However, this sequence does not occur when using the
debugger because the WDT does not run when connected to the debugger.

1. Stop the debugger in the ISDE via Run > Terminate.
2. Press the reset button on the target board. The LEDs begin flashing.

3.4 IAR Embedded Workbench for Renesas

3.4.1 Using IAR Embedded Workbench for Synergy

This section describes how to use the IAR Embedded Workbench for Renesas Synergy (IAR EW for
Synergy) in combination with the Renesas Synergy Standalone Configurator (SSC) to develop
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applications with the Renesas Synergy Software Package (SSP). The architecture of the SSP directly
determines how you use the IAR EW for Synergy and SSC to develop a Synergy application. See the
following documents for details on the SSP architecture included in this manual:

e SSP Architecture
e BSP Architecture

3.4.2 What is IAR EW for Synergy?

IAR Embedded Workbench is now completely integrated with the Renesas Synergy Platform. The
new product IAR EW for Synergy provides add-on functionality to simplify and accelerate software
development, and provide the best performance and smallest code size.

Just like e? studio, IAR EW for Synergy offers secure source-level visibility into the Synergy Software
Package (SSP) as well as secure source-level debugging. The developer can see protected source
code but not modify or save it. Once the application code is developed, IAR EW for Synergy includes
IAR C-STAT® and C-RUN® analyzers, tools which help and guide to improve application code quality.

3.4.3 IAR EW Key Features

Integrated development environment with project management tools and editor
Highly optimizing C and C++ compiler and Linker for Renesas Synergy devices
Integration support for Renesas Synergy Standalone Configurator (SSC)

C-STAT and C-RUN code analysis tools included

Extensive HW target system support

Power debugging to visualize power consumption in correlation with source code
C-SPY® Debugger with JTAG/SWD support and support for RTOS-aware debugging on
hardware

e Support for ETM Trace

e Comprehensive user and reference guides and context-sensitive help function

e Compliant with ARM® Embedded Application Binary Interface (EABI) and ARM Cortex®
Microcontroller Software Interface Standard (CMSIS)

For detailed instructions on how to download and install IAR EW for Synergy, see the IAR EW for
Synergy Release Notes on the Synergy Gallery.

3.4.4 What is Synergy Standalone Configurator (SSC)?

The Synergy Standalone Configurator (SSC) is an Eclipse Rich Client Platform (RCP) application
containing the Synergy Project Generator and the Synergy Project Editor as implemented in the
Renesas e’ studio ISDE. SSC includes configurators like the Clock Configurator, Pin Configurator,
RTOS Configurator, SSP Module Selector/Configurator, and Interrupt Control Unit (ICU) Configurator
for use with 3™ party IDEs such as IAR EW for Synergy.
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IAR Embedded Workbench®

for Renesas Synergy™ Synergy Standalone Configurator (SSC)

Synergy Project Generator

Synergy Project Editor

C-SPY Debugger IAR toolchain for ARM

BSP Configurator  Clock Configurator

RTOS/HAL/SSP

Configurator Pin Configurator

Synergy-based
Target Board

Figure 95: IAR EW for Synergy and SSC Functional Block Diagram

Since the functionality of the SSC is identical to the Synergy Project Generator and the Synergy
Project Editor as implemented in the Renesas e? studio ISDE, refer to e2 studio ISDE User Guide for
information on how to use it.

For detailed instructions on how to download and install the SSC and the SSP to use with IAR EW for
Synergy, see the SSC Release Notes and the SSP Release notes on the Synergy Gallery.

3.4.5 Installing the Tools
To install the tools, follow the steps below:

1. Download and install the Renesas Synergy Standalone Configurator (SSC) from the Renesas
Synergy Gallery. You can find it under Development Tools. The default installation directory
is C:\Renesas\Synergy\SSC_<SSCversion>.

2. Download and install the Renesas Synergy Software Package (SSP) from the Renesas
Synergy Gallery. During the installation you will be prompted to specify an installation
directory for the SSP. Point the SSP installer to the directory where you just installed the
SSC (for example C:\Renesas\Synergy\SSC_<SSCversion>).

3. Download and install IAR Embedded Workbench for Renesas Synergy from the Renesas
Synergy Gallery. To install IAR Embedded Workbench:

a. In your web browser, specify the URL https://synergygallery.renesas.com and
download IAR Embedded Workbench for Renesas Synergy from the Renesas
Synergy Gallery. You will also find information about how to obtain a license and
get a license number.

b. Execute the installer that is included in the downloaded file.

c. Specify the license number when prompted for in the IAR License Manager.
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Note
The lAR EW for Synergy license entitles you to use this specific edition of AR Embedded
Workbench, but not the Synergy Standalone Configurator for which separate licenses are
required.

3.4.6 Creating a Renesas Synergy Project using IAR EW for Synergy and
SSC

To create a Synergy Project using IAR EW for Synergy and SSC, follow the steps below:

1. In the IAR Embedded Workbench IDE, choose Project>Create New Project.

2. In the Create New Project dialog box, select Renesas Synergy Project and click OK.

G ™
Create New Project liz-l

Tool chain: ARM vJ

Project templates

~E Empty project

w23 asm

w00 Ce+

w3 C

L e Fv‘fnrnn":{hlu" avaritahla

‘- #+ Renesas Synergy Project

Description:

Creates an empty project.

OK | { Cancel

Figure 96: Creating a New Synergy Project using IAR EW for Synergy

3. In the Save As dialog box that appears, choose a suitable destination directory for your
workspace (the container that holds your project), for example MyWorkspace, and click
Save.

Note
Do not save your workspace in the root directory of your operating system (C:).

4. In the Renesas Synergy Setting dialog box that appears, specify the location of your
installed Synergy Standalone Configurator (SSC), which by default is installed in
C:\Renesas\Synergy\SSC_<SSCversion>.

Note
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You do not need to specify a licensefile. You can click OK with the Licensefile field empty. An SSP
licensefileis not required and the source files are not encrypted for SSP v2.0.0 and later.

Renesas Synergy Settings X

Location where Renesas Synergy S5C/55F iz installed;
C:\Renesas\SynerquiSSC_v2022 10 R20221013 5| Wl oo

License file:

License information:

[] Replace encrypted files with decrypted fles

Cancel
Figure 97: Renesas Synergy Settings in IAR EW for Synergy

5. Click OK.

6. In the Save As dialog box that appears, specify the name of your project, for example
MyProject.

Note

Do not save your project in the root directory of your operating system (C:).

7. The IAR Embedded Workbench IDE now connects with the Renesas Synergy Standalone
Configurator (SSC). Specify the board support you require:

m | Synergy Standalone Configurator o == @

Synergy Standalone Configurator —

Select the board support that you require.

Device Selection

SSP version: [ XXX - ‘

Board:  [S7G2DK -|

Device:  |R7FS7G27H2A01CBD || .. |

< Back Next > Finist Cancel

Figure 98: SSC selection Dialog for SSP, Board, and MCU to be used

Note
The SSP versions available in the drop-down list correspond to the versions you have previously
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installed on your computer.

Click Next.

8. The Synergy Software Packages come with several example projects, which include source
code files, header files, and linker configuration files, adapted for your device. Select the
example packages that you want to add to your project:

-

-
Synergy Standalone Configurator l | = |ﬁ

Synergy Standalone Configurator

Select the type of project you wish to create.

Project Template Selection

| BSP
g Base Board Support Package for the chosen Synergy family. No RTOS included.

| S7G2-DK BSP
Q Board Support Package for the S7G2-DK. No RTOS included.

® g §7G2-DK Blinky

Blinky for the S7G2-DK.

'| $7G2-DK Blinky with ThreadX
Q Threaded version of Blinky for the S7G2-DK.

Q °i 5$7G2-DK Developer Examples

Developer example code exercised over a command line interface.

\,
v

m

Next > [ Finish ] [ Cancel

Figure 99: Project Template Selection Dialog

Click Finish.

9. In the Synergy Project Editor that opens up, you can now configure MCU pin function
assignments, clock and peripheral settings, and interrupt source assignments. When
finished configuring, click the Generate Project Content button. The source code is now

generated.

R11UMO0161EU0160 Revision 1.

Mar.29.2024

60 RENESAS

Page 138 /5,198



Synergy Software Package User’s Manual
Starting Development > IAR Embedded Workbench for Renesas > Creating a Renesas Synergy Project using IAR EW for Synergy and SSC

= | ®

S5 Pacoge] @ @ - [ @~ B~ -
0 1 2 3 4 5 6 7 8

Generate Project Content L N vee_ ||
s [oam [on | vss || vss || soos | pass | 755 v
e configuration file (configuration — || = [Fus %08 [0 | vee | vee %z | sosz [ 5200 [—,,-_‘;

‘ | 7z ~ VIV IV~

< [P111 [P1s0 P1s2 | Pa0s 7309 [[P310 [[P311 | p201 || 2o

Figure 100: Generate Project Content Button

Note
You can always add or change the configuration of your Synergy project later on.

10. After a couple of seconds, your Renesas Synergy project is displayed in the IAR EW
Workspace window:

rﬁ MyWorkspace - IAR Embedded Workbench IDE

File Edit View Project Simulator Tools Window
D@ & 8RR o
Workspace x
[Debug v

Files &z By

=Ju MyProject- Debug* | v |
-2 @ Synergy
L a1 Source Files
e Csrc
H82 (O synergy_gen

common_data.c .
— B) common_data h
= ) hal_data.c B
— k) hal_data.h
Fa R main.c >
L@ [ pin_datac .
& [ hal_entry.c -
g O synergy

Lassp

Faine

| Fabsp

| FaCdriver

| — ) ssp_common_apih

| L— P ssp_versionh

Lasrc x
51 (1 Output

L— [ MyProject.out

Figure 101: IAR EW for Synergy Workspace and Project Window

11. If you close the SSC, you can re-open it again by clicking the Synergy Configuration button
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in the toolbar, or by selecting Renesas Synergy > Configurator from the menu.

12. Whenever you switch back to the SSC to change configuration settings, click the Generate
Project Content button when finished. The affected source code files are now re-
generated.

13. You can now continue building and debugging according to the standard routines in the IAR
Embedded Workbench IDE, see the IAR Embedded Workbench® IDE User Guide on the IAR
web site.

As the SSC works just like the Synergy Project Editor in e? studio, refer to e2 studio ISDE
User Guide for more details on how to use it.

Note that the Synergy Project is by default configured for the J-Link debugging probe.
If you have another debugging probe, for example I-jet or I-jet Trace, choose

Project>Options>Debugger in the IDE and select I-jet/|TAGjet from the Driver drop-down
list.
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Chapter 4 Module Overviews

You can find a list of Module Overviews on the following pages:

e Framework Layer
e HAL Layer
e Azure RTOS Modules

The Module Overviews for each SSP module have been significantly improved since the last release.
The new Module Overviews should provide all the information necessary for a developer to evaluate
a specific modules fitness for use in a target application and significantly help with the development
process. The intent of these notes is to provide all the information needed to begin developOment
with the target module in one easy to find location.

Each Module Overview includes the following sections:

1. A short introduction to the module includes a short description, a block diagram of key
module components, and a list of features

2. An API table lists all the available APIs, and example use of the APl and a short description
of the APIs function. A list of some of the key Status Return values is provided to help
determine the result of the API call.

3. A functional overview describes key module operations and includes a list of important
module limitations.

4. A step-by-step description of how to include the module in an application using the ISDE
threads tab and stack selection process.

5. A set of tables showing the configuration parameters for the module and key lower level
modules is provided so the developer can easily see the modules key capabilities. Note that
these configurable properties vary by MCU series and by SSP Release. Treat the tables in
these notes as illustrations and refer to the actual parameters available within the ISDE for
your target MCU and for your chosen SSP release. Example pin and clock configuration and
selection information is also provided to help guide development.

6. A simple implementation using the target module is provided and shows the steps used in a
typical application, the associated flow diagram, and the API use at each step. This helps
describe how APIs are commonly used and will give the developer a head start with their
implementation.

Module Guide Application Notes

These six sections are also found in the Module Guide Application Notes for a specific module. In the
Application Note additional sections provide detailed descriptions of the associated application
project that demonstrates the module working in an actual design. Development can be dramatically
simplified when the application project is used as a starting point or reference for a new design.
Module guide application notes can be found with the following search:
https://www.renesas.com/us/en/support/document-search?doc_file_all_types%5BApplication+Note%5
D=Application+Note&doc_file_all_types%5BSample+Code+-+FIT+Module%5D=Sample+Code+-+Fl
T+Module&doc file_all_types%5BSample+Code%5D=Sample+Code&doc_category tier 1=467666&
doc_category_tier 2=469306&doc_part_ numbers=&keywords=&sort_order=DESC&sort_by=field _do
cument_revision_date#documentation-tools-results. More module guide application notes are being
added all the time so check back frequently to find when new ones have been released.
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Module Overviews

Using the Module Guide Module Overviews

The Module Overviews provide sufficient details to begin development, but there will be cases when
additional information is useful in implementing a design. The SSP User Manual provides a wealth of
information on the details of APl implementation, structures, enumerations and more. Simply jump to
the API reference section and find your module of interest to find any additional information you
might need.

HAL modules have chapters that cover the above topics as well. It is highly recommended that you
spend some time looking at the reference material available in ALL the reference chapters so you
know where to look when an APl implementation question, not answered in the module guide usage
note or associated module guide application note, comes up.

4.1 Framework Layer

Some SSP framework modules are not included in the following list of Module Overviews. This is
because some modules, although they can be selected and added to a thread, are only used as
lower level modules and are not expected to be used by a developer separately. These modules are
included in the Module Overview for the higher level module however. So if additional information is
desired, just refer to the associated higher level Module Overview. The following list shows how to
find these 'missing' modules:

Module Included In

D/AVE 2D Port on sf_tes_2d_drw GUIX Port on sf_el_gx under the Azure RTOS
Modules section as GUIX Port

D/AVE 2D Driver on dave2d GUIX Port on sf_el_gx under the Azure RTOS
Modules section as GUIX Port

ADC Periodic Framework

Audio Playback Framework

Audio Playback Hardware Framework Shared on sf audio_playback _hw_dac
Audio Playback Hardware Framework Shared on sf audio_playback hw_i2s
Audio Record ADC Framework

Audio Record I12S Framework

Block Media Framework on sf block_media_Ix_nor

Block Media Framework on sf block_media_gspi

Block Media Framework on sf_block_media_ram
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Block Media Framework on sf_block_media_sdmmc
BLE Framework

Cellular Framework

Telnet Communications Framework on sf comms_telnet
Communications Framework on sf_el_ux_comms_v2
Console Framework

Crypto Framework

Capacitive Touch v2 Framework

External IRQ Framework

I12C Framework

JPEG Decode Framework

Memory Framework on sf_memory_qspi_nor
Messaging Framework

Power Profiles V2 Framework

SPI Framework

Thread Monitor Framework

Touch Panel V2 Framework

UART Communications Framework

Wi-Fi Framework

Wi-Fi QCA4010 Framework

4.1.1 ADC Periodic Framework

4.1.1.1 ADC Periodic Framework Module Introduction

The ADC Periodic Framework provides a high-level API for signal processing applications. The module
configures the ADC/SDADC to sample any of the available channels (using the single-scan mode) at a
configurable rate and buffers the data for a configurable number of sampling iterations before
notifying the application. The ADC Periodic Framework uses the ADC/SDADC, GPT or AGT and DTC
peripherals on a Renesas Synergy™ Microcontroller. A user-defined callback can be created to
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process the data each time a new sample is available.
ADC Periodic Framework Module Features

24-bit Sigma-Delta A/D Converter (S1JA only).
16-bit A/D Converter (S1JA)
14-bit A/D Converter (S3A7, S3A6, S3A3, 5124, S128)
12-bit A/D Converter (57G2, S5D9, S5D5)
Multiple Operation Modes
o Single Scan
o Group Scan
o Continuous Scan
Multiple Channels
o 1 channel (S1JA)
o 13 channels (unit 0), 12 channels (unit 1) (57G2 and S5D9)
13 channels (unit 0), 9 channels (unit 1) (S5D5)
18 channels (5124)
21 channels (5128)
25 channels (S3A6)
28 channels (S3A7)
Temperature sensor channel
Voltage sensor channel

o e o o o o

o 0 o o o o o

Application

Framework

ADC Periodic Framework Interface
sf_adc_periodic_instance

ThreadX® N
RTOS HAL Drivers / \ / \
ADC Driver ADC Driver Timer Driver Timer Driver Transfer Driver
R_ADC R_SDADC (S1JA) R_AGT R_GPT R_DTC

BSP

Figure 102: ADC Periodic Framework Module Block Diagram

4.1.1.2 ADC Periodic Framework Module APIs Overview

The ADC Periodic Framework defines APIs for opening, closing, starting and stopping the ADC scans.
A complete list of the available APIs, an example API call and a short description of each can be
found in the following table. A table of status return values follows the APl summary table.

ADC Periodic Framework Module APl Summary

Function Name Example API Call and Description

open g_sf adc_periodic.p_api->open(g_sf adc_periodic
.p_ctrl, g_sf adc_periodic.p_cfqg);

Acquires mutex, then initializes module at the
HAL layer.
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start g_sf adc_periodic.p_api->start(g_sf adc_periodic
.p_ctrl);
Starts the scan.

stop g_sf adc_periodic.p_api->stop(g_sf adc_periodic.
p_ctrl);

Stops the hardware trigger (timer) from
triggering any more ADC scans.

close g_sf adc_periodic.p_api->close(g_sf adc_periodi
c.p_ctrl);
Releases channel mutex and closes channel at
HAL layer.

versionGet g_sf_adc_periodic.p_api->versionGet(&version);
Retrieve the API version using the version
pointer.

Note

For more complete descriptions of operation and definitions for the function data structures, typedefs, defines, API
data, API structures, and function variables, review the SSP User's Manual API References for the associated
module.

Status Return Values

Name Description
SSP_SUCCESS API Call Successful.
SSP_ERR_UNSUPPORTED Command not found in the current menu.
SSP_ERR_NOT_OPEN Driver control block not valid.
CallSF_ADC_PERIODIC_Open to configure.
SSP_ERR_ASSERTION Version get error- p_version was NULL.
SSP_ERR_INTERNAL An internal ThreadX® error has occurred. This is

typically a failure to create/use a mutex or to
create an internal thread.

Note
Lower-level drivers may return common error codes. Refer to the SSP User's Manual API References for the
associated module for a definition of all relevant status return values.

4.1.1.3 ADC Periodic Framework Module Operational Overview

The ADC Periodic Framework module samples and buffers ADC data. The Framework notifies the
application once the configured number of samples are buffered. The ADC Periodic Framework works
as follows:

e After initial configuration and after the scan process is started, the framework uses a
hardware timer to trigger an ADC scan in one-shot mode. Each scan can consist of one or
more channels. When each scan is completed, the ADC interrupt is intercepted by the DTC,
which moves the result of the scan into the user buffer.

e Each scan is defined as a sampling iteration, and the number of samples generated for each
scan is equal to the number of channels. If the channels are sequential, for example,
channels 1, 2, 3, 4, the data is captured in order. If the channels are not in sequence, for
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example, channels 1, 3, 4, 5, then the samples generated by each scan also include data
from the unused channels in between. Thus, in the second example, five samples are
stored to the user buffer each time.

e The user specifies the total number of sample iterations that need to occur before being
notified. When the specified number of sampling iterations have occurred and the data for
each iteration has been stored into the user buffer, the user is notified via a callback with
an index for the valid data in the buffer and an event indicating that sampling for the
specified number of iterations is complete.

Unless the user stops the scan process, the scan continues to be triggered by the timer (using AGT
or GPT) and data will be written into the user buffer, which is treated by the Framework as a circular
buffer. The name and length of the buffer are specified via the ISDE configurator.

ADC Periodic Framework Module Important Operational Notes and Limitations

ADC Periodic Framework Module Operational Notes

1. At least one channel must be chosen while configuring the ADC/SDADC HAL driver to avoid
an API return error.

2. When configuring the scan rate for the ADC Framework (the GPT or AGT timer period),
make sure that the period is long enough to accommodate scanning of all selected
channels (about 2 microseconds for each channel conversion on a Synergy S7G2 device).

3. The ADC Periodic Framework stores data for all the channels from each scan into the user
specified buffer. When the specified number of sample iterations are completed, the user is
notified. If five channels are selected (channels 1,2,3,4,5) and the sample count is set to 3,
the user will be notified when 5 x 3 = 15 samples are available. The samples are ordered as
follows:

112 34 51, 2 3|4|5 12|34 5

Figure 103: ADC Periodic Framework Module Sample Order

When selecting the data buffer length in the ADC Periodic Framework configuration, make sure that
the buffer length is at least twice the length of the number of samples that will be generated (15 x 2
= 30 in this example). This is because once the user application is notified that the data is available,
the Framework will keep buffering in new data at the sample rate. Since the buffer is treated as a
circular buffer, you can inadvertently overwrite the data. If the size is not larger than the number of
samples generated, the data is overwritten before the application can use it.

The application callback has an index into the appropriate location in the buffer where valid data is
present.

ADC Periodic Framework Module Limitations

The ADC Periodic framework does not currently support the following features:
o The use of Group Scan mode
o The use of DMA
e When configuring the ADC channels to be used with this framework, the temperature or
voltage sensors must not be selected if any of the other available channels are also
selected. It is possible to use only the temperature sensor, only the voltage sensor, or any
number of the regular ADC channels.
e ADC Periodic framework does not support DTC transfer when lower lever driver is SDADC.
e When using ADC Periodic framework with lower level SDADC of 24-bit, user should not
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access output data through "p_args" in callback function. User should access output data
only through user defined buffer.

e Refer to the most recent SSP Release Notes for any additional operational limitations for
this module.

4.1.1.4 Including the ADC Periodic Framework Module in an Application

This section describes how to include the ADC Periodic Framework Module in an application using the
SSP configurator.

Note
This section assumes you are familiar with creating a project, adding threads, adding a stack to a thread and
configuring a block within the stack. If you are unfamiliar with any of these items, refer to the first few chapters of
the SSP User's Manual to learn how to manage each of these important stepsin creating SSP-based applications.

To add the ADC Periodic Framework to an application, simply add it to a thread using the stacks
selection sequence given in the following table. (The default name for the ADC Periodic Framework is
g_adc_periodic0. This name can be changed in the associated Properties window.)

ADC Periodic Framework Module Selection Sequence

Resource ISDE Tab Stacks Selection Sequence
g_sf adc_periodicOADC Periodic | Threads New Stack> Driver>
Framework on sf_adc_periodic Analog> ADC Periodic

Framework on
sf_adc_periodic

When the ADC Periodic Framework on sf _adc_periodic is added to the thread stack as shown in the
following figure, the configurator automatically adds any needed lower-level modules. Any modules
needing additional configuration information have the box text highlighted in Red. Modules with a
Gray band are individual modules that stand alone. Modules with a Blue band are shared or
common; they need only be added once and can be used by multiple stacks. Modules with a Pink
band can require the selection of lower-level modules; these are either optional or recommended.
(This is indicated in the block with the inclusion of this text.) If the addition of lower-level modules is
required, the module description include Add in the text. Clicking on any Pink banded modules brings
up the New icon and displays possible choices.
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New Thread Stacks ¢ | New Stack > x| Remove

¢ g_sf_adc_periodicO ADC Periodic Framework on sf_adc_periodic

®

A
I | |
@ g_adc0 ADC Driveron | | %% Add Timer Driver @ g_transfer0 Transfer
r_adc Driver on r_dtc
Software Activation 1
A A

Figure 104: ADC Periodic Framework Module Stack

Note
The above diagramwill have an "Add ADC Driver" block instead of the "g_adc0" block for the SLJA only.

4.1.1.5 Configuring the ADC Periodic Framework Module

The ADC Periodic Framework Module must be configured by the user for the desired operation. The
available configuration settings and defaults for all the user-accessible properties are given in the
properties tab within the SSP configurator and are shown in the following tables for easy reference.
Only properties that can be changed without causing conflicts are available for modification. Other
properties are locked and not available for changes and are identified with a lock icon for the locked
property in the Properties window in the ISDE. This approach simplifies the configuration process and
makes it much less error-prone than previous manual approaches to configuration. The available
configuration settings and defaults for all the user-accessible properties are given in the Properties
tab within the SSP Configurator and are shown in the following tables for easy reference.

Note
You may want to open your | SDE, create the module and explore the property settings in parallel with looking over
the following configuration table settings. Thiswill help orient you and can be a useful 'hands-on' approach to
learning the ins and outs of developing with SSP.

Configuration Settings for the ADC Periodic Framework Module on sf_adc_periodic

ISDE Property Value Description
Parameter Checking BSP, Enabled, Disabled Enables or disables the
parameter checking.
Default: BSP
Name g_sf adc_periodicO Module name.
Name of the data-buffer to g_user_buffer Name of the 16-bit data buffer
store samples to store samples.
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Length of the data-buffer 128 Length of the buffer to which
data is to be stored.

Number of sampling iterations |10 Priority of ADC Periodic
Framework internal thread.

Callback g_adc_framework user_callback | User function that will be called
once "sample_counts" number
of data has been buffered.

Name of generated initialization | sf adc_periodic_init0 Name of generated initialization
function function selection.
Auto Initialization Enable, Disable Auto initialization selection.

Default: Enable

Note
The example settings and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the ADC Periodic Framework Module Lower Level Modules

Typically, only a small number of settings must be modified from the default for lower level drivers
as indicated via the red text in the thread stack block. Notice that some of the configuration
properties must be set to a certain value for proper framework operation and will be locked to
prevent user modification. The following tables identify all the settings within the properties section
for the module.

Configuration Settings for the ADC HAL Module on r_adc

ISDE Property Value Description
Parameter Checking BSP, Enabled, Disabled If selected code for parameter
checking is included in the
Default: Enabled build.
Name g_adcO Module name.
Unit 0, 1 (57G2 Only) Specify the ADC Unit to be
used. The S7G2 has two units; 0
Default: 0 and 1.
Resolution 14-Bit (S3A7/S124 Only), 12-Bit, | Specify the conversion
10-Bit (57G2) resolution for this unit.

Default: 8-Bit (S7G2 Only)

Alignment Right, Left Specify the conversion result
alignment.
Default: Right
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Clear after read

Off, On

Default: On

Specify if the result register
must be automatically cleared
after the conversion result is
read.

Note: If this is enabled, then
watching the result register
using a debugger always
results in a 0.

Mode

Single Scan

The ADC Framework
preconfigures and locks this
field.

Channels 0-6

Unused, Use in Normal/Group A,
Use in Group B

Default: Unused

In Normal mode of operation,
this bitmask field is used to
specify the channels that are
enabled in that ADC unit. For
example, if it is set to 0x101,
then channels 0 and 2 are
enabled. In group mode, this
field is used to specify which
channels belong to group A.

Channels 7-10 (S3A7/5124
Only)

Unused, Use in Normal/Group A,
Use in Group B

Default: Unused

In Normal mode of operation,
this bitmask field is used to
specify the channels that are
enabled in that ADC unit. For
example, if it is set to 0x101,
then channels 0 and 2 are
enabled. In group mode, this
field is used to specify which
channels belong to group A.

Channels 11-15 (S3A7 Only)

Unused, Use in Normal/Group A,
Use in Group B

Default: Unused

In Normal mode of operation,
this bitmask field is used to
specify the channels that are
enabled in that ADC unit. For
example, if it is set to 0x101,
then channels 0 and 2 are
enabled. In group mode, this
field is used to specify which
channels belong to group A.

Channels 16-20

Unused, Use in Normal/Group A,
Use in Group B

Default: Unused

In Normal mode of operation,
this bitmask field is used to
specify the channels that are
enabled in that ADC unit. For
example, if it is set to 0x101,
then channels 0 and 2 are
enabled. In group mode, this
field is used to specify which
channels belong to group A.
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Channel 21 (Unit 0 Only)

Unused, Use in Normal/Group A,
Use in Group B

Default: Unused

In Normal mode of operation,
this bitmask field is used to
specify the channels that are
enabled in that ADC unit. For
example, if it is set to 0x101,
then channels 0 and 2 are
enabled. In group mode, this
field is used to specify which
channels belong to group A.

Channel 22 (S3A7/5124 Only)

Unused, Use in Normal/Group A,
Use in Group B

Default: Unused

In Normal mode of operation,
this bitmask field is used to
specify the channels that are
enabled in that ADC unit. For
example, if it is set to 0x101,
then channels 0 and 2 are
enabled. In group mode, this
field is used to specify which
channels belong to group A.

Channels 23-27 (S3A7 Only)

Unused, Use in Normal/Group A,
Use in Group B

Default: Unused

In Normal mode of operation,
this bitmask field is used to
specify the channels that are
enabled in that ADC unit. For
example, if it is set to 0x101,
then channels 0 and 2 are
enabled. In group mode, this
field is used to specify which
channels belong to group A.

Temperature Sensor

Unused, Use in Normal/Group A,
Use in Group B

Default: Unused

Temperature sensor use
selection for Channel Scan
Mask.

Voltage Sensor

Unused, Use in Normal/Group A,
Use in Group B

Default: Unused

Voltage sensor use selection for
Channel Scan Mask.

Normal/Group A Trigger

ELC Event

The ADC Framework
preconfigures and locks this
field.

Group B Trigger (Valid Only in
Group Scan Mode)

ELC Event (The only valid
trigger for either group in Group
Scan Mode)

The ADC Framework
preconfigures and locks this
field.
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Group Priority (Valid only in
Group Scan Mode)

Group A cannot interrupt Group
B, Group A can interrupt Group
B; Group B scan restarts at next
trigger, Group A can interrupt
Group B; Group B scan restarts
immediately, Group A can
interrupt Group B; Group B scan
restarts immediately and scans
continuously

Default: Group A cannot
interrupt Group B

Do not use with ADC
Framework since the mode is
locked to Single Scan Mode.

Add/Average Count

Disabled, Add two samples, Add
three samples, Add four
samples, Add sixteen samples,
Average two samples, Average
four samples

Default: Disabled

Specify if addition or averaging
needs to be done for any of the
channels in this unit. The actual
channels are specified by using
a channel mask
adc_channel_cfg_t::add_mask.

Channels 0-27

Disabled, Enabled

Default: Disabled

This field is valid only if
adc_cfg t::add_average count
is enabled. This field
determines what channels
results are to be averaged or
summed.

Temperature Sensor

Disabled, Enabled

Default: Disabled

Temperature sensor use
selection for Addition/Averaging
Mask.

Voltage Sensor

Disabled, Enabled

Default: Disabled

Voltage sensor use selection for
Addition/Averaging Mask.

Channels 0-2

Disabled, Enabled

Default: Disabled

Determines which of channels
0, 1 and 2 are using the
updated sample-and-hold
states value specified in
adc_channel cfg_t::sample_hold
_states. This field must only be
set if it is desired to modify the
default sample and hold count
value for channels 0, 1 and 2.

R11UMO0161EU0160 Revision 1.60
Mar.29.2024

RLENESAS

Page 152 /5,198



Synergy Software Package

Module Overviews > Framework Layer > ADC Periodic Framework > Configuring the ADC Periodic Framework Module

User’s Manual

Sample Hold States (Applies
only to the 3 channels selected
above)

24

Specifies the updated sample-
and-hold count for the channel
dedicated sample-and-hold
circuit. This field is valid only if
adc_channel cfg_t::sample_hold
_mask is not 0. Only channels
0, 1 and 2 have dedicated
sample and hold circuits.

Note: Use this to modify the
default number of states (24)
for which the value is sampled.
Each state is equal to 1/ADCLK
time.

Callback

NULL

The ADC Framework uses the
callback internally.

Scan End Interrupt Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

Scan End Interrupt Priority
selection.

Scan End Group B Interrupt
Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

Scan End Group B Interrupt
Priority selection.

Note

The exampl e settings and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the SDADC HAL Module on r_sdadc(Only for S1JA)

ISDE Property

Value

Description

Parameter Checking

BSP, Enabled, Disabled

Enable or disable parameter
error checking.

Default: BSP
Name g_adcO Module name.
Mode Single Scan, Continuous Scan In single scan mode, all
channels are converted once
Default: Continuous Scan per start trigger, and
conversion stops after all
enabled channels are scanned.
In continuous scan mode,
conversion starts after a start
trigger, then continues until
stopped in software.
Resolution 16 Bit, 24 Bit Select 24-bit or 16-bit

Default: 24 Bit

resolution.
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Default: Software

Alignment Right, Left Select left or right alignment.
Default: Right
Trigger ELC Hardware Event, Software | Select conversion start trigger.

Conversion can be started in
software, or conversion can be
started when a hardware event
occurs if the hardware event is
linked to the SDADC peripheral
using the ELC API.

Vref Source

Internal, External

Default: Internal

Vref can be sourced internally
and output on the SBIAS pin, or
Vref can be input from VREFI.

Vref Voltage

0.8V,1.0V,1.2V,14V,16V,
1.8V,20V,22V,24V

Default: 1.0 V

Select Vref voltage. If Vref is
input externally, the voltage on
VREFI must match the voltage
selected within 3%.

Internal Calibration During
Open()

Enabled, Disabled

Default: Enabled

Calibration is required for all
channels configured for
differential input. Internal
calibration is performed
automatically during open for
these channels unless it is
disabled here.

Callback

NULL

Enter the name of the callback
function to be called when
conversion completes or a scan
ends.

Conversion End Interrupt
Priority

Priority O (highest), Priority 1,
Priority 2, Priority 3 (lowest -
not valid if using ThreadX)

Default: Priority 2

Select the interrupt priority for
the conversion end interrupt.
[Required]

Scan End Interrupt Priority

Priority O (highest), Priority 1,
Priority 2, Priority 3 (lowest -
not valid if using ThreadX),
Disabled

Default: Disabled

Select the interrupt priority for
the scan end interrupt.
[Required]

Calibration End Interrupt
Priority

Priority O (highest), Priority 1,
Priority 2, Priority 3 (lowest -
not valid if using ThreadX),
Disabled

Default: Disabled

Select the interrupt priority for
the calibration end interrupt.
[Required]

Configuration Settings for the AGT HAL Module on r_agt

ISDE Property

Value

Description
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Parameter Checking

BSP, Enabled, Disabled

Default: BSP

Enables or disables parameter
checking.

Name

g_timer0

Module name.

Channel

0

Physical hardware channel.

Mode

Periodic

Warning: One-shot functionality
is not available in the GPT
hardware, so it is implemented
in software by stopping the
timer in the ISR called when the
period expires. For this reason,
ISRs must be enabled for one-
shot mode even if the callback
is unused.

Period Value

10

See Timer Period Calculation.

Period Unit Raw Counts, Nanoseconds, See Timer Period Calculation.
Microseconds, Milliseconds,
Seconds, Hertz, Kilohertz
Default: Microseconds

Auto Start False Set to true to start the timer

after configuring or false to
leave the timer stopped until
timer_api_t::start is called.

Count Source

PCLKB, PCLKB/8, PCLKB/2,
LOCO, AGTO Underflow, AGTO
fSub

Default: PCLKB

The clock source for the AGT
counter.

AGTO Output Enabled

True, False

Default: False

Set to true to output the timer
signal on a port pin configured
for AGT (AGTO pin). Set to false
for no output of the timer
signal.

AGTIO Output Enabled

True, False

Default: False

Set to true to output the timer
signal on a port pin configured
for AGT (AGTIO pin). Set to false
for no output of the timer
signal.

Output Inverted

True, False

Default: True

Set to false to start the output
signal low. Set to true to start
the output signal high.

Enable comparator A output pin

True, False

Default: False

Enable comparator A output pin
selection.
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Enable comparator B output pin

True, False

Default: False

Enable comparator B output pin
selection.

Callback

NULL

A user callback function can be
registered in timer_api_t::open.
If this callback function is
provided, it will be called from
the interrupt service routine
(ISR) each time the timer period
elapses.

Warning: Since the callback is
called from an ISR, care should
be taken not to use blocking
calls or lengthy processing.
Spending excessive time in an
ISR can affect the
responsiveness of the system.

Underflow Interrupt Priority

Priority O (highest), Priority

1:14, Priority 15 (lowest - not

valid if using ThreadX)

Default: Disabled

Timer interrupt priority. 0 is the
highest priority.

Note

The example settings and defaults are for a project using the Synergy S7TG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the GPT HAL Module on r_gpt

ISDE Property

Value

Description

Parameter Checking

BSP, Enabled, Disabled

Enables or disables the
parameter checking.

Default: BSP

Name g_timer0 Module name.

Channel 0 The ADC Framework
preconfigures and locks this
field based on channel selected
in the ADC Framework.

Mode Periodic The ADC Framework
preconfigures and locks this
field.

Period Value 10 Configure timer period to

trigger ADC scans.

Period Unit

Raw Counts, Nanoseconds,
Microseconds, Milliseconds,
Seconds, Hertz, Kilohertz

Default: Milliseconds

Configure units of the timer
period set above.
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Duty Cycle Value

50

Duty cycle value selection.

Duty Cycle Unit

Unit Raw Counts, Unit Percent,
Unit Percent x 1000

Default: Unit Raw Counts

Duty cycle unit selection.

Auto Start False The ADC Framework
preconfigures and locks this
field.

GTIOCA Output Enabled True, False Set to true to output the timer

Default: False

signal on a port pin configured
for GPT. Set to false for no
output of the timer signal.

GTIOCA Stop Level

Pin Level Low, Pin Level High,
Pin Level Retained

Default: Pin Level Low

Controls output pin level when
the timer is stopped.

GTIOCB Output Enabled

True, False

Default: False

Set to true to output the timer
signal on a port pin configured
for GPT. Set to false for no
output of the timer signal.

GTIOCB Stop Level

Pin Level Low, Pin Level High,
Pin Level Retained

Default: Pin Level Low

Controls output pin level when
the timer is stopped.

Callback

NULL

The ADC Framework
preconfigures and locks this
field.

Overflow Interrupt Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

Interrupt priority selection.

Note

The exampl e settings and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the DTC HAL Module on r_dtc Software Activation

ISDE Property

Value

Description

Parameter Checking

BSP, Enabled, Disabled

Default: BSP

Selects if code for parameter
checking is to be included in
the build.

Software Start

Enabled, Disabled

Default: Disabled

Software start selection.
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Linker section to keep DTC
vector table

.ssp_dtc_vector_table

Linker section to keep DTC
vector table selection.

Mode

Name g_transferO Module name.

Mode Block Mode selection.

Transfer Size 2 Bytes Transfer size selection.

Destination Address Mode Incremented Destination address mode
selection.

Source Address Mode Incremented Source address mode selection.

Repeat Area (Unused in Normal | Source Repeat area selection.

Interrupt Frequency

After all transfers have
completed

Interrupt frequency selection.

Block Mode)

Destination Pointer NULL Destination pointer selection.
Source Pointer NULL Source pointer selection.
Number of Transfers 1 Number of transfers selection.
Number of Blocks (Valid only in |1 Number of blocks selection.

Activation Source (Must enable
IRQ)

Software Activation 1

Activation source selection.

Auto Enable

False

Auto enable selection.

Callback (Only valid with
Software start)

NULL

Callback selection.

ELC Software Event Interrupt
Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

ELC Software Event interrupt
priority selection.

Note

The exampl e settings and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

ADC Periodic Framework Module Pin Configuration

To access a channel, ADC channels must be set in the Pins tab of the ISDE. The following table
illustrates the method for selecting the pins within the SSP configuration window:

Pin Selection for the ADC HAL Module on r_adc

Resource ISDE Tab Pin selection Sequence
ADC Pins Select Peripherals > **Analog:
ADC > ADCO\1** > AN_XX
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SDADC

Pins

Select Peripherals > Analog:
SDADC > SDADCO > AN_XX

Note

In the cases of the internal temperature sensor and the internal voltage sensor, there are no pin configurations

required.

4.1.1.6 Using the ADC Periodic Framework Module in an Application

The steps in using the ADC Periodic Framework module on sf audio_record_adc in a typical

application are:

. Initialize the ADC using the sf adc_periodic_api_t::open API.

1
2. Start the Scan of channels using the sf adc_periodic_api_t::start API.
3

. Stop the scan with the sf adc_periodic_api_t::stop API.

4. Read the results of the conversion using the callback in application code.
5. Close the instance using the sf_adc_periodic_api_t::close API.

These common steps are illustrated in a typical operational flow diagram in the following figure:
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1. Initialize ADC
open

'

2. Start ADC Scan
start

'

3. Stop the scan
stop

'

4. Read conversion results
Application code and callback

A 4

5. Close the ADC instance
close

Figure 105: Flow Diagram of a Typical ADC/SDADC Periodic Framework Module Application

4.1.2 Audio Playback Framework

4.1.2.1 Audio Playback Framework Introduction

The Audio Playback Framework module provides a high-level API for audio playback applications and
is implemented on either sf_audio_playback _hw_dac or sf audio_playback _hw_i2s. The Audio
Playback Framework handles the synchronization needed to play 16-bit and 8-bit pulse-code
modulation (PCM) samples and uses the DAC (DAC12 or DACS8) or I2S, timer (AGT or GPT) and data-
transfer (DMA or DTC) peripherals on a Synergy MCU. A user-defined callback can be created to
respond to the need for additional data.

Audio Playback Framework Module Features
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¢ Plays long buffers by splitting the data into manageable chunks.

e Repeats playback until a ThreadX timeout (for repeated audio like sine wave tones or
looped background music).

¢ Requests next data using callback after last buffer playback begins.

¢ Software volume control.

¢ Pause and resume functions.

¢ Scaling, for example to move signed 16-bit PCM data into range of the unsigned 12-bit DAC
or unsigned 8-bit DACS.

e Basic mixing for multiple streams.

Application

Framework
Audio Playback Framework
sf_audio_playback
Framework
Audio Playback Framework Shared
sf_audio_playback_common
Framework
§< Messaging Audio Playback Hardware Framework Shared Audio Playback Hardware Framework Shared
T v Framework : . :
s O sf_audio_playback_hw_dac sf_audio_playback_hw_i2s
o = sf_message
e
|-5 AN ™~
P | 7N T~
HAL Driv‘ey j / \ X
Transfer Transfer Timer Timer DAC DAC .
o . . X . . 12S Driver
Driver Driver Driver Driver Driver Driver R SSI
R_DMAC R_DTC R_AGT R_GPT R_DAC R_DAC8 =
— AN
Z N\
HAL Drivers — a X N
Timer . .
T;?j:fr Transfer Driver Driver Timer Driver
R_GPT
R_DMAC L R_AGT -
BSP

Figure 106: Audio Playback Framework Module Block Diagram

4.1.2.2 Audio Playback Framework Module APIs Overview

The Audio Playback Framework module defines APIs for operations such as opening, starting, playing
and stopping. A complete list of the available APIs, an example API call and a short description of
each can be found in the following table. A table of status return values follows the APl summary
table.

Audio Playback Framework Module APl Summary

Function Name Example API Call and Description
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open g_sf audio_playback0.p_api->open(

g_sf audio_playbackO0.p_ctrl,

g_sf audio_playback0.p_cfg);

Open a device channel for read/write and
control.

start g_sf audio_playback0.p_api->start(
g_sf audio_playback0.p_ctrl, p_data, Timeout);
Start Audio Playback Hardware.

pause g_sf audio_playback0.p_api->pause(
g_sf audio_playbackO0.p_ctrl);
Pause Audio Playback Hardware.

stop g_sf audio_playback0.p_api->stop(
g_sf audio_playbackO0.p_ctrl);
Stop Audio Playback Hardware.

resume g_sf audio_playback0.p_api->resume(
g_sf audio_playbackO0.p_ctrl, &buffer, length);
Resume playback.

volumeSet g_sf audio_playback0.p_api->volumeSet(
g_sf audio_playback0.p_ctrl, volume);
Sets volume.

close g_sf audio_playback0.p_api->close(
g_sf audio_playbackO0.p_ctrl);
Close the audio module.

versionGet g_sf audio_playback0.p_api->versionGet(&versi
on);

Return the version of the module using the
version pointer.

Note
For more complete descriptions of operation and definitions for the function data structures, typedefs, defines, API
data, API structures and function variables, review the SSP User's Manual API References for the associated
module.

Status Return Values

Name Description
SSP_SUCCESS Function successful.
SSP_ERR_ASSERTION A pointer is NULL or a parameter is invalid.
SSP_ERR_OUT_OF_MEMORY The number of streams open at once is limited

to SF_AUDIO_PLAYBACK_CFG_MAX_STREAMS. If
this number is exceeded, an out of memory
error occurs.

SSP_ERR_TIMEOUT Timeout occurred before playback finished.
SSP_ERR_NOT_OPEN The stream control block p_ctrl is not initialized.
Note
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Lower-level drivers may return common error codes. Refer to the SSP User's Manual API References for the
associated module for a definition of all relevant status-return values.

4.1.2.3 Audio Playback Framework Module Operational Overview
The Audio Playback Framework module creates a thread internally to support audio playback. The

following figure shows a flowchart of the audio playback framework thread and its interactions with
public Audio Playback Framework API functions:

SF_AUDIO_PLAYBACK_Open

SF_AUDIO_PLAYBACK_Start

—PC Thread Entry )
H(a)rdwa;e Open Hardware 7 Post data to
[l message queue
Parse all
»| messagesin [« *
4 audio queue
Create Audio ‘
Initialize Stream |« Playback —
Thread Process Data SF_AUDIO_PLAYBACK_Pause/
R SF_AUDIO_PLAYBACK_Stop/
(scale, mix, SF_AUDIO_PLAYBACK_Resume
volume, etc.)
No ‘
Start playback Post control
(first time) or message
store pointer fo
next data buffer
Internal Audio Playback in control block
Callback
Play next buffer
(if available)
v
Wait for
Post “playback o playback Legend
complete”flag | complete flag or Beige Blue represents
timeout represents the shared audio
API calls made thread (internal to
per stream framework)

Figure 107: Audio Playback Framework Module Flow Chart

Suggested use of the audio playback framework:

¢ Create a semaphore (for example, g_sf audio_playback semaphore). This can be done on
the Threads tab. Set the initial value to 2 (the audio playback framework can store up to
two data messages per stream).

¢ Create a callback function (for example, sf_audio_playback_callback). Enter the name of
your callback function in the Audio Playback Framework instance. The callback function will
be called when the audio playback framework is done with the data. In the callback, put the
semaphore created above.

¢ In your main loop, get the semaphore before playing data. To play data, first acquire a
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buffer from the messaging framework, then create your audio playback data structure
inside the buffer.

The Audio Playback Framework supports multiple audio streams on a single hardware port. A block
diagram of the modules required if two streams are used is shown in the following figure:

Ogg Vorbis/
SF_AUDIO_DECODE N MP3/WAV Takes compressed audio data {from file system or pointer to data
*Future " Decoder from input stream), selects appropriate decoder, decodes data and
Plugins passes it to audio playback stream. This module is not yet implemented.
SF_AUDIO_ PLAYBACK on SF_AUDIO_ PLAYBACK on
SF_AUDIO_PLAYBACK SF_AUDIO_PLAYBACK Passes data associated with a particular stream to a shared audio
Stream 1 Stream 2 playback thread.
SF_AUDIO_ PLAYBACK_COMMON Thread shared by all audio streams on the same hardware.
on SF_AUDIO_PLAYBACK Combines decompressed data from all active streams and scales it to

fix the ouput hardware data type and requested volume.

!

SF_AUDIO_ PLAYBACK_HW on
SF_AUDIO_PLAYBACK_HW_DAC

Plays a single buffer of decompressed audio data. Transfers PCM
data to DAC at sampling frequency governed by timer.

R_TIMER + R_DAC TRANSFER .
T el e Modules required by the layer above.

Figure 108: Audio Playback Framework Module Audio Streams

Audio Playback Framework Module Important Operational Notes and Limitations

Audio Playback Framework Module Operational Notes
Configuring Messages

Use the Messaging Framework configurator on the Messaging tab to configure the messaging
framework:

=

. Highlight the Audio Playback event class.
2. Add a new subscriber. Select the following configurations and make sure the Message Class
Instance property set in the Properties tab of the Audio Playback Framework on
sf audio_playback module is between the Start and End instance.
o Thread: Any thread in the application.
o Start: First audio instance used in application.
o End: Last audio instance used in application.
. Highlight the new Subscriber in the Audio Playback Subscribers. Record the Symbol name.
. Go back to the Threads tab.
. Highlight the Audio Playback Framework Shared module in HAL/Common, and set the Audio

(S0~ O)
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Message Queue Name to the Symbol name from the Audio Playback Subscriber.
Using the 12S Implementation

The audio framework 12S hardware port has dependencies on the 12S Driver module. The 12S driver
module can be accelerated with DTC.

e Set the ISDE properties for the 12S driver module.
o Set the Audio Clock Frequency (Hertz) to the frequency of the input audio clock
used.
o Set the Sampling Frequency (Hertz) to the sampling frequency of your audio data.
o Set the Data Bits and Word Length to 16 bits (audio framework accepts 16 bit
samples only).
o Enable the SSIn TXI and SSIn INT interrupts.
e The Transfer module on r_dtc is added automatically.

Using the DAC Implementation

The audio framework DAC hardware port has dependencies on the Timer, DAC, and Transfer API
modules.

e Add a Timer module.
o Set the Frequency in Hz to the sampling frequency of your audio data.
o Enable the interrupt if using DTC as the transfer module (recommended).
e Add a DAC (DAC12 or DACS8) module.
e Add a Transfer module on r_dtc.
o Set Destination pointer to &R _DAC->DADRN[0] if using DAC channel 0 or
&R _DAC->DADRN[1] if using DAC channel 1.
o Set Destination pointer to &R_DAC8->DADRN[2] if using DAC8 channel 2 (5128) or
&R_DAC8->DADRN[O0] if using DAC8 channel 0 (S1JA).
o Set the Activation source to the timer interrupt chosen above.

Other Operational Notes

The Queue used must match the name specified in Properties for Audio Playback Framework Shared
on sf _audio_playback (default is g_sf audio_playback queue).

Audio Playback Framework Module Limitations

e Refer to the latest SSP Release Notes for any additional operational limitations for this
module.

4.1.2.4 Including the Audio Playback Framework Module in an Application

This section describes how to include the Audio Playback Framework module in an application using
the SSP configurator.

Note
This section assumes you are familiar with creating a project, adding threads, adding a stack to a thread and
configuring a block within the stack. If you are unfamiliar with any of these items, refer to the first few chapters of
the SSP User's Manual to learn how to manage each of these important stepsin creating SSP-based applications.

To add the Audio Playback Framework module to an application, simply add it to a HAL /Common
thread using the stacks selection sequence given in the following table. (The default name for the
Audio Playback Framework module is g_sf audio_playback0. This name can be changed in the
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associated Properties

window.)

Audio Playback Framework Module Selection Sequence

Resource

ISDE Tab

Stacks Selection Sequence

Playback Framework
g_sf audio_playback

g_sf audio_playback Audio Threads

on

New Stack> Framework>
Audio> Audio Playback
Framework on
g_sf_audio_playback

When the Audio Playback Framework module on sf _audio_playback is added to the thread stack as
shown in the following figure, the configurator automatically adds any needed lower-level modules.
Any modules needing additional configuration information have the box text highlighted in Red.
Modules with a Gray band are individual modules that stand alone. Modules with a Blue band are
shared or common; they need only be added once and can be used by multiple stacks. Modules with
a Pink band can require the selection of lower-level modules; these are either optional or
recommended. (This is indicated in the block with the inclusion of this text.) If the addition of lower-
level modules is required, the module description include Add in the text. Clicking on any Pink
banded modules brings up the New icon and displays possible choices.

New Thread Stacks

¢ | New Stack > % | Remove

4 g_sf_audio_playback0 Audio Playback Framework

on sf_audio_playback

®

A

|

*) - n A .
& g_sf_audio_playback_common0 Audio Playback
Framework Shared on sf_audio_playback

|

& g_sf_message
Messaging
Framework on
sf_message

% Add Audio Playback
Hardware

4.1.2.5 Configuring the Audio Playback Framework Module

Figure 109: Audio Playback Framework Module Stack

The Audio Playback Framework module must be configured by the user for the desired operation.
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The SSP configuration window will automatically identify (by highlighting the block in red) any
required configuration selections, such as interrupts or operating modes, which must be configured
for lower-level modules in order to ensure successful operation. Furthermore, only those properties
that can be changed without causing conflicts are available for modification. Other properties are
'locked' and are not available for changes, and are identified with a lock icon for the 'locked' property
in the Properties window in the ISDE. This approach simplifies the configuration process and makes it
much less error-prone than previous 'manual' approaches to configuration. The available
configuration settings and defaults for all the user-accessible properties are given in the Properties
tab within the SSP configurator, and are shown in the following tables for easy reference.

Note
You may want to open your | SDE, create the module and explore the property settings in parallel with looking over
the following configuration table settings; thiswill help orient you and can be a useful 'hands-on' approach to
learning the ins and outs of developing with the SSP.

Configuration Settings for the Audio Playback Framework Module on sf audio_playback

ISDE Property Value Description
Parameter Checking BSP, Enabled, Disabled Enables or disables the
parameter checking.
Default: BSP
Buffer Size Bytes 512 Buffer size bytes selection.
Maximum Number of Streams 1 Maximum number of streams
selection.
Thread Stack Size 512 Thread stack size selection.
Name g_sf audio_playbackO Module name.
Message Class Instance 0 Message class instance
selection.
Callback NULL Callback selection.
Name of generated initialization | sf_audio_playback_init0 Name of generated initialization
function function selection.
Auto Initialization Enable, Disable Auto initialization selection.
Default: Enable

Note
Increasing the buffer size will increase the RAM consumption of this module.
The example values and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

In some cases, settings other than the defaults for lower-level modules can be desirable. For
example, it might be useful to select the DAC Channel based on the target hardware
implementation. The configurable properties for the lower-level stack modules are given in the
following sections for completeness and as a reference.

Note
Most of the property settings for lower level modules are fairly intuitive and can usually be determined by
inspection of the associated Properties window from the SSP configurator.
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Configuring the Audio Playback Framework Lower-Level Modules

Typically, only a small number of settings must be modified from the default for lower-level drivers
as indicated with red text in the thread stack block. Notice that some of the configuration properties
must be set to a certain value for proper framework operation and will be locked to prevent user
modification. The following table identifies all the settings within the properties section for the
module.

Configuration Settings for the Audio Playback Framework Shared on sf_audio_playback

ISDE Property Value Description
Name g_sf audio_playback_commonO | Module name.
Thread Priority 3 Thread priority selection.
Audio Message Queue Name g_sf audio_playback queue Auldio message queue name
selection.

Note
The example values and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the Messaging Framework on sf_message

ISDE Property Value Description

Parameter Checking BSP, Enabled, Disabled Enables or disables the
parameter checking.
Default: BSP

Message Queue Depth (Total 16 Specify the size of Thread X
number of messages to be Message Queue in bytes for
enqueued in a Message Queue) Message Subscribers. This
value is applied to all the
Message Queues.

Name g_sf message0 The name of Messaging
Framework module control
block instance.

Work memory size in bytes 2048 Specify the work memory size
in bytes. Choosing a small
number results in a small
number of buffers, which can
be allocated at the same time
(you can confirm the total
buffer number on
sf_message_instance_ctrl_t::nu
mber_of buffers). If the value is
smaller than the peak number
of messages to be posted at the
same time, the Framework has
a buffer allocation failure,
affecting system performance.
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Pointer to subscriber list array

p_subscriber_lists

Specify the name of pointer to
the Subscriber List array.

name of the block pool
internally used in the
messaging framework

sf msg_blk _pool

The name of memory block
memory the Framework creates
in the control block. This
parameter might be useful for
debugging purpose but NULL
can be specified for saving
memory.

Name of generated initialization
function

sf message_init0

Name of generated initialization
function selection.

Auto Initialization

Enable, Disable

Default: Enable

Auto initialization selection.

Note

The example values and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the Audio Playback Hardware Framework Shared on

sf_audio_playback hw_dac

ISDE Property

Value

Description

Parameter Checking

BSP, Enabled, Disabled

Default: BSP

Enables or disables the
parameter checking.

DMAC Support

Disabled, Enabled

Default: Disabled

DMAC support selection.

Name

g_sf audio_playback _hwO

Module name.

Note

The example values and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the Transfer Driver on r_dmac Software Activation

ISDE Property

Value

Description

Parameter Checking

BSP, Enabled, Disabled

Selects if code for parameter
checking is to be included in

Default: BSP the build.
Name g_transferO Module name.
Channel 0 Channel selection.
Mode Normal Mode selection.
Transfer Size 2 Bytes Transfer size selection.
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Block Mode)

Destination Address Mode Fixed Destination address mode
selection.

Source Address Mode Incremented Source address mode selection.

Repeat Area (Unused in Normal | Source Repeat area selection.

Mode

Destination Pointer NULL Destination pointer selection.

Source Pointer NULL Source pointer selection.

Number of Transfers 0 Number of transfers selection.

Number of Blocks (Valid only in |0 Number of blocks selection.

Activation Source

Software Activation, Peripheral
Events

Default: Software Activation

Activation source selection.

Auto Enable

False

Auto enable selection.

Callback

NULL

Callback selection.

Interrupt Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

Interrupt priority selection.

Note

The example values and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the Transfer Driver on r_dmac Software Activation 1

ISDE Property

Value

Description

Parameter Checking

BSP, Enabled, Disabled

Default: BSP

Selects if code for parameter
checking is to be included in
the build.

Software Start

Enabled, Disabled

Default: Disabled

Software start selection.

Linker section to keep DTC
vector table

.ssp_dtc_vector _table

Linker section selection.

Name g_transferO Module name.

Mode Normal Mode selection.

Transfer Size 2 Bytes Transfer size selection.

Destination Address Mode Fixed Destination address mode
selection.

Source Address Mode Incremented Source address mode selection.
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Repeat Area (Unused in Normal
Mode

Source

Repeat area selection.

Interrupt Frequency

After all transfers have

Interrupt frequency selection.

Block Mode)

completed
Destination Pointer NULL Destination pointer selection.
Source Pointer NULL Source pointer selection.
Number of Transfers 0 Number of transfers selection.
Number of Blocks (Valid only in |0 Number of blocks selection.

Activation Source (Must enable
IRQ)

Software Activation 1, Software
Activation 2, Peripheral Events

Default: Software Activation 1

Activation source selection.

Auto Enable

False

Auto enable selection.

Callback (Only valid with
Software start)

NULL

Callback selection.

ELC Software Event Interrupt
Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

ELC Software Event interrupt
priority selection.

Note

The example values and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the Timer Driver on r_agt

ISDE Property

Value

Description

Parameter Checking

BSP, Enabled, Disabled

Default: BSP

Enables or disables parameter
checking.

Name

g_timer0

Module name.

Channel

0

Physical hardware channel.

Mode

Periodic

Warning: One-shot functionality
is not available in the GPT
hardware, so it is implemented
in software by stopping the
timer in the ISR called when the
period expires. For this reason,
ISRs must be enabled for one-
shot mode even if the callback
is unused.

Period Value

10

See Timer Period Calculation.
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Period Unit Hertz See Timer Period Calculation.

Auto Start False Set to true to start the timer
after configuring or false to
leave the timer stopped until
timer_api_t::start is called.

Count Source PCLKB, PCLKB/8, PCLKB/2, The clock source for the AGT
LOCO, AGTO Underflow, AGTO counter.
fSub

Default: PCLKB

AGTO Output Enabled True, False Set to true to output the timer
signal on a port pin configured
Default: False for AGT (AGTO pin). Set to false
for no output of the timer
signal.
AGTIO Output Enabled True, False Set to true to output the timer
signal on a port pin configured
Default: False for AGT (AGTIO pin). Set to false
for no output of the timer
signal.
Output Inverted True, False Set to false to start the output
signal low. Set to true to start
Default: False the output signal high.
Enable comparator A output pin | True, False Enable comparator A output pin
selection.

Default: False

Enable comparator B output pin | True, False Enable comparator B output pin
selection.
Default: False

Callback NULL A user callback function can be
registered in timer_api_t::open.
If this callback function is
provided, it will be called from
the interrupt service routine
(ISR) each time the timer period
elapses.

Warning: Since the callback is
called from an ISR, care should
be taken not to use blocking
calls or lengthy processing.
Spending excessive time in an
ISR can affect the
responsiveness of the system.

Interrupt Priority Priority O (highest), Priority Timer interrupt priority. 0 is the
1:14, Priority 15 (lowest - not highest priority.
valid if using ThreadX)

Default: Disabled
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Note

The example values and defaults are for a project using the Synergy S7G2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the Timer Driver on r_gpt

ISDE Property

Value

Description

Parameter Checking

BSP, Enabled, Disabled

Enables or disables the
parameter checking.

Default: BSP

Name g_timer0 Module name.

Channel 0 Channel selection.

Mode Periodic Warning: One-shot functionality
is not available in the GPT
hardware, so it is implemented
in software by stopping the
timer in the ISR called when the
period expires. For this reason,
ISRs must be enabled for one-
shot mode even if the callback
is unused.

Period Value 10 See Timer Period Calculation.

Period Unit Hertz See Timer Period Calculation.

Duty Cycle Value 50 Duty cycle value selection.

Duty Cycle Unit

Unit Raw Counts, Unit Percent,
Unit Percent x 1000

Default: Unit Raw Counts

Duty cycle unit selection.

Auto Start False Set to true to start the timer
after configuring or false to
leave the timer stopped until
timer_api_t::start is called.

GTIOCA Output Enabled True, False Set to true to output the timer

Default: False

signal on a port pin configured
for GPT. Set to false for no
output of the timer signal.

GTIOCA Stop Level

Pin Level Low, Pin Level High,
Pin Level Retained

Default: Pin Level Low

Controls output pin level when
the timer is stopped.

GTIOCB Output Enabled

True, False

Default: False

Set to true to output the timer
signal on a port pin configured
for GPT. Set to false for no
output of the timer signal.
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GTIOCB Stop Level Pin Level Low, Pin Level High, Controls output pin level when
Pin Level Retained the timer is stopped.

Default: Pin Level Low

Callback NULL A user callback function can be
registered in timer_api_t::open.
If this callback function is
provided, it will be called from
the interrupt service routine
(ISR) each time the timer period
elapses.

Warning: Since the callback is
called from an ISR, care should
be taken not to use blocking
calls or lengthy processing.
Spending excessive time in an
ISR can affect the
responsiveness of the system.

Interrupt Priority Priority O (highest), Priority Interrupt priority selection.
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

Note
The example values and defaults are for a project using the Synergy S7G2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the DAC HAL Module on r_dac

ISDE Property Value Description

Parameter Checking BSP, Enabled, Disabled Enable or disable the parameter
error checking.
Default: BSP

Name g_dacO Module name.

Channel 0 Set to 0 for output DAO or 1 for
output DAL.

Synchronize with ADC Enabled, Disabled Set to true for anti-interference
synchronization with the Analog-
Default: Disabled to-Digital Converter (ADC)
Module. Set to false if power
supply interference between

the analog modules is not a
problem, or if asynchronous
conversion by the DAC module
is desired.
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Data Format Right Justified Set to zero, if 12-bit data values
are loaded in bits 11 through O,
or right justified. Set to one, if
12-bit data values are loaded in
bits 15 through 4, or left

justified.
Output Amplifier Enable, Disable Set to true, if output amplifier
hardware function is desired.
Default: Disable Set to false to bypass output

amplifier hardware function.

Note
The example values and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the Audio Playback Framework Shared on
sf_audio_playback hw_i2s

ISDE Property Value Description
Parameter Checking BSP, Enabled, Disabled Enable or disable the parameter
error checking.
Default: BSP
Name g_sf audio_playback hwO0 Module name.

Note
The example values and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the 12S HAL Module on r_ssi

ISDE Property Value Description
Parameter Checking BSP, Enabled, Disabled Enables or disables the
parameter checking.
Default: BSP
Name g_i2s0 Module name.
Channel 0 Physical hardware channel.
Audio Clock Frequency (Hertz) |2822400 Input audio clock frequency,
used to generate the I12S clock.
Must be a multiple between 1
and 128 of (sampling_freq_hz *
word_length_in_bits).
Sampling Frequecy (Hertz) 44100 Sampling frequency of audio
data.
Data Bits 8 bits, 16, 18, 20, 22, 24 Bit depth of audio data, which is
the size in bits of one sample of
Default: 16 bits audio data.
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Word Length

8 bits, 16, 24, 32

Default: 16 bits

Word length of audio data,
must be at least the same size
as the bit depth (Data Bits
field).

WS Continue Mode

Enabled, Disabled

Default: Disabled

Enable WS continue mode to
continue to output the word
select line when the peripheral
is idle. Disable to stop
outputting the word select line
when the peripheral is idle.

Name of 12S callback function
to be defined by user

NULL

A user callback function must
be registered in open. The
callback will be called from the
interrupt service routine (ISR)
when the transmission FIFO
reaches the high watermark
point after all data for
transmission is transmitted or
when reception is complete
(the requested number of bytes
have been received).

Warning: Since the callback is
called from an ISR, care should
be taken not to use blocking
calls or lengthy processing.
Spending excessive time in an
ISR can affect the
responsiveness of the system.

Transmit Interrupt Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

Transmit interrupt priority
selection.

Receive Interrupt Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

Receive interrupt priority
selection.

Idle/Error Interrupt Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Priority 12

Idle/error interrupt priority
selection.

Note

The example values and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the Transfer Driver on r_dtc Software Activation 1
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ISDE Property

Value

Description

Parameter Checking

BSP, Enabled, Disabled

Default: BSP

Parameter selection.

Software Start

Enabled, Disabled

Default: Disabled

Software start selection.

Linker section to keep DTC
vector table

.ssp_dtc_vector_table

Linker section to keep DTC
vector table.

Mode

Name g_transferO Driver name.

Mode Normal Mode selection.

Transfer Size 4 Bytes Transfer size selection.

Destination Address Mode Fixed Destination address mode
selection.

Source Address Mode Incremented Source address mode selection.

Repeat Area (Unused in Normal | Source Repeat area selection.

Interrupt Frequency

After all transfers have

Interrupt frequency selection.

Block Mode)

completed
Destination Pointer NULL Destination pointer selection.
Source Pointer NULL Source pointer selection.
Number of Transfers 0 Number of transfers selection.
Number of Blocks (Valid only in |0 Number of blocks selection.

Activation Source (Must enable
IRQ)

Software Activation 1, Software
Activiation 2, Peripheral Events

Default: Software Activation 1

Activation source selection.

Auto Enable

False

Auto enable selection.

Callback (Only valid with
Software start)

NULL

Callback selection.

ELC Software Event Interrupt
Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

ELC software event interrupt
priority selection.

Note

The example values and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the Transfer Driver on r_dtc Software Activation 1
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ISDE Property

Value

Description

Parameter Checking

BSP, Enabled, Disabled

Default: BSP

Parameter selection.

Software Start

Enabled, Disabled

Default: Disabled

Software start selection.

Linker section to keep DTC
vector table

.ssp_dtc_vector_table

Linker section to keep DTC
vector table.

Mode

Name g_transferl Driver name.

Mode Normal Mode selection.

Transfer Size 4 Bytes Transfer size selection.

Destination Address Mode Incremented Destination address mode
selection.

Source Address Mode Fixed Source address mode selection.

Repeat Area (Unused in Normal | Destination Repeat area selection.

Interrupt Frequency

After all transfers have

Interrupt frequency selection.

Block Mode)

completed
Destination Pointer NULL Destination pointer selection.
Source Pointer NULL Source pointer selection.
Number of Transfers 0 Number of transfers selection.
Number of Blocks (Valid only in |0 Number of blocks selection.

Activation Source (Must enable
IRQ)

Software Activation 1, Software
Activiation 2, Peripheral Events

Default: Software Activation 1

Activation source selection.

Auto Enable

False

Auto enable selection.

Callback (Only valid with
Software start)

NULL

Callback selection.

ELC Software Event Interrupt
Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

ELC software event interrupt
priority selection.

Note

The example values and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the Timer Driver on r_agt
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ISDE Property

Value

Description

Parameter Checking

BSP, Enabled, Disabled

Default: BSP

Parameter selection.

Software Start

Enabled, Disabled

Default: Disabled

Software start selection.

Linker section to keep DTC
vector table

.ssp_dtc_vector_table

Linker section to keep DTC
vector table.

Mode

Name g_transferl Driver name.

Mode Normal Mode selection.

Transfer Size 4 Bytes Transfer size selection.

Destination Address Mode Incremented Destination address mode
selection.

Source Address Mode Fixed Source address mode selection.

Repeat Area (Unused in Normal | Destination Repeat area selection.

Interrupt Frequency

After all transfers have

Interrupt frequency selection.

Block Mode)

completed
Destination Pointer NULL Destination pointer selection.
Source Pointer NULL Source pointer selection.
Number of Transfers 0 Number of transfers selection.
Number of Blocks (Valid only in |0 Number of blocks selection.

Activation Source (Must enable
IRQ)

Software Activation 1, Software
Activation 2, Peripheral Events

Default: Software Activation 1

Activation source selection.

Auto Enable

False

Auto enable selection.

Callback (Only valid with
Software start)

NULL

Callback selection.

ELC Software Event Interrupt
Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

ELC software event interrupt
priority selection.

Note

The example values and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the Timer Driver on r_gpt
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ISDE Property

Value

Description

Parameter Checking

BSP, Enabled, Disabled

Parameter selection.

Default: BSP
Name g_timer0 Module name.
Channel 0 Channel selection.
Mode Periodic Mode selection.
Period Value 2822400 *2 Period value selection.
Period Unit Hertz Period unit selection.
Duty Cycle Value 50 Duty cycle value selection.

Duty Cycle Unit

Unit Raw Counts, Unit Percent,
Unit Percent x 1000

Default: Unit Raw Counts

Duty cycle unit selection.

Auto Start

FALSE

Auto start selection.

GTIOCA Output Enabled

True, False

Default: False

GTIOCA output enabled
selection.

GTIOCA Stop Level

Pin Level Low, Pin Level High,
Pin Level Retained

Default: Pin Level Low

GTIOCA stop level selection.

GTIOCB Output Enabled

True, False

Default: False

GTIOCB output enabled
selection.

GTIOCB Stop Level

Pin Level Low, Pin Level High,
Pin Level Retained

Default: Pin Level Low

GTIOCB stop level selection.

Callback

NULL

Callback selection.

Overflow Interrupt Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

Interrupt priority selection.

Note

The example values and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have

different default values and available configuration settings.

Audio Playback Framework Module Clock Configuration

The Audio Playback Framework hardware modules use the peripheral clocks available in the clock

configuration window.
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Audio Playback Framework Module Pin Configuration

The DAC or SSI peripheral module uses pins on the MCU to communicate with external devices. 1/0
pins must be selected and configured as required by the external device. The following tables
illustrate the method for selecting the pins within the SSP configuration window, and show an
example selection for the associated pins.

Pin Selection Sequence for the Audio Playback Framework Module

Resource ISDE Tab Pin selection Sequence

DAC Pins Select Peripherals >
Analog:DAC12 >
DAC120/121

SSI Pins Select Peripherals >
Connectivity:SSI > SS1/0/1

Note
The selection sequence assumes the DACO/DAC1 or the SSI0/SS 1 isthe desired hardware target of the driver.

Pin Configuration Settings for the DAC Driver on r_dac

Pin Configuration Property Value Description

Operation Mode Enabled, Disabled Operation selection.

DAC None, P014 DAC pin selection.
(Default: P014)

Note
The example values are for a project using the Synergy S7TG2 MCU Group and the K-S7G2 Kit. Other Synergy
Kits and other Synergy MCUs may have different available pin configuration settings.

4.1.2.6 Using the Audio Playback Framework Module in an Application
The typical steps in using the Audio Playback Framework module in an application are:

1. Initialize an audio stream using the sf audio_playback api_t::open API.
2. Use the callback function to post to a semaphore with an initial count equal to the number
of buffers required. This is implemented in the application code.

= Note
Get this semaphore in the application thread before calling sf_audio_playback api_t::start
API.
3. Acquire a buffer from the Messaging Framework using sf message_api_t::bufferAcquire API.

= Note
Create the Audio Framework Data Sructure using sf_audio_playback data t inside the
buffer.
4. Start the Audio Playback Framework using the sf_audio_playback api_t::start API.

Note
If multiple streams are desired, repeat steps 1-4 for any additional audio streams. A separate audio stream should
only be used if the streams need to play simultaneously using mixing. If audio sounds are always played in
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seguence and never overlap, the stream can be reused.

These common steps are illustrated in a typical operational flow in the following figure:

1. Initialize audio stream
open

'

2. Use callback function to post a semaphore

'

3. Acquire a buffer
bufferAcquire

'

4. Start the Audio Playback Framework
start

Figure 110: Flow Diagram of a Typical Audio Playback Framework Module Application

4.1.3 Audio Playback Hardware Framework Shared on
sf audio_playback hw_dac

4.1.3.1 Audio Playback DAC Framework Introduction

The Audio Playback Framework DAC module provides a high-level API for audio playback applications
and handles the synchronization needed to play 8-bit or 16-bit pulse-code modulation (PCM)
samples. The Audio Playback DAC Framework uses the DAC/DACS, timer (AGT or GPT) and data-
transfer (DMA or DTC) peripherals on a Synergy MCU. A user-defined callback can be created to
respond to the need for additional data.

Audio Playback DAC Framework Module Features

» Plays long buffers by splitting the data into manageable chunks.
* Repeats playback until a ThreadX timeout (for repeated audio like sine wave tones or
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looped background music).

Requests next data using callback after last buffer playback begins.
Software volume control.
Pauses and resumes functions.
Scaling, for example, to move signed 16-bit PCM data into range of the unsigned 12-bit or

8-bit DAC.

e Basic mixing for multiple streams.

Application

Framework

Audio Playback Framework
sf_audio_playback _hw_dac

ThreadX®

RTOS HAL Drivers

Transfer Driver
R_DTC

Transfer Driver
R_DMAC

Timer Driver
R_AGT

Timer Driver
R GPT

DAC/DACS Driver
R_DAC/R_DACS

Figure 111: Audio Playback DAC Framework Module Block Diagram

Note

BSP

Selection options of DAC or DAC8 Driver is MCU specific.

4.1.3.2 Audio Playback DAC Framework Module APIs Overview

The Audio Playback DAC Framework module defines APIs for operations such as opening, starting,
playing and stopping. A complete list of the available APIs, an example API call and a short
description of each can be found in the following table. A table of status return values follows the API

summary table.

Audio Playback DAC Framework Module APl Summary

Function Name

Example API Call and Description

open

control.

g_sf audio_playback_hwO.p_api->open(
g_sf audio_playback_hwO.p_ctrl,

g_sf audio_playback_hwO0.p_cfg);

Open a device channel for read/write and

start

Timeout);

g_sf audio_playback hwO.p_api->start(
g_sf audio_playback hwO0.p ctrl, &p_data,

Start Audio Playback Hardware.
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stop g_sf audio_playback _hw0.p_api->stop(
g_sf audio_playback_hwO0.p_ctrl);
Stop Audio Playback Hardware.

play g_sf audio_playback_hwO0.p_api->play
(g_sf audio_playback_hwO0.p_ctrl, p_buffer,
length);

Play audio buffer.

dataTypeGet g_sf audio_playback hwO0.p_api->dataTypeGet(
g_sf audio_playback hwO.p ctrl, p_data_type);
Store expected data type in provided pointer
p_data type.

close g_sf audio_playback hwO.p_api->close(
g_sf audio_playback _hwO0.p_ctrl);
Close the audio module.

versionGet g_sf audio_playback hwO0.p_api->versionGet(&v
ersion);

Return the version of the module with the
version pointer.

Note
For more complete descriptions of operation and definitions for the function data structures, typedefs, defines, API
data, API structures and function variables, review the SSP User's Manual API References for the associated
module.

Status Return Values

Name Description
SSP_SUCCESS Function successful.
SSP_ERR_ASSERTION A pointer is NULL or a parameter is invalid.
SSP_ERR_OUT _OF _MEMORY The number of streams open at once is limited

to SF_AUDIO_PLAYBACK CFG_MAX STREAMS. If
this number is exceeded, an out of memory
error occurs.

SSP_ERR_TIMEOUT Timeout occurred before playback finished.
SSP_ERR_NOT_OPEN The stream control block p_ctrl is not initialized.
Note

Lower-level drivers may return common error codes. Refer to the SSP User's Manual API References for the
associated module for a definition of all relevant status-return values.

4.1.3.3 Audio Playback DAC Framework Module Operational Overview
The Audio Playback Framework DAC module creates a thread internally to support audio playback.

The following figure shows a flowchart of the Audio Playback Framework thread and its interactions
with public Audio Playback Framework APIs.
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SF_AUDIO_PLAYBACK_Open

SF_AUDIO_PLAYBACK_Start

Thread Entry
H:)rdwa:’re Open Hardware Post data to
pen: ‘ message queue
Parse all
»| messagesin [« +
\ 4 audio queue
s P Create Audio *
Initialize Stream [« Plavback Thread |
ayback fhrea o Dat SF_AUDIO_PLAYBACK_Pause/
(“”TSS ata SF_AUDIO_PLAYBACK_Stop/
scale, mix, SF_AUDIO_PLAYBACK_Resume
volume, etc.)
No +
Start playback Post control
(first time) or message
store pointer
to next data
. buffer in
Internal Audio Playback contral block
Callback 3
Play next buffer
(if available)
Wait for Legend
Post “playback playback
complete” flag complete flag Beige Blue represents
or timeout represents the shared audio

APl calls made
per stream

thread (internal
to framework)

Figure 112: Audio Playback DAC Framework Module Flow Chart

Suggested use of the Audio Playback Framework:

¢ Create a semaphore (for example, 'g_sf audio_playback semaphore'). This can be done on
the Threads tab. Set the initial value to 2 (the audio playback framework can store up to
two data messages per stream).

¢ Create a callback function (for example, 'sf_audio_playback_callback)'. Enter the name of
your callback function in the Audio Playback Framework instance. The callback function will
be called when the Audio Playback Framework is done with the data. In the callback, put
the semaphore created above.

¢ In your main loop, get the semaphore before playing data. To play data, first acquire a

buffer from the messaging framework, then create your audio playback data structure
inside the buffer.

The Audio Playback DAC Framework supports multiple audio streams on a single hardware port. A
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block diagram of the modules required if two streams are used is shown in the following figure:

Ogg Vorbis/
sf_audio_ decode > MP3/WAV Takes compressed audio data (from file system or pointer to data
*Future Decoder from input stream), selects appropriate decoder, decodes data and
Plugins passes it to audio playback stream. This module is not yet implemented.
v
sf_audio_ playback on sf_audio_ playback on
sf_audio_playback sf_audio_playback Passes data associated with a particular stream to a shared audio
Stream 1 Stream 2 playback thread.
sf_audio_ playback_commonon Thread shared by all audio streams on the same hardware.
sf_audio_playback Combines decompressed data from all active streams and scales it to

fix the ouput hardware data type and requested volume.

y

sf_audio_ playback_hwon
sf_audio_playback_hw_dac

'

r_timer + r_dac_transfer

Plays a single buffer of decompressed audio data. Transfers PCM
data to DAC at sampling frequency governed by timer.

Modules required by the layer above.

Figure 113: Audio Playback DAC Framework Implementing Multiple Audio Streams

Audio Playback DAC Framework Module Important Operational Notes and Limitations

Audio Playback DAC Framework Module Operational Notes

e The Audio Framework DAC hardware port uses the transfer API to transfer audio data from a
playback buffer to DAC at a sampling frequency defined by an internal timer.
e The Audio Framework DAC hardware port has dependencies on the Timer, DAC/DACS8, and
Transfer APl modules.
e Add a Timer module.
o Set the Frequency in Hz to the sampling frequency of your audio data.
o Enable the interrupt if using DTC as the transfer module (recommended).
e Add a Transfer module: select either the DTC or DMAC.
e For DTC:
o Set Destination pointer to &R_DAC->DADRN[0] if using DAC channel 0 or
&R_DAC->DADRN[1] if using DAC channel 1.
o Set Destination pointer to &R_DAC8->DADRN[2] if using DAC8 channel 2 (S128) or
&R _DAC8->DADRNI[O0] if using DAC8 channel 0 (S1JA).
o Set the activation source to the timer interrupt chosen above.
e For DMAC:
o Enable the DMAC support
o Set Destination pointer to &R_DAC->DADRN[0] if using DAC channel 0 or
&R_DAC->DADRN[1] if using DAC channel 1.
o Set Destination pointer to &R_DAC8->DADRN[2] if using DAC8 channel 2 (5128) or
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&R _DACS8->DADRNI[O0] if using DAC8 channel 0 (S1JA).

o Set the activation source to the timer interrupt chosen above.

e The Audio Playback DAC Framework is designed to support the following MCU families with
no changes to the API:

o S7G2
o S3A3
o S5D9
o S3A7
o 5124
o S3A6
o S5D5
o S3Al
o 5128
o S1JA
o S5D3

Audio Playback DAC Framework Module Limitations

e Refer to the most recent SSP Release Notes for any additional operational limitations for
this module.

4.1.3.4 Including the Audio Playback DAC Framework Module in an Application

This section describes how to include the Audio Playback DAC Framework module in an application
using the SSP configurator.

Note
This section assumes you are familiar with creating a project, adding threads, adding a stack to a thread and
configuring a block within the stack. If you are unfamiliar with any of these items, refer to the first few chapters of
the SSP User's Manual to learn how to manage each of these important stepsin creating SSP-based applications.

To add the Audio Playback DAC Framework module to an application, simply add it to a HAL
/Common thread using the stacks selection sequence given in the following table. (The default name
for the Audio Playback DAC Framework module is g_sf audio_playback _hwO0. This name can be
changed in the associated Properties window.)

Audio Playback DAC Framework Module Selection Sequence

Resource ISDE Tab Stacks Selection Sequence
g_sf audio_playback _hwO0 Audio | Threads New Stack> Framework>
Playback Hardware Framework Audio> Audio Playback
on g_sf audio_playback _hwO Hardware Framework on

g_sf_audio_playback _hw_dac

When the Audio Playback DAC Framework module on sf_audio_playback_hw_dac is added to the
thread stack as shown in the following figure, the configurator automatically adds any needed
lower-level modules. Any modules needing additional configuration information have the box text
highlighted in Red. Modules with a Gray band are individual modules that stand alone. Modules with
a Blue band are shared or common; they need only be added once and can be used by multiple
stacks. Modules with a Pink band can require the selection of lower-level modules; these are either
optional or recommended. (This is indicated in the block with the inclusion of this text.) If the
addition of lower-level modules is required, the module description include Add in the text. Clicking
on any Pink banded modules brings up the New icon and displays possible choices.
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New Thread Stacks %) New Stack > -] Remove

@ g_sf_audio_playback_hwO Audio Playback Hardware Framework Shared on

sf_audio_playback_hw_dac
@

ry
] | |

& g_transferD Transfer %1 Add Timer Driver % Add DAC Driver

Driver on r_dtc

Software Activation 1

Figure 114: Audio Playback DAC Framework Module Stack

Note
Salection options of DAC or DAC8 Driver is MCU specific

4.1.3.5 Configuring the Audio Playback DAC Framework Module

The Audio Playback DAC Framework module must be configured by the user for the desired
operation. The SSP configuration window will automatically identify (by highlighting the block in red)
any required configuration selections, such as interrupts or operating modes, which must be
configured for lower-level modules in order to ensure successful operation. Furthermore, only those
properties that can be changed without causing conflicts are available for modification. Other
properties are 'locked' and are not available for changes, and are identified with a lock icon for the
'locked' property in the Properties window in the ISDE. This approach simplifies the configuration
process and makes it much less error-prone than previous 'manual' approaches to configuration. The
available configuration settings and defaults for all the user-accessible properties are given in the
Properties tab within the SSP configurator, and are shown in the following tables for easy reference.

Note
You may want to open your | SDE, create the module and explore the property settings in parallel with looking over
the following configuration table settings; thiswill help orient you and can be a useful 'hands-on' approach to
learning the ins and outs of developing with the SSP.

Configuration Settings for the Audio Playback DAC Framework Module on
sf_audio_playback _hw_dac

ISDE Property Value Description
Parameter Checking BSP, Enabled, Disabled Enables or disables the
parameter checking.
Default: BSP
DMAC Support Disabled, Enabled DMAC support selection.

Default: Disabled

Name g_sf audio_playback _hwO Module name.

Note
The example values and defaults are for a project using the Synergy S7G2 MCU Group. Other MCUs may have
different default values and available configuration settings.
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In some cases, settings other than the defaults for lower-level modules can be desirable. For
example, it might be useful to select the DAC channel based on the target hardware implementation.
The configurable properties for the lower-level stack modules are given in the following sections for
completeness and as a reference.

Note

Most of the property settings for lower level modules are fairly intuitive and can usually be determined by
inspection of the associated Properties window from the SSP configurator.

Configuring the Audio Playback DAC Framework Lower-Level Modules

Typically, only a small number of settings must be modified from the default for lower-level drivers
as indicated with red text in the thread stack block. Notice that some of the configuration properties
must be set to a certain value for proper framework operation and will be locked to prevent user
modification. The following table identifies all the settings within the properties section for the

module.

Configuration Settings for the Transfer Driver on r_dmac Software Activation

ISDE Property

Value

Description

Parameter Checking

BSP, Enabled, Disabled

Selects if code for parameter
checking is to be included in

Block Mode)

Default: BSP the build.
Name g_transfer0 Module name.
Channel 0 Channel selection.
Mode Normal Mode selection.
Transfer Size 2 Bytes Transfer size selection.
Destination Address Mode Fixed Destination address mode

selection.

Source Address Mode Incremented Source address mode selection.
Repeat Area (Unused in Normal | Source Repeat area selection.
Mode
Destination Pointer NULL Destination pointer selection.
Source Pointer NULL Source pointer selection.
Number of Transfers 0 Number of transfers selection.
Number of Blocks (Valid only in |0 Number of blocks selection.

Activation Source

Software Activation, Peripheral
Events

Default: Software Activation

Activation source selection.

Auto Enable

False

Auto enable selection.

Callback

NULL

Callback selection.
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Interrupt Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

Interrupt priority selection.

Note

The example values and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the Transfer Driver on r_dmac Software Activation 1

ISDE Property

Value

Description

Parameter Checking

BSP, Enabled, Disabled

Default: BSP

Selects if code for parameter
checking is to be included in
the build.

Software Start

Enabled, Disabled

Default: Disabled

Software start selection.

Linker section to keep DTC
vector table

.ssp_dtc_vector_table

Linker section selection.

Mode

Name g_transferO Module name.

Mode Normal Mode selection.

Transfer Size 2 Bytes Transfer size selection.

Destination Address Mode Fixed Destination address mode
selection.

Source Address Mode Incremented Source address mode selection.

Repeat Area (Unused in Normal | Source Repeat area selection.

Interrupt Frequency

After all transfers have

Interrupt frequency selection.

Block Mode)

completed
Destination Pointer NULL Destination pointer selection.
Source Pointer NULL Source pointer selection.
Number of Transfers 0 Number of transfers selection.
Number of Blocks (Valid only in |0 Number of blocks selection.

Activation Source (Must enable
IRQ)

Software Activation 1, Software
Activation 2, Peripheral Events

Default: Software Activation 1

Activation source selection.

Auto Enable

False

Auto enable selection.

Callback (Only valid with
Software start)

NULL

Callback selection.
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ELC Software Event Interrupt
Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

ELC Software Event interrupt
priority selection.

Note

The example values and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the Timer Driver on r_agt

ISDE Property

Value

Description

Parameter Checking

BSP, Enabled, Disabled

Enables or disables parameter
checking.

Default: BSP

Name g_timer0 Module name.

Channel 0 Physical hardware channel.

Mode Periodic Warning: One-shot functionality
is not available in the GPT
hardware, so it is implemented
in software by stopping the
timer in the ISR called when the
period expires. For this reason,
ISRs must be enabled for one-
shot mode even if the callback
is unused.

Period Value 10 See Timer Period Calculation.

Period Unit Hertz See Timer Period Calculation.

Auto Start False Set to true to start the timer

after configuring or false to
leave the timer stopped until
timer_api_t::start is called.

Count Source

PCLKB, PCLKB/8, PCLKB/2,
LOCO, AGTO Underflow, AGTO
fSub

Default: PCLKB

The clock source for the AGT
counter.

AGTO Output Enabled

True, False

Default: False

Set to true to output the timer
signal on a port pin configured
for AGT (AGTO pin). Set to false
for no output of the timer
signal.

AGTIO Output Enabled

True, False

Default: False

Set to true to output the timer
signal on a port pin configured
for AGT (AGTIO pin). Set to false
for no output of the timer
signal.
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Output Inverted True, False Set to false to start the output
signal low. Set to true to start
Default: False the output signal high.
Enable comparator A output pin | True, False Enable comparator A output pin
selection.

Default: False

Enable comparator B output pin | True, False Enable comparator B output pin
selection.
Default: False

Callback NULL A user callback function can be
registered in timer_api_t::open.
If this callback function is
provided, it will be called from
the interrupt service routine
(ISR) each time the timer period
elapses.

Warning: Since the callback is
called from an ISR, care should
be taken not to use blocking
calls or lengthy processing.
Spending excessive time in an
ISR can affect the
responsiveness of the system.

Interrupt Priority Priority O (highest), Priority Timer interrupt priority. 0 is the
1:14, Priority 15 (lowest - not highest priority.
valid if using ThreadX)

Default: Disabled

Note

The example values and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the Timer Driver on r_gpt

ISDE Property Value Description
Parameter Checking BSP, Enabled, Disabled Enables or disables the
parameter checking.
Default: BSP
Name g_timer0 Module name.
Channel 0 Channel selection.
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Mode

Periodic

Warning: One-shot functionality
is not available in the GPT
hardware, so it is implemented
in software by stopping the
timer in the ISR called when the
period expires. For this reason,
ISRs must be enabled for one-
shot mode even if the callback
is unused.

Period Value

10

See Timer Period Calculation.

Period Unit

Hertz

See Timer Period Calculation.

Duty Cycle Value

50

Duty cycle value selection.

Duty Cycle Unit

Unit Raw Counts, Unit Percent,
Unit Percent x 1000

Default: Unit Raw Counts

Duty cycle unit selection.

Auto Start False Set to true to start the timer
after configuring or false to
leave the timer stopped until
timer_api_t::start is called.

GTIOCA Output Enabled True, False Set to true to output the timer

Default: False

signal on a port pin configured
for GPT. Set to false for no
output of the timer signal.

GTIOCA Stop Level

Pin Level Low, Pin Level High,
Pin Level Retained

Default: Pin Level Low

Controls output pin level when
the timer is stopped.

GTIOCB Output Enabled

True, False

Default: False

Set to true to output the timer
signal on a port pin configured
for GPT. Set to false for no
output of the timer signal.

GTIOCB Stop Level

Pin Level Low, Pin Level High,
Pin Level Retained

Default: Pin Level Low

Controls output pin level when
the timer is stopped.

R11UMO0161EU0160 Revision 1.60
Mar.29.2024

RLENESAS

Page 193 /5,198



Synergy Software Package

User’s Manual

Module Overviews > Framework Layer > Audio Playback Hardware Framework Shared on sf_audio_playback_hw_dac > Configuring the Audio Playback DAC Framework Module

Callback

NULL

A user callback function can be
registered in timer_api_t::open.
If this callback function is
provided, it will be called from
the interrupt service routine
(ISR) each time the timer period
elapses.

Warning: Since the callback is
called from an ISR, care should
be taken not to use blocking
calls or lengthy processing.
Spending excessive time in an
ISR can affect the
responsiveness of the system.

Interrupt Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

Interrupt priority selection.

Note

The example values and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the DAC HAL Module on r_dac

ISDE Property

Value

Description

Parameter Checking

BSP, Enabled, Disabled

Enable or disable the parameter
error checking.

Default: BSP
Name g_dacO Module name.
Channel 0 Set to 0 for output DAO or 1 for

output DAL.

Synchronize with ADC

Enabled, Disabled

Default: Disabled

Set to true for anti-interference
synchronization with the Analog-
to-Digital Converter (ADC)
Module. Set to false if power
supply interference between

the analog modules is not a
problem, or if asynchronous
conversion by the DAC Module
is desired.

Data Format

Right Justified

Set to zero, if 12-bit data values
are loaded in bits 11 through O,
or right justified. Set to one, if
12-bit data values are loaded in
bits 15 through 4, or left
justified.
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Output Amplifier Enable, Disable Set to true, if output amplifier
hardware function is desired.
Default: Disable Set to false to bypass output

amplifier hardware function.

Note
The example values and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the DAC8 HAL Module r_dac8

ISDE Property Value Description
Parameter Checking BSP, Enabled, Disabled Enable or disable the parameter
Default: BSP error checking.
Name g dac8 0 Module name.
Channel 0 Channel selection.
Synchronize with ADC Enabled, Disabled Choose whether to sync with
Default: Disabled the ADC module.
Data Format Right Justified Data format selection.
DAC Mode Normal Mode, Real-time (Event | DAC mode selection.
Link) Mode
Default: Normal Mode
Charge Pump Enabled Enabled, Disabled Enable or disable the charge
(Requires MOCO active) Default: Enabled pump.
Note

The example values and defaults are for a project using the Synergy SfG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Audio Playback DAC Framework Module Clock Configuration

The Audio Playback DAC Framework hardware modules use the peripheral clocks available in the
Clocks configuration window.

Audio Playback DAC Framework Module Pin Configuration

The DAC or SSI peripheral module uses pins on the MCU to communicate to external devices. I/O pins
must be selected and configured as required by the external device. The following tables illustrate
the method for selecting the pins within the SSP configuration window and show an example
selection for the associated pins.

Note
For some peripherals, the operation mode selection determines what peripheral signals are available and what
MCU pinsare required.

Pin Selection Sequence for the Audio Playback DAC Framework Module

Resource ISDE Tab Pin selection Sequence
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DAC Pins Select Peripherals >
Analog:DAC12 >
DAC120/121

SSI Pins Select Peripherals >
Connectivity:SSI > SS1/0/1

Note
The selection sequence assumes the DACO/DAC1 or the SSI0/SS 1 is the desired hardware target of the driver.

Pin Configuration Settings for the DAC HAL Module on r_dac

Pin Configuration Property Value Description
Operation Mode Enabled, Disabled Operation selection.
DAC None, P0O14 DAC pin selection.

Default: P014

Note
The example values are for a project using the Synergy S7G2 MCU Group and the K-S7G2 Kit. Other Synergy
Kits and other Synergy MCUs may have different available pin configuration settings.

4.1.3.6 Using the Audio Playback DAC Framework Module in an Application
The typical steps in using the Audio Playback DAC Framework module in an application are:

1. Initialize the Audio Playback DAC Framework using the sf audio_playback _hw_api_t::open
API
2. Start the low level hardware of the Audio Playback DAC Framework using the
sf audio_playback hw api_t::start API.
3. Play the PCM audio samples using the sf audio_playback hw_api t::play API.
4. PCM audio samples supported by the hardware is provided by the
sf audio_playback hw api t::dataTypeGet API.
5. Stop the low level hardware of the Audio Playback DAC Framework using
sf audio_playback hw_api_t::stop API.
6. Close the Audio Playback DAC Framework using the sf audio_playback _hw_api_t::close API.

These common steps are illustrated in a typical operational flow in the following figure:
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1. Audio Playback open
open

l

2. Start hardware
start

l

3. Play PCM audio
play

l

4. Determine type of audio
dataTypeGet

l

5. Stop low-level hardware
stop

l

6. Close Audio Playback Framework
close

Figure 115: Flow Diagram of a Typical Audio Playback DAC Framework Module Application

4.1.4 Audio Playback Hardware Framework Shared on
sf_audio_playback_hw_i2s
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4.1.4.1 Audio Playback 12S Framework Introduction

The I12S Audio Playback Framework module provides a high-level API for Audio Playback applications
and handles the synchronization needed to play 8-bit or 16-bit pulse-code modulation (PCM)
samples. The Audio Playback Framework uses the I12S, Timer (AGT or GPT) and Data Transfer (DMA
or DTC) peripherals on a Synergy MCU. A user defined callback can be created to respond to the
need for additional data.

Audio Playback 12S Framework Module Features

¢ Plays long buffers by splitting the data into manageable chunks.

e Repeats playback until ThreadX timeout (for repeated audio like sine wave tones or looped
background music).

Requests next data using callback after last buffer playback begins.

Software volume control.

Pauses and resumes functions.

Basic mixing for multiple streams.

Application

Framework

Audio Playback Framework

sf_audio_playback_hw_i2s
HAL Driver

ThreadX®
12S Driver
N~
N~
HAL Drivers \ \
Transfer Driver Transfer Driver Timer Driver Timer Driver
R_DTC R_DTC R_AGT R_GPT

BSP

Figure 116: Audio Playback I12S Framework Module Block Diagram

4.1.4.2 Audio Playback 12S Framework Module APIs Overview

The Audio Playback 12S Framework module defines APIs for operations such as opening, starting,
playing and stopping. A complete list of the available APIs, an example API call and a short
description of each can be found in the following table. A table of status return values follows the API
summary table.
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Audio Playback 12S Framework Module APl Summary

Function Name Example API Call and Description

open g_sf audio_playback _hwO0.p_api->open(
g_sf audio_playback _hwO.p_ctrl,

g_sf audio_playback_hwO0.p cfg);

Open a device channel for read/write and
control.

start g_sf audio_playback hwO0.p_api->start(
g_sf audio_playback hwO0.p ctrl, &p_data,
Timeout);

Start Audio Playback Hardware.

stop g_sf audio_playback _hw0.p_api->stop(
g_sf audio_playback _hwO0.p_ctrl);
Stop Audio Playback Hardware.

play g_sf audio_playback_hwO0.p_api->play
(g_sf audio_playback_hwO0.p_ctrl, p_buffer,
length);

Play audio buffer.

dataTypeGet g_sf audio_playback hwO0.p_api->dataTypeGet(
g_sf audio_playback hwO.p ctrl, p_data_type);
Stores expected data type in provided pointer
p_data type.

close g_sf audio_playback hwO.p_api->close(
g_sf audio_playback _hwO0.p_ctrl);
Close the audio module.

versionGet g_sf audio_playback hwO0.p_api->versionGet(&v
ersion);

Return the version of the module with the
version pointer.

Note
For more complete descriptions of operation and definitions for the function data structures, typedefs, defines, API
data, API structures and function variables, review the SSP User's Manual API References for the associated
module.

Status Return Values

Name Description
SSP_SUCCESS Function successful.
SSP_ERR_OUT_OF_MEMORY The number of streams open at once is limited

to SF_AUDIO_PLAYBACK CFG_MAX STREAMS. If
thisnumber is exceeded, an out of memory error

occurs.
SSP_ERR_TIMEOUT Timeout occurred before playback finished.
Note
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Lower-level drivers may return common error codes. Refer to the SSP User's Manual APl References for the
associated module for a definition of all relevant status-return values.

4.1.4.3 Audio Playback 12S Framework Module Operational Overview
The 12S Audio Playback Framework module creates a thread internally to support audio playback.

The figure below shows a flowchart of the audio playback framework thread and its interactions with
public Audio Playback Framework APlIs.

SF_AUDIO_PLAYBACK_Open

SF_AUDIO_PLAYBACK_Start

~< Thread Entry )
Post data to

Open Hardware +

Hardware
Open?

message queue

v

Parse all
messagesin [
v audio queue

A4

- Create Audio ‘
Initialize Stream [« Playback Thread

5 o SF_AUDIO_PLAYBACK_Pause/
rocess Lata SF_AUDIO_PLAYBACK_Stop/

(scale, mix, SF_AUDIO_PLAYBACK_Resume
volume, etc.) — — —

v

Start playback Post control
(first time) or message
store pointer

to next data
buffer in
contrgl block

No

Internal Audio Playback
Callback

Next

Play next buffer
(if available) i

+ Yes

Wait for Legend
Post “playback playback
complete” flag "] completeflag Beige Blue represents
or timeout represents the shared audio
API calls made thread (internal
per stream to framework)

Figure 117: Audio Playback DAC Framework Module Flow Chart

Suggested use of the audio playback framework:

¢ Create a semaphore (for example g_sf audio_playback semaphore). This can be done on
the Threads tab. Set the initial value to 2 (the audio playback framework can store up to
two data messages per stream).
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» Create a callback function (for example sf_audio_playback callback). Enter the name of
your callback function in the Audio Playback Framework instance. The callback function will
be called when the audio playback framework is done with the data. In the callback, put the
semaphore created above.

e In your main loop, get the semaphore before playing data. To play data, first acquire a
buffer from the messaging framework, then create your audio playback data structure
inside the buffer.

The Audio Playback Framework supports multiple audio streams on a single hardware port. A block
diagram of the modules required if two streams are used is shown in following figure:

Ogg Vorbis/
sf_audio_ decode > MP3/WAV Takes compressed audio data (from file system or pointer to data
*Future Decoder from input stream), selects appropriate decoder, decodes data and
Plugins passes it to audio playback stream. This module is not yet implemented.
3
sf_audio_ playback on st_audio_ playback on
sf_audio_playback st_audio_playback Passes data associated with a particular stream to a shared audio
Stream 1 Stream 2 playback thread.
sf_audio_ playback_common on Thread shared by all audio streams on the same hardware.
sf_audio_playback Combines decompressed data from all active streams and scales it to

fix the ouput hardware data type and requested volume.

|

sf_audio_ playback_hw on
sf_audio_playback_hw_i2s

!

r_timer +r_I2S_transfer

Plays a single buffer of decompressed audio data. Transfers PCM
data to 125 at sampling frequency governed by timer.

Modules required by the layer above.

Figure 118: Audio Playback DAC Framework Implementing Multiple Audio Streams

Audio Playback 12S Framework Module Important Operational Notes and Limitations

Audio Playback 12S Framework Module Operational Notes

e The queue used must match the name specified in Properties for Audio Playback
Framework Shared on sf_audio_playback (default is g_sf audio_playback _queue).
e The audio framework 12S hardware port has dependencies on the 125 driver module. The
I2S driver module can be accelerated with DTC (recommended).
e |2S driver module.
o Set the Audio Clock Frequency (Hertz) to the frequency of the input audio clock
used.
o Set the Sampling Frequency (Hertz) to the sampling frequency of your audio data.
o Set the Data Bits and Word Length to 16 bits (audio framework accepts 16 bit
samples only).
o Enable the SSIn TXI and SSIn INT interrupts.
e Transfer module on r_dtc (recommended).
e Set the activation source to the SSIn TXI interrupt.
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* The Audio Playback I12S Framework is designed to support the following MCU families with
no changes to the API:
o S7G2
S3A7
S5D9
S3A3
S3A6
S5D5
S3A1
S5D3

o 0 0o o o o o

Audio Playback 12S Framework Module Limitations

e Refer to the latest SSP Release Notes for any additional operational limitations for this
module.

4.1.4.4 Including the Audio Playback I12S Framework Module in an Application

This section describes how to include the Audio Playback 12S Framework module in an application
using the SSP configurator.

Note
This section assumes you are familiar with creating a project, adding threads, adding a stack to a thread and
configuring a block within the stack. If you are unfamiliar with any of these items, refer to the first few chapters of
the SSP User's Manual to learn how to manage each of these important stepsin creating SSP-based applications.

To add the Audio Playback 12S Framework module to an application, simply add it to a HAL /Common
thread using the stacks selection sequence given in the following table. (The default name for the
Audio Playback 12S Framework module is g_sf audio_playback _hwO0. This name can be changed in
the associated Properties window.)

Audio Playback 12S Framework Module Selection Sequence

Resource ISDE Tab Stacks Selection Sequence
g_sf audio_playback hwO Audio | Threads New Stack> Framework>
Playback Hardware Framework Audio> Audio Playback
on sf _audio_playback hw i2s Hardware Framework on

sf_audio_playback hw_i2s

When the Audio Playback 12S Framework module on sf _audio_playback hw_i2s is added to the
thread stack as shown in the following figure, the configurator automatically adds any needed
lower-level modules. Any modules needing additional configuration information have the box text
highlighted in Red. Modules with a Gray band are individual modules that stand alone. Modules with
a Blue band are shared or common; they need only be added once and can be used by multiple
stacks. Modules with a Pink band can require the selection of lower-level modules; these are either
optional or recommended. (This is indicated in the block with the inclusion of this text.) If the
addition of lower-level modules is required, the module description include Add in the text. Clicking
on any Pink banded modules brings up the New icon and displays possible choices.
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New Thread Stacks & | New Stack > % | Remove

@ g_sf_audio_playback_hw0 Audio Playback Hardware Framework Shared on
sf_audio_playback_hw_i2s

@

A
1
¢ g_i2s0 12S Driver on r_ssi
A
| | |
@ g_transfer Transfer @ g_transfer Transfer % Add Timer Driver
Driver on r_dtc Driver on r_dtc [Optional]
Software Activation 1 Software Activation 1
A A

Figure 119: Audio Playback I12S Framework Module Stack

4.1.4.5 Configuring the Audio Playback 12S Framework Module

The Audio Playback 12S Framework module must be configured by the user for the desired operation.
The SSP configuration window will automatically identify (by highlighting the block in red) any
required configuration selections, such as interrupts or operating modes, which must be configured
for lower-level modules in order to ensure successful operation. Furthermore, only those properties
that can be changed without causing conflicts are available for modification. Other properties are
'locked' and are not available for changes, and are identified with a lock icon for the 'locked' property
in the Properties window in the ISDE. This approach simplifies the configuration process and makes it
much less error-prone than previous 'manual' approaches to configuration. The available
configuration settings and defaults for all the user-accessible properties are given in the Properties
tab within the SSP configurator, and are shown in the following tables for easy reference.

Note
You may want to open your |SDE, create the module and explore the property settingsin parallel with looking over
the following configuration table settings; thiswill help orient you and can be a useful 'hands-on' approach to
learning the ins and outs of developing with the SSP.

Configuration Settings for the Audio Playback 12S Framework Module on
sf_audio_playback _hw_i2s

ISDE Property Value Description
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Parameter Checking

BSP, Enabled, Disabled

Default: BSP

Enable or disable the parameter
error checking.

Name

g_sf audio_playback _hwO

Module name.

Note

The example values and defaults are for a project using the Synergy S7G2 MCU Group. Other MCUs may have
different default values and available configuration settings.

In some cases, settings other than the defaults for lower level modules can be desirable. For
example, it might be useful to select the DAC or 12S Channel based on the target hardware
implementation. The configurable properties for the lower level stack modules are given in the
following sections for completeness and as a reference.

Note

Most of the property settings for lower level modules are fairly intuitive and can usually be determined by
inspection of the associated Properties window from the SSP configurator.

Configuring the Audio Playback 12S Framework Lower-Level Modules

Typically, only a small number of settings must be modified from the default for lower-level drivers
as indicated with red text in the thread stack block. Notice that some of the configuration properties
must be set to a certain value for proper framework operation and will be locked to prevent user
modification. The following table identifies all the settings within the properties section for the

module.

Configuration Settings for the 12S HAL Module on r_ssi

ISDE Property

Value

Description

Parameter Checking

BSP, Enabled, Disabled

Enables or disables the
parameter checking.

Default: BSP

Name g_i2s0 Module name.

Channel 0 Physical hardware channel.

Audio Clock Frequency (Hertz) |2822400 Input audio clock frequency,
used to generate the I12S clock.
Must be a multiple between 1
and 128 of: (sampling_freq_hz *
word_length_in_bits).

Sampling Frequecy (Hertz) 44100 Sampling frequency of audio

data.

Data Bits

8 bits, 16, 18, 20, 22, 24

Default: 16 bits

Bit depth of audio data, which is
the size in bits of one sample of
audio data.

Word Length

8 bits, 16, 24, 32

Default: 16 bits

Word length of audio data,
must be at least the same size
as the bit depth (Data Bits
field).
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WS Continue Mode

Enabled, Disabled

Default: Disabled

Enable WS continue mode to
continue to output the word
select line when the peripheral
is idle. Disable to stop
outputting the word select line
when the peripheral is idle.

Name of 12S callback function
to be defined by user

NULL

A user callback function must
be registered in open. The
callback will be called from the
interrupt service routine (ISR)
when the transmission FIFO
reaches the high watermark
point after all data for
transmission is transmitted or
when reception is complete
(the requested number of bytes
have been received).

Warning: Since the callback is
called from an ISR, care should
be taken not to use blocking
calls or lengthy processing.
Spending excessive time in an
ISR can affect the
responsiveness of the system.

Transmit Interrupt Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

Transmit interrupt priority
selection.

Receive Interrupt Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

Receive interrupt priority
selection.

Idle/Error Interrupt Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Priority 12

Idle/error interrupt priority
selection.

Note

The example values and defaults are for a project using the Synergy S7G2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the Transfer Driver on r_dtc Software Activation 1

ISDE Property

Value

Description

Parameter Checking

BSP, Enabled, Disabled

Default: BSP

Parameter selection.
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Software Start

Enabled, Disabled

Default: Disabled

Software start selection.

Linker section to keep DTC
vector table

.ssp_dtc_vector_table

Linker section to keep DTC
vector table.

Mode

Name g_transferO Driver name.

Mode Normal Mode selection.

Transfer Size 4 Bytes Transfer size selection.

Destination Address Mode Fixed Destination address mode
selection.

Source Address Mode Incremented Source address mode selection.

Repeat Area (Unused in Normal | Source Repeat area selection.

Interrupt Frequency

After all transfers have

Interrupt frequency selection.

Block Mode)

completed
Destination Pointer NULL Destination pointer selection.
Source Pointer NULL Source pointer selection.
Number of Transfers 0 Number of transfers selection.
Number of Blocks (Valid only in |0 Number of blocks selection.

Activation Source (Must enable
IRQ)

Software Activation 1, Software
Activiation 2, Peripheral Events

Default: Software Activation 1

Activation source selection.

Auto Enable

False

Auto enable selection.

Callback (Only valid with
Software start)

NULL

Callback selection.

ELC Software Event Interrupt
Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

ELC software event interrupt
priority selection.

Note

The example values and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the Transfer Driver on r_dtc Software Activation 1

ISDE Property

Value

Description

Parameter Checking

BSP, Enabled, Disabled

Default: BSP

Parameter selection.
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Software Start

Enabled, Disabled

Default: Disabled

Software start selection.

Linker section to keep DTC
vector table

.ssp_dtc_vector_table

Linker section to keep DTC
vector table.

Mode

Name g_transferl Driver name.

Mode Normal Mode selection.

Transfer Size 4 Bytes Transfer size selection.

Destination Address Mode Incremented Destination address mode
selection.

Source Address Mode Fixed Source address mode selection.

Repeat Area (Unused in Normal | Destination Repeat area selection.

Interrupt Frequency

After all transfers have

Interrupt frequency selection.

Block Mode)

completed
Destination Pointer NULL Destination pointer selection.
Source Pointer NULL Source pointer selection.
Number of Transfers 0 Number of transfers selection.
Number of Blocks (Valid only in |0 Number of blocks selection.

Activation Source (Must enable
IRQ)

Software Activation 1, Software
Activiation 2, Peripheral Events

Default: Software Activation 1

Activation source selection.

Auto Enable

False

Auto enable selection.

Callback (Only valid with
Software start)

NULL

Callback selection.

ELC Software Event Interrupt
Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

ELC software event interrupt
priority selection.

Note

The example values and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the Timer Driver on r_agt

ISDE Property

Value

Description

Parameter Checking

BSP, Enabled, Disabled

Default: BSP

Enables or disables parameter
checking.
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Name

g_timer0

Module name.

Channel

0

Physical hardware channel.

Mode

Periodic

Warning: One-shot functionality
is not available in the GPT
hardware, so it is implemented
in software by stopping the
timer in the ISR called when the
period expires. For this reason,
ISRs must be enabled for one-
shot mode even if the callback
is unused.

Period Value

10

See Timer Period Calculation.

Period Unit

Hertz

See Timer Period Calculation.

Auto Start

False

Set to true to start the timer
after configuring or false to
leave the timer stopped until
timer_api_t::start is called.

Count Source

PCLKB, PCLKB/8, PCLKB/2,
LOCO, AGTO Underflow, AGTO
fSub

Default: PCLKB

The clock source for the AGT
counter.

AGTO Output Enabled

True, False

Default: False

Set to true to output the timer
signal on a port pin configured
for AGT (AGTO pin). Set to false
for no output of the timer
signal.

AGTIO Output Enabled

True, False

Default: False

Set to true to output the timer
signal on a port pin configured
for AGT (AGTIO pin). Set to false
for no output of the timer
signal.

Output Inverted

True, False

Default: False

Set to false to start the output
signal low. Set to true to start
the output signal high.

Enable comparator A output pin

True, False

Default: False

Enable comparator A output pin
selection.

Enable comparator B output pin

True, False

Default: False

Enable comparator B output pin
selection.
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Callback NULL A user callback function can be
registered in timer_api_t::open.
If this callback function is
provided, it will be called from
the interrupt service routine
(ISR) each time the timer period
elapses.

Warning: Since the callback is
called from an ISR, care should
be taken not to use blocking
calls or lengthy processing.
Spending excessive time in an
ISR can affect the
responsiveness of the system.

Interrupt Priority Priority O (highest), Priority Timer interrupt priority. 0 is the
1:14, Priority 15 (lowest - not highest priority.
valid if using ThreadX)

Default: Disabled

Parameter Checking BSP, Enabled, Disabled Enables or disables parameter
checking.
Default: BSP
Name g_timer0 Module name.
Channel 0 Physical hardware channel.
Note

The example values and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the Timer Driver on r_gpt

ISDE Property Value Description
Parameter Checking BSP, Enabled, Disabled Parameter selection.
Default: BSP
Name g_timer0 Module name.
Channel 0 Channel selection.
Mode Periodic Mode selection.
Period Value 2822400 *2 Period value selection.
Period Unit Hertz Period unit selection.
Duty Cycle Value 50 Duty cycle value selection.
Duty Cycle Unit Unit Raw Counts, Unit Percent, |Duty cycle unit selection.
Unit Percent x 1000
Default: Unit Raw Counts
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Auto Start FALSE Auto start selection.
GTIOCA OQutput Enabled True, False GTIOCA output enabled
selection.

Default: False

GTIOCA Stop Level Pin Level Low, Pin Level High, GTIOCA stop level selection.
Pin Level Retained

Default: Pin Level Low

GTIOCB Output Enabled True, False GTIOCB output enabled
selection.
Default: False

GTIOCB Stop Level Pin Level Low, Pin Level High, GTIOCB stop level selection.
Pin Level Retained

Default: Pin Level Low

Callback NULL Callback selection.

Overflow Interrupt Priority Priority O (highest), Priority Interrupt priority selection.
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

Note
The example values and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Audio Playback 12S Framework Module Clock Configuration

The Audio Playback 12S Framework hardware modules use the peripheral clocks available in the
clock configuration window.

Audio Playback 12S Framework Module Pin Configuration

The SSI peripheral module uses pins on the MCU to communicate to external devices. I/0O pins must
be selected and configured as required by the external device. The following tables illustrate the
method for selecting the pins within the SSP configuration window and shows an example selection
for the associated pins.

Pin Selection Sequence for the Audio Playback 12S Framework Module

Resource ISDE Tab Pin selection Sequence

12S Pins Select Peripherals >
Connectivity:SSI >
SSI10/SSI1.

Note
The selection sequence assumes the ADCO/ADCL or the SS0/SS 1 isthe desired hardware target of the driver.

Pin Configuration Settings for the 12S Driver on r_ssi
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Pin Configuration Property Value Description
Pin Group Selection _Aonly, B only, Mixed Pin group for 12S port.
Operation Mode Enabled, Custom, Disabled Operation selection.
SSISCK None, P204 SSI Serial clock.

Default: None

SSIWS None, P205 SSI Stereo pin selection.

Default: None

SSIDATA None, P206 SSI Data pin selection.

Default: None

Note
The example values are for a project using the Synergy S7G2 MCU Group and the K-S7G2 Kit. Other Synergy
Kits and other Synergy MCUs may have different available pin configuration settings.

4.1.4.6 Using the Audio Playback 12S Framework Module in an Application

The typical steps in using the Audio Playback I12S Framework module in an application are:

1. Initialize the Audio Playback 12S Framework using the sf audio_playback hw_api_t::open API.

2. Start the low level hardware of the Audio Playback 12S framework using the
sf_audio_playback_hw_api_t::start API.

3. Play the PCM audio samples using the sf_audio_playback hw_api_t::play API.

4. PCM audio samples supported by the hardware is provided by the
sf audio_playback _hw_api_t::dataTypeGet API.

5. Stop the low level hardware of the Audio Playback 12S Framework using
sf audio_playback hw_api_t::stop API.

6. Close the Audio Playback 12S framework using the sf_audio_playback _hw_api_t::close API.

These common steps are illustrated in a typical operational flow in the following figure:
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1. Audio Playback open
open

l

2. Start hardware
start

l

3. Play PCM audio
play

l

4. Determine type of audio
dataTypeGet

l

5. Stop low-level hardware
stop

l

6. Close Audio Playback Framework
close

Figure 120: Flow Diagram of a Typical Audio Playback 12S Framework Module Application

4.1.5 Audio Record ADC Framework

4.1.5.1 Audio Record ADC Framework Module Introduction
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The Audio Record ADC Framework module provides a high-level API for audio recording applications
and uses the sf _adc_periodic and its lower layer ADC, GPT and DTC peripherals on the Synergy MCU.
A user-defined callback can be created to indicate that the sample count has been completed.

Audio Record ADC Framework Module Features

¢ Currently supports 12-bit ADCs (supports 8, 10, and 12 bits) and 14-bit ADCs (supports 14
or 12-bit PCM data)
¢ Uses ADC Periodic Framework to simplify configuration and integration
¢ Uses a ThreadX object (for example, mutex) to protect hardware from improper access
¢ APIs for high-level functions simplify coding:
o sf audio_record_api_t::open, sf audio_record api_t::start
o sf audio_record_api_t::stop, sf audio_record_api_t::infoGet
o sf audio_record _api_t::close

Application

Framework

Audio Record ADC Framework
sf_audio_record_adc

Framework

ThreadX®

ADC Periodic Framework
sf_adc_periodic

HAL Drivers / \

RTOS

ADC Driver Timer Driver Timer Driver Transfer Driver
R_ADC R_AGT R_GPT R_DTC
BSP

Figure 121: Audio Record ADC Framework Module Block Diagram

4.1.5.2 Audio Record ADC Framework Module APIs Overview

The Audio Record ADC Framework module defines APIs for opening, closing, starting and stopping
the record process. A complete list of the available APIs, an example API call and a short description
of each can be found in the following table. A table of status return values follows the APl summary
table.

Audio Record ADC Framework Module APl Summary

Function Name Example API Call and Description

open g_sf_audio_record_adc.p_api->open(g_sf audio_r
ecord_adc.p_ctrl, g_sf audio_record_adc.p_cfg);
Initialize the module.
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start g_sf audio_record_adc.p_api->start(g_sf audio r
ecord_adc.p_ctrl);
Start audio recording.

stop g_sf audio_record _adc.p_api->stop(g_sf audio r
ecord_adc.p_ctrl);
Stop audio recording.

infoGet g_sf audio_record_adc.p_api->infoGet(g_sf audi
o_record_adc.p_api.p_ctrl;
Get the channel information (mono or Stereo).

close g_sf audio_record_adc.p_api->close(g_sf audio_r
ecord_adc.p_ctrl);
Close the module.

versionGet g_sf audio_record_adc.p_api->versionGet(&versi
on);
Retrieve the API version with the version pointer.

Note
For more complete descriptions of operation and definitions for the function data structures, typedefs, defines, API
data, API structures, and function variables, review the SSP User's Manual API References for the associated
module.

Status Return Values

Name Description
SSP_SUCCESS API Call Successful.
SSP_ERR_INVALID ARGUME Parameter has invalid value.
SSP_ERR_IN_USE The adc periodic framework mutex may be

unavailable for the unit requested. See HAL
driver for other possible causes.

SSP_ERR_INTERNAL An internal ThreadX error has occurred. This is
typically a failure to create/use a mutex or to
create an internal thread.

SSP_ERR_NOT_OPEN Unit is not open.
SSP_ERR_ASSERTION The parameter p_ctrl or p_sample is NULL.
SSP_ERR_UNSUPPORTED This function is not supported by the HAL driver

(p_ctrl->p_api->close is NULL).

Note
Lower-level drivers may return common error codes. Refer to the SSP User's Manual API References for the
associated module for a definition of all relevant status return values.

4.1.5.3 Audio Record ADC Framework Module Operational Overview

The Audio Record ADC Framework Module samples audio analog data using the ADC Periodic
Framework and the data samples captured are stored in the user buffer. The data is made available
for further processing as needed by the application. The Audio Record ADC Framework has a
configuration parameter that is initialized during the framework initialization, which also initializes
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the underlying ADC periodic framework for data capture.

The captured data is stored in a user defined buffer and this is done in the callback function as
illustrated below:

Assuming the name of the callback has been configured to be sf_audio_record_user_callback:

uintl6 t * audi o_record_buffer;

voi d sf_audi o_record_user call back (sf_audio_record _call back_args_t *p_args)
{

audi o_record_buffer = ((uintl6_t *)g sf_audio_record_adc. p_cfg->

p_capture_data_buffer + (p_args->buffer_index/2)); }

Audio Record ADC Framework Module Important Operational Notes and Limitations

Audio Record ADC Framework Module Operational Notes

e The Audio Record ADC Framework Module configuration data can specify the length of the
data buffer, data width, sampling rate and the number of sampling iterations.

Audio Record ADC Framework Module Limitations

e Currently, the Audio Record ADC only supports the ADC Periodic Framework as the lower
level; recording via the 12S is not supported.

e The framework currently supports recording 8 bit or 12 bit PCM data.

e Currently, the Audio Record ADC only supports mono channel.

e Refer to the most recent SSP Release Notes for any additional operational limitations for
this module.

4.1.5.4 Including the Audio Record ADC Framework Module in an Application

This section describes how to include the Audio Record ADC Framework Module in an application
using the SSP configurator.

Note
This section assumes you are familiar with creating a project, adding threads, adding a stack to a thread and
configuring a block within the stack. If you are unfamiliar with any of these items, refer to the first few chapters of
the SSP User's Manual to learn how to manage each of these important steps in creating SSP-based applications.

To add the Audio Record ADC Framework to an application, simply add it to a thread using the stacks
selection sequence given in the following table. (The default name for the ADC Audio Record ADC
Framework is g _adc_record_adcO. This name can be changed in the associated Properties window.)

Audio Record ADC Framework Module Selection Sequence

Resource ISDE Tab Stacks Selection Sequence
g_audio_record_adcO Audio Threads New Stack> Driver> Audio>
Record ADC Framework on Audio Record ADC
sf audio_record_adc Framework on

sf_audio_record_adc
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When the Audio Record ADC Framework on sf_audio_record_adc is added to the thread stack as
shown in the following figure, the configurator automatically adds any needed lower-level modules.
Any modules needing additional configuration information have the box text highlighted in Red.
Modules with a Gray band are individual modules that stand alone. Modules with a Blue band are
shared or common; they need only be added once and can be used by multiple stacks. Modules with
a Pink band can require the selection of lower-level modules; these are either optional or
recommended. (This is indicated in the block with the inclusion of this text.) If the addition of lower-
level modules is required, the module description include Add in the text. Clicking on any Pink
banded modules brings up the New icon and displays possible choices.

New Thread Stacks %] New Stack > % | Remove
4% g_sf_audio_record_adc0 Audio Record ADC Framework on sf_audio_record_adc
@

A
T
d,- g_sf_adc_periodicO ADC Periodic Framework on sf_adc_periodic
A
[ [ [
@ g_adcO ADC Driveron | | & Add Timer Driver # g_transferD Transfer
r_adc Driver on r_dtc
Software Activation 1
r ry

Figure 122: Audio Record ADC Framework Module Stack

4.1.5.5 Configuring the Audio Record ADC Framework Module

The Audio Record ADC Framework Module must be configured by the user for the desired operation.
The available configuration settings and defaults for all the user-accessible properties are given in
the properties tab within the SSP configurator and are shown in the following tables for easy
reference. Only properties that can be changed without causing conflicts are available for
modification. Other properties are locked and not available for changes and are identified with a lock
icon for the locked property in the Properties window in the ISDE. This approach simplifies the
configuration process and makes it much less error-prone than previous manual approaches to
configuration. The available configuration settings and defaults for all the user-accessible properties
are given in the Properties tab within the SSP Configurator and are shown in the following tables for
easy reference.

Note
You may want to open your | SDE, create the module and explore the property settings in parallel with looking over
the following configuration table settings. This will help orient you and can be a useful 'hands-on' approach to
learning the ins and outs of developing with SSP.

Configuration Settings for the Audio Record ADC Framework Module on
sf_audio_record_adc

ISDE Property Value Description
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Parameter Checking

BSP, Enabled, Disabled

Default: BSP

Enables or disables the
parameter checking.

Name

g_sf audio_record _adcO

Module name.

Name of the data-buffer to
store samples

p_capture_data_buffer

Name of the 16-bit data buffer
to store samples.

Length of the data-buffer 2048 Length of the buffer to which
data is to be stored.

Audio Record Data Size 8-Bit, 16-Bit The data width of captured data
8 bit or 16 bit.

Default: 8-Bit

Sampling Rate in HZ 8000 Sampling rate to be used to
capture data.

Number of sampling iterations | 256 Samples to be captured.

Callback

g_audio_record _framework user
_callback

Callback to user after capturing
the sample count.

Name of generated initialization
function

sf audio_record_adc_init0

Name of generated initialization
function selection.

Auto Initialization

Enable, Disable

Default: Enable

Auto initialization selection.

Note

The example settings and defaults are for a project using the Synergy S7TG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the Audio Record ADC Framework Module Lower Level Modules

Typically, only a small number of settings must be modified from the default for lower level drivers
as indicated via the red text in the thread stack block. Notice that some of the configuration
properties must be set to a certain value for proper framework operation and will be locked to
prevent user modification. The following tables identify all the settings within the properties section

for the module.

Configuration Settings for the ADC Periodic Framework on sf adc_periodic

ISDE Property

Value

Description

Parameter Checking

BSP, Enabled, Disabled

Default: BSP

Enables or disables the
parameter checking.

Name

g_sf adc_periodic0O

Module name.

Name of the data-buffer to
store samples

g_user_buffer

Name of the 16-bit data buffer
to store samples.

Length of the data-buffer

2048

Length of the buffer to which
data is to be stored.
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Number of sampling iterations |256 Priority of ADC Periodic
Framework internal thread.

Callback NULL User function that will be called
once "sample_counts" number
of data has been buffered.

Name of generated initialization | sf_adc_periodic_initO Name of generated initialization
function function selection.
Auto Initialization Enable, Disable Auto initialization selection.

Default: Enable

Note
The example settings and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the ADC HAL Module on r_adc

ISDE Property Value Description
Parameter Checking BSP, Enabled, Disabled If selected code for parameter
checking is included in the
Default: Enabled build.
Name g_adcO Module name.
Unit 0, 1 (57G2 Only) Specify the ADC Unit to be
used. The S7G2 has two units; 0
Default: 0 and 1.
Resolution 14-Bit (53A7/S124 Only), 12-Bit, | Specify the conversion
10-Bit (57G2) resolution for this unit.

Default: 8-Bit (S7G2 Only)

Alignment Right, Left Specify the conversion result
alignment.
Default: Right
Clear after read Off, On Specify if the result register
must be automatically cleared
Default: On after the conversion result is
read.

Note: If this is enabled, then
watching the result register
using a debugger always
results in a 0.

Mode Single Scan The ADC Framework
preconfigures and locks this
field.
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Channels 0-6

Unused, Use in Normal/Group A,
Use in Group B

Default: Unused

In Normal mode of operation,
this bitmask field is used to
specify the channels that are
enabled in that ADC unit. For
example, if it is set to 0x101,
then channels 0 and 2 are
enabled. In group mode, this
field is used to specify which
channels belong to group A.

Channels 7-10 (S3A7/S124
Only)

Unused, Use in Normal/Group A,
Use in Group B

Default: Unused

In Normal mode of operation,
this bitmask field is used to
specify the channels that are
enabled in that ADC unit. For
example, if it is set to 0x101,
then channels 0 and 2 are
enabled. In group mode, this
field is used to specify which
channels belong to group A.

Channels 11-15 (S3A7 Only)

Unused, Use in Normal/Group A,
Use in Group B

Default: Unused

In Normal mode of operation,
this bitmask field is used to
specify the channels that are
enabled in that ADC unit. For
example, if it is set to 0x101,
then channels 0 and 2 are
enabled. In group mode, this
field is used to specify which
channels belong to group A.

Channels 16-20

Unused, Use in Normal/Group A,
Use in Group B

Default: Unused

In Normal mode of operation,
this bitmask field is used to
specify the channels that are
enabled in that ADC unit. For
example, if it is set to 0x101,
then channels 0 and 2 are
enabled. In group mode, this
field is used to specify which
channels belong to group A.

Channel 21 (Unit 0 Only)

Unused, Use in Normal/Group A,
Use in Group B

Default: Unused

In Normal mode of operation,
this bitmask field is used to
specify the channels that are
enabled in that ADC unit. For
example, if it is set to 0x101,
then channels 0 and 2 are
enabled. In group mode, this
field is used to specify which
channels belong to group A.
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Channel 22 (S3A7/5124 Only)

Unused, Use in Normal/Group A,
Use in Group B

Default: Unused

In Normal mode of operation,
this bitmask field is used to
specify the channels that are
enabled in that ADC unit. For
example, if it is set to 0x101,
then channels 0 and 2 are
enabled. In group mode, this
field is used to specify which
channels belong to group A.

Channels 23-27 (S3A7 Only)

Unused, Use in Normal/Group A,
Use in Group B

Default: Unused

In Normal mode of operation,
this bitmask field is used to
specify the channels that are
enabled in that ADC unit. For
example, if it is set to 0x101,
then channels 0 and 2 are
enabled. In group mode, this
field is used to specify which
channels belong to group A.

Temperature Sensor

Unused, Use in Normal/Group A,
Use in Group B

Default: Unused

Temperature sensor use
selection for Channel Scan
Mask.

Voltage Sensor

Unused, Use in Normal/Group A,
Use in Group B

Default: Unused

Voltage sensor use selection for
Channel Scan Mask.

Normal/Group A Trigger

ELC Event

The ADC Framework
preconfigures and locks this
field.

Group B Trigger (Valid Only in
Group Scan Mode)

ELC Event (The only valid
trigger for either group in Group
Scan Mode)

The ADC Framework
preconfigures and locks this
field.

Group Priority (Valid only in
Group Scan Mode)

Group A cannot interrupt Group
B, Group A can interrupt Group
B; Group B scan restarts at next
trigger, Group A can interrupt
Group B; Group B scan restarts
immediately, Group A can
interrupt Group B; Group B scan
restarts immediately and scans
continuously

Default: Group A cannot
interrupt Group B

Do not use with ADC
Framework since the mode is
locked to Single Scan Mode.
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Add/Average Count

Disabled, Add two samples, Add
three samples, Add four
samples, Add sixteen samples,
Average two samples, Average
four samples

Default: Disabled

Specify if addition or averaging
needs to be done for any of the
channels in this unit. The actual
channels are specified by using
a channel mask

adc_channel cfg_t::add_mask.

Channels 0-27

Disabled, Enabled

Default: Disabled

This field is valid only if
adc_cfg t::add_average_count
is enabled. This field
determines what channels
results are to be averaged or
summed.

Temperature Sensor

Disabled, Enabled

Default: Disabled

Temperature sensor use
selection for Addition/Averaging
Mask.

Voltage Sensor

Disabled, Enabled

Default: Disabled

Voltage sensor use selection for
Addition/Averaging Mask.

Channels 0-2

Disabled, Enabled

Default: Disabled

Determines which of channels
0, 1 and 2 are using the
updated sample-and-hold
states value specified in
adc_channel cfg_t::sample_hold
_states. This field must only be
set if it is desired to modify the
default sample and hold count
value for channels 0, 1 and 2.

Sample Hold States (Applies
only to the 3 channels selected
above)

24

Specifies the updated sample-
and-hold count for the channel
dedicated sample-and-hold
circuit. This field is valid only if
adc_channel cfg_t::sample_hold
_mask is not 0. Only channels
0, 1 and 2 have dedicated
sample and hold circuits.

Note: Use this to modify the
default number of states (24)
for which the value is sampled.
Each state is equal to 1/ADCLK
time.

Callback

NULL

The ADC Framework uses the
callback internally.

Scan End Interrupt Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

Scan End Interrupt Priority
selection.
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Scan End Group B Interrupt
Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

Scan End Group B Interrupt
Priority selection.

Note

The exampl e settings and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the AGT HAL Module on r_agt

ISDE Property

Value

Description

Parameter Checking

BSP, Enabled, Disabled

Default: BSP

Enables or disables parameter
checking.

Name

g_timer0

Module name.

Channel

0

Physical hardware channel.

Mode

Periodic

Warning: One-shot functionality
is not available in the GPT
hardware, so it is implemented
in software by stopping the
timer in the ISR called when the
period expires. For this reason,
ISRs must be enabled for one-
shot mode even if the callback
is unused.

Period Value

10

See Timer Period Calculation.

Period Unit Raw Counts, Nanoseconds, See Timer Period Calculation.
Microseconds, Milliseconds,
Seconds, Hertz, Kilohertz
Default: Microseconds

Auto Start False Set to true to start the timer

after configuring or false to
leave the timer stopped until
timer_api_t::start is called.

Count Source

PCLKB, PCLKB/8, PCLKB/2,
LOCO, AGTO Underflow, AGTO
fSub

Default: PCLKB

The clock source for the AGT
counter.

AGTO Output Enabled

True, False

Default: False

Set to true to output the timer
signal on a port pin configured
for AGT (AGTO pin). Set to false
for no output of the timer
signal.
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AGTIO Output Enabled True, False Set to true to output the timer
signal on a port pin configured
Default: False for AGT (AGTIO pin). Set to false
for no output of the timer
signal.
Output Inverted True, False Set to false to start the output
signal low. Set to true to start
Default: True the output signal high.
Enable comparator A output pin | True, False Enable comparator A output pin
selection.

Default: False

Enable comparator B output pin | True, False Enable comparator B output pin
selection.
Default: False

Callback NULL A user callback function can be
registered in timer_api_t::open.
If this callback function is
provided, it will be called from
the interrupt service routine
(ISR) each time the timer period
elapses.

Warning: Since the callback is
called from an ISR, care should
be taken not to use blocking
calls or lengthy processing.
Spending excessive time in an
ISR can affect the
responsiveness of the system.

Underflow Interrupt Priority Priority O (highest), Priority Timer interrupt priority. O is the
1:14, Priority 15 (lowest - not highest priority.
valid if using ThreadX)

Default: Disabled

Note
The example settings and defaults are for a project using the Synergy S7G2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the GPT HAL Module on r_gpt

ISDE Property Value Description
Parameter Checking BSP, Enabled, Disabled Enables or disables the
parameter checking.
Default: BSP
Name g_timer0 Module name.
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Channel

The ADC Framework
preconfigures and locks this
field based on channel selected
in the ADC Framework.

Mode

Periodic

The ADC Framework
preconfigures and locks this
field.

Period Value

10

Configure timer period to
trigger ADC scans.

Period Unit

Raw Counts, Nanoseconds,
Microseconds, Milliseconds,
Seconds, Hertz, Kilohertz

Default: Milliseconds

Configure units of the timer
period set above.

Duty Cycle Value

50

Duty cycle value selection.

Duty Cycle Unit

Unit Raw Counts, Unit Percent,
Unit Percent x 1000

Default: Unit Raw Counts

Duty cycle unit selection.

Default: False

Auto Start False The ADC Framework
preconfigures and locks this
field.

GTIOCA Output Enabled True, False Set to true to output the timer

signal on a port pin configured
for GPT. Set to false for no
output of the timer signal.

GTIOCA Stop Level

Pin Level Low, Pin Level High,
Pin Level Retained

Default: Pin Level Low

Controls output pin level when
the timer is stopped.

GTIOCB Output Enabled

True, False

Default: False

Set to true to output the timer
signal on a port pin configured
for GPT. Set to false for no
output of the timer signal.

GTIOCB Stop Level

Pin Level Low, Pin Level High,
Pin Level Retained

Default: Pin Level Low

Controls output pin level when
the timer is stopped.

Callback

NULL

The ADC Framework
preconfigures and locks this
field.

Overflow Interrupt Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

Interrupt priority selection.
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Note

The example settings and defaults are for a project using the Synergy S7TG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the DTC HAL Module on r_dtc Software Activation

ISDE Property

Value

Description

Parameter Checking

BSP, Enabled, Disabled

Default: BSP

Selects if code for parameter
checking is to be included in
the build.

Software Start

Enabled, Disabled

Default: Disabled

Software start selection.

Linker section to keep DTC
vector table

.ssp_dtc_vector_table

Linker section to keep DTC
vector table selection.

Mode

Name g_transferO Module name.

Mode Block Mode selection.

Transfer Size 2 Bytes Transfer size selection.

Destination Address Mode Incremented Destination address mode
selection.

Source Address Mode Incremented Source address mode selection.

Repeat Area (Unused in Normal | Source Repeat area selection.

Interrupt Frequency

After all transfers have
completed

Interrupt frequency selection.

Block Mode)

Destination Pointer NULL Destination pointer selection.
Source Pointer NULL Source pointer selection.
Number of Transfers 1 Number of transfers selection.
Number of Blocks (Valid only in |1 Number of blocks selection.

Activation Source (Must enable
IRQ)

Software Activation 1

Activation source selection.

Auto Enable

False

Auto enable selection.

Callback (Only valid with
Software start)

NULL

Callback selection.

ELC Software Event Interrupt
Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

ELC Software Event interrupt
priority selection.

Note

The exampl e settings and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
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different default values and available configuration settings.
Audio Record ADC Framework Module Clock Configuration
The ADC peripheral module uses the PCLKC as its clock source.
Audio Record ADC Framework Module Pin Configuration
The ADC peripheral module uses pins on the MCU to communicate to external devices. I/O pins must
be selected and configured as required by the external device. ADC pins must be configured as
analog pins. The following table illustrates the method for selecting the pins within the SSP
configuration window and the subsequent table illustrates an example selection for the pins.
Note

For some peripherals, the operation mode selection determines what peripheral signals are available and what

MCU pinsare required.

Pin Selection for the Audio Record ADC Framework Module on sf_audio_record_adc

Resource ISDE Tab Pin selection Sequence

ADC Pins Select Peripherals >
Analog:ADC > ADCO

Note
The selection sequence assumes KINTO is the desired hardware target for the driver.

Pin Configuration Settings for the Audio Record ADC Framework Module on
sf_audio_record_adc

Property Value Description

Operation Mode Disabled, Custom Select operating mode for ADC.
Default: Custom

ADTRG None, P407, P102 ADTRG pin.
Default: None)

ANO0O-19 None, Pnnn, Pmmm Analog input pins.
Default: None

PGAVSSO None, PO0O3 PGAVSS pin.

Default: None

Note
The example settings are for a project using the Synergy S7TG2 MCU Group and the SK-S7G2 Kit. Other Synergy
MCUs and Synergy Kits may have different available pin configuration settings.

4.1.5.6 Using the Audio Record ADC Framework Module in an Application

The steps in using the Audio Record ADC Framework module on sf _audio_record_adc in a typical
application are:

1. Open the module using the sf_audio_record api_t::open API.
2. Start the recording using the sf_audio_record_api_t::start API.
3. Store data in a user buffer with the callback.
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4. Operate on data as needed.

5. Close the module using the sf audio_record_api_t::close API.

These common steps are illustrated in a typical operational flow diagram in the following figure:

1. Open module
open

.

2. Start recording
start

'

3. Buffer data in callback

'

4. Operate on data as needed

.

5. Close module
close

Figure 123: Flow Diagram of a Typical Audio Record ADC Framework Module Application

4.1.6 Audio Record 12S Framework

4.1.6.1 Audio Record 12S Framework Introduction

The Audio Record I12S Framework module provides a high-level API for audio recording applications
and uses the 12S interface. The Audio Record 12S Framework module uses the SSI, GPT and DTC
peripherals on the Synergy MCU. A user-defined callback can be created to indicate that new
samples are stored in the user buffer.
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Audio Record 12S Framework Module Features

¢ Thread safe

¢ Records data in 8 or 16-bit PCM

¢ Periodic callback function when new samples are available

¢ Configurable number of samples (sample count) per callback

Application

Framework
Audio Record 12S Framework
sf_audio_record_i2s
HAL Driver
ThreadX®
12S Driver
RTOS R_SSI
~———

HAL Drivers \ \

Transfer Driver Transfer Driver Timer Driver Timer Driver

R_DTC Software R_DTC Software R AGT R GPT

Activation 1 Activation 1 - -

BSP

Figure 124: Audio Record 12S Framework Module Block Diagram

4.1.6.2 Audio Record 12S Framework Module APIs Overview

The Audio Record I12S Framework module defines APIs to open, start, stop and close the recording
module. A complete list of the available APIs, an example API call and a short description of each can
be found in the following table. A table of status return values follows the APl summary table.

Audio Record 12S Framework Module APl Summary

Function Name Example API Call and Description

open g_sf audio_record _i2s0.p_api->open
(g_sf audio_record_i2s0.p_ctrl,

g_sf audio_record _i2s0.p_cfg);
Initializes audio recording framework.

start g_sf audio_record_i2s0.p_api->start
(g_sf audio_record_i2s0.p_ctrl);
Starts audio recording.

stop g_ sf audio_record_i2s0.p_api->stop
(g_sf audio_record_i2s0.p_ctrl);
Stops audio recording.

R11UMO0161EU0160 Revision 1.60 RENESAS Page 228 /5,198
Mar.29.2024



Synergy Software Package User’s Manual

Module Overviews > Framework Layer > Audio Record 12S Framework > Audio Record 12S Framework Module APIs Overview

infoGet g_sf audio_record_i2s0.p_api->infoGet
(g_sf audio_record_i2s0.p_ctrl, p_info);
Gets channel information (Mono/Stereo).

close g_sf audio_record i2s0.p_api->close

(g_sf audio_record_i2s0.p_ctrl);

Releases channel mutex and closes channel at
HAL layer.

versionGet g_ sf audio_record_i2s0.p_api->versionGet(&ver
sion);

Gets version and stores it in provided version
pointer.

Note
For more complete descriptions of operation and definitions for the function data structures, typedefs, defines, API
data, API structures and function variables, review the SSP User's Manual API References for the associated
module.

Status Return Values

Name Description

SSP_SUCCESS API Call Successful.

SSP_ERR_INVALID ARGUMENT Parameter has invalid value.

SSP_ERR_INTERNAL An internal TheadX error has occurred.

SSP_ERR_NOT_OPEN Unit is not open.

SSP_ERR_ASSERTION The parameter p_ctrl or p_sample is NULL.

SSP_ERR_IN_USE Peripheral is still running in another mode;
perform Close first.

SSP_ERR_UNSUPPORTED Command not supported.

Note
Lower-level drivers may return common error codes. Refer to the SSP User's Manual API References for the
associated module for a definition of all relevant status-return values.

4.1.6.3 Audio Record 12S Framework Module Operational Overview
The Audio Record I12S Framework Module uses the 12S HAL layer as the underlying interface for the
audio data transfer and the data captured is stored in the user buffer. The data is made available for

further processing as needed by the application.

The captured data is stored in a user defined buffer and this is done in the callback function as
illustrated below:

Assuming the name of the callback has been configured to be sf audio_record user_callback.

uintl6 t * audi o_buffer;

voi d audi o_record_user _cal | back (sf_audi o_record_cal | back_args_t * p_args)
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audi o_buffer = ((uintl16_t *)sf _audio record_ i2s.p _cfg->p _capture_data buffer

+ (p_args->buffer_index));

Audio Record 12S Framework Module Important Operational Notes and Limitations

Audio Record 12S Framework Module Operational Notes

The Audio Record I12S Framework Module configuration data can specify the name of the data buffer,
length of the data buffer, data size (8-bit or 16-bit samples), sampling iterations and the name of the
callback.

Audio Record 12S Framework Module Limitations

e The framework currently supports recording 8-bit or 16-bit PCM data.
e Refer to the most recent SSP Release Notes for any additional operational limitations for
this module.

4.1.6.4 Including the Audio Record I12S Framework Module in an Application

This section describes how to include the Audio Record I12S Framework module in an application
using the SSP configurator.

Note
This section assumes you are familiar with creating a project, adding threads, adding a stack to a thread and
configuring a block within the stack. If you are unfamiliar with any of these items, refer to the first few chapters of
the SSP User's Manual to learn how to manage each of these important steps in creating SSP-based applications.

To add the Audio Record 12S Framework module to an application, simply add it to a HAL /Common
thread using the stacks selection sequence given in the following table. (The default name for the
Audio Record 12S Framework module is g_sf audio_record_i2s0. This name can be changed in the
associated Properties window.)

Audio Record 12S Framework Module Selection Sequence

Resource ISDE Tab Stacks Selection Sequence
g_sf audio_record_i2s0 Audio Threads New Stack> Framework>
Record 12S Framework on Audio> Audio Record 12S
sf audio_record_i2s Framework on

sf_audio_record_i2s

When the Audio Record I12S Framework module on sf audio_record_i2s is added to the thread stack
as shown in the following figure, the configurator automatically adds any needed lower-level
modules. Any modules needing additional configuration information have the box text highlighted in
Red. Modules with a Gray band are individual modules that stand alone. Modules with a Blue band
are shared or common; they need only be added once and can be used by multiple stacks. Modules
with a Pink band can require the selection of lower-level modules; these are either optional or
recommended. (This is indicated in the block with the inclusion of this text.) If the addition of lower-
level modules is required, the module description include Add in the text. Clicking on any Pink

R11UMO0161EU0160 Revision 1.60 RENESANAS Page 230/5,198
Mar.29.2024



Synergy Software Package User’s Manual

Module Overviews > Framework Layer > Audio Record 12S Framework > Including the Audio Record 12S Framework Module in an Application

banded modules brings up the New icon and displays possible choices.

New Thread Stacks %) New Stack > 3] Remove

@ g_sf_audio_record_i2s0 Audio Record 125 Framework on sf_audio_record_i2s

>

& g_i2s012S Driver on r_ssi

A
I I I

- g_transferD Transfer & g_transfer! Transfer % Add Timer Driver
Driver on r_dtc Driver on r_dtc [Optional]
Software Activation 1 Software Activation 1

r r

Figure 125: Audio Record I12S Framework Module Stack

4.1.6.5 Configuring the Audio Record I12S Framework Module

The Audio Record I12S Framework module must be configured by the user for the desired operation.
The SSP configuration window will automatically identify (by highlighting the block in red) any
required configuration selections, such as interrupts or operating modes, which must be configured
for lower-level modules in order to ensure successful operation. Furthermore, only those properties
that can be changed without causing conflicts are available for modification. Other properties are
'locked' and are not available for changes, and are identified with a lock icon for the 'locked' property
in the Properties window in the ISDE. This approach simplifies the configuration process and makes it
much less error-prone than previous 'manual' approaches to configuration. The available
configuration settings and defaults for all the user-accessible properties are given in the Properties
tab within the SSP configurator, and are shown in the following tables for easy reference.

Note
You may want to open your | SDE, create the module and explore the property settings in parallel with looking over
the following configuration table settings; thiswill help orient you and can be a useful 'hands-on' approach to
learning the ins and outs of developing with the SSP.

Configuration Settings for the Audio Record 12S Framework Module on
sf_audio_record_i2s

ISDE Property Value Description
Parameter Checking BSP, Enabled, Disabled Enables or disables the
Default: BSP parameter checking.
Name g_sf audio_record_i2s0 Module name.
Name of the data-buffer to p_capture_data_buffer Data-buffer name.
store samples
Length of the data buffer 2048 Length of the data buffer.
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Audio Record Data Size 8-Bit, 16-Bit Audio record data size
selection.
Default: 16-Bit

Number of sampling iterations | 256 Number of sampling iterations.
Callback g_audio_record_framework_user | Callback name.

_callback
Name of generated initialization | sf audio_record_i2s_init0 Name of generated initialization
function function.
Auto Initialization Enable, Disable Auto initialization selection.

Default: Enable

Note
The example values and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

In some cases, settings other than the defaults for lower level modules can be desirable. The
configurable properties for the lower level stack modules are given in the below sections for
completeness and as a reference.

Note
Most of the property settings for lower level modules are fairly intuitive and can usually be determined by
inspection of the associated Properties window from the SSP configurator.

Configuring the Audio Record 12S Framework Lower-Level Modules

Typically, only a small number of settings must be modified from the default for lower-level drivers
as indicated with red text in the thread stack block. Notice that some of the configuration properties
must be set to a certain value for proper framework operation and will be locked to prevent user
modification. The following table identifies all the settings within the properties section for the
module.

Configuration Settings for the 12S HAL Module on r_ssi

ISDE Property Value Description

Parameter Checking BSP, Enabled, Disabled Enables or disables the

parameter checking.
Default: BSP

Name g_i2s0 Module name.

Channel 0 Physical hardware channel.

Audio Clock Frequency (Hertz) |2822400 Input audio clock frequency,
used to generate the 12S clock.
Must be a multiple between 1
and 128 of: (sampling freq_hz *
word_length_in_bits).

Sampling Frequency (Hertz) 44100 Sampling frequency of audio
data.
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Data Bits

8 bits, 16, 18, 20, 22, 24

Default: 16 bits

Bit depth of audio data, which is
the size in bits of one sample of
audio data.

Word Length

8 bits, 16, 24, 32

Default: 16 bits

Word length of audio data,
must be at least the same size
as the bit depth (Data Bits
field).

WS Continue Mode

Enabled, Disabled

Default: Disabled

Enable WS continue mode to
continue to output the word
select line when the peripheral
is idle. Disable to stop
outputting the word select line
when the peripheral is idle.

Audio Clock Frequency (Hertz)

External, GTIOC1A

Default: External

Select External for external
signal to AUDIO_CLK input pin
or GTIOCAL.

Name of 12S callback function
to be defined by user

NULL

A user callback function must
be registered in open. The
callback will be called from the
interrupt service routine (ISR)
when the transmission FIFO
reaches the high watermark
point after all data for
transmission is transmitted or
when reception is complete
(the requested number of bytes
have been received).

Warning: Since the callback is
called from an ISR, care should
be taken not to use blocking
calls or lengthy processing.
Spending excessive time in an
ISR can affect the
responsiveness of the system.

Transmit Interrupt Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

Transmit interrupt priority
selection.

Receive Interrupt Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

Receive interrupt priority
selection.

Idle/Error Interrupt Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Priority 12

Idle/error interrupt priority
selection.
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Note

The example values and defaults are for a project using the Synergy S7G2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the DTC HAL Module on r_dtc Software Activation 1

ISDE Property

Value

Description

Parameter Checking

BSP, Enabled, Disabled

Default: BSP

Parameter selection.

Software Start

Enabled, Disabled

Default: Disabled

Software start selection.

Linker section to keep DTC
vector table

.ssp_dtc_vector_table

Linker section to keep DTC
vector table.

Mode

Name g_transferO Driver name.

Mode Normal Mode selection.

Transfer Size 4 Bytes Transfer size selection.

Destination Address Mode Fixed Destination address mode
selection.

Source Address Mode Incremented Source address mode selection.

Repeat Area (Unused in Normal | Source Repeat area selection.

Interrupt Frequency

After all transfers have

Interrupt frequency selection.

Block Mode)

completed
Destination Pointer NULL Destination pointer selection.
Source Pointer NULL Source pointer selection.
Number of Transfers 0 Number of transfers selection.
Number of Blocks (Valid only in |0 Number of blocks selection.

Activation Source (Must enable
IRQ)

Software Activation 1, Software
Activation 2, Peripheral Events

Default: Software Activation 1

Activation source selection.

Auto Enable

FALSE

Auto enable selection.

Callback (Only valid with
Software start)

NULL

Callback selection.

ELC Software Event Interrupt
Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

ELC software event interrupt
priority selection.
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Note

The example values and defaults are for a project using the Synergy S7G2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the DTC HAL Module on r_dtc Software Activation 1

ISDE Property

Value

Description

Parameter Checking

BSP, Enabled, Disabled

Default: BSP

Parameter selection.

Software Start

Enabled, Disabled

Default: Disabled

Software start selection.

Linker section to keep DTC
vector table

.ssp_dtc_vector_table

Linker section to keep DTC
vector table.

Mode

Name g_transferl Driver name.

Mode Normal Mode selection.

Transfer Size 4 Bytes Transfer size selection.

Destination Address Mode Incremented Destination address mode
selection.

Source Address Mode Fixed Source address mode selection.

Repeat Area (Unused in Normal | Destination Repeat area selection.

Interrupt Frequency

After all transfers have

Interrupt frequency selection.

Block Mode)

completed
Destination Pointer NULL Destination pointer selection.
Source Pointer NULL Source pointer selection.
Number of Transfers 0 Number of transfers selection.
Number of Blocks (Valid only in |0 Number of blocks selection.

Activation Source (Must enable
IRQ)

Software Activation 1, Software
Activation 2, Peripheral Events

Default: Software Activation 1

Activation source selection.

Auto Enable

FALSE

Auto enable selection.

Callback (Only valid with
Software start)

NULL

Callback selection.

ELC Software Event Interrupt
Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

ELC software event interrupt
priority selection.
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Note
The example values and defaults are for a project using the Synergy S7G2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the AGT HAL Module on r_agt

ISDE Property Value Description
Parameter Checking BSP, Enabled, Disabled Parameter selection.
Default: BSP
Name g_timer0 Module name.
Channel 0 Channel selection.
Mode Periodic Mode selection.
Period Value 2822400 *2 Period value selection.
Period Unit Hertz Period unit selection.
Auto Start FALSE Auto start selection.
Count Source PCLKB, PCLKB/8, PCLKB/2, Count source selection.
LOCO, AGTO Underflow, AGTO
fSub

Default: PCLKB

AGTO Output Enabled True, False AGTO output selection.

Default: False

AGTIO Output Enabled True, False AGTIO output selection.

Default: False

Output Inverted True, False Output inverted selection.

Default: False

Enable comparator A output pin | True, False Enable comparator A output pin
selection.
Default: False

Enable comparator B output pin | True, False Enable comparator B output pin
selection.
Default: False

Callback NULL Callback selection.

Underflow Interrupt Priority Priority O (highest), Priority Interrupt priority selection.
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

Note
The example values and defaults are for a project using the Synergy S7G2 MCU Group. Other MCUs may have
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different default values and available configuration settings.

Configuration Settings for the GPT HAL Module on r_gpt

ISDE Property

Value

Description

Parameter Checking

BSP, Enabled, Disabled

Parameter selection.

Default: BSP
Name g_timer0 Module name.
Channel 0 Channel selection.
Mode Periodic Mode selection.
Period Value 2822400 *2 Period value selection.
Period Unit Hertz Period unit selection.
Duty Cycle Value 50 Duty cycle value selection.

Duty Cycle Unit

Unit Raw Counts, Unit Percent,
Unit Percent x 1000

Default: Unit Raw Counts

Duty cycle unit selection.

Auto Start

FALSE

Auto start selection.

GTIOCA Output Enabled

True, False

Default: False

GTIOCA output enabled
selection.

GTIOCA Stop Level

Pin Level Low, Pin Level High,
Pin Level Retained

Default: Pin Level Low

GTIOCA stop level selection.

GTIOCB Output Enabled

True, False

Default: False

GTIOCB output enabled
selection.

GTIOCB Stop Level

Pin Level Low, Pin Level High,
Pin Level Retained

Default: Pin Level Low

GTIOCB stop level selection.

Callback

NULL

Callback selection.

Overflow Interrupt Priority

Priority O (highest), Priority
1:14, Priority 15 (lowest - not
valid if using ThreadX)

Default: Disabled

Interrupt priority selection.

Note

The example values and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Audio Record I12S Framework Module Clock Configuration
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The Audio Record I12S Framework module uses the PCLKB as its clock source.

To change the clock frequency at run-time, use the CGC Interface.

Audio Record I12S Framework Module Pin Configuration

To use the Audio Record 12S Framework module, the port pins for the peripheral inputs and outputs
must be set in the pin configurator in the ISDE. The following table illustrates the method for

selecting the pins within the ISDE configuration window:

Pin Selection Sequence for the Audio Record I12S Framework Module

Resource ISDE Tab Pin selection Sequence

SSI Pins Select Peripherals>
Connectivity:SSI>
SSI1/SSl10/SSI1

4.1.6.6 Using the Audio Record I12S Framework Module in an Application
The typical steps in using the Audio Record I12S Framework module in an application are:
1. Initialize the module using the sf audio_record_api_t::open API.
2. Start the recording using the sf_audio_record_api_t::start API.
3. Operate on data from the periodic callback function as needed.
4. Close the module using the sf_audio_record_api_t::close API.

These common steps are illustrated in a typical operational flow in the following figure:

R11UMO0161EU0160 Revision 1.60 RENESANAS Page 238/5,198
Mar.29.2024



Synergy Software Package User’s Manual

Module Overviews > Framework Layer > Audio Record 12S Framework > Using the Audio Record 12S Framework Module in an Application

1. Initialize module
open

v

2. Start recording
start

.

3. Operate on data as needed

'

4. Close module
close

Figure 126: Flow Diagram of a Typical Audio Record 12S Framework Module Application

4.1.7 Block Media Framework on sf_block_media_lx_nor

4.1.7.1 Block Media Framework Module Introduction

The Block Media Framework on sf_block_media_Ix_nor module provides a high-level API for
interfacing with QSPI NOR flash memory devices. It provides API functions for reading, writing and
controlling the QSPI NOR Flash memory. The framework includes the Azure RTOS wear

leveling component LevelX NOR. The LevelX functions to support wear leveling are automatic and
transparent to the developer. File system accesses, using the Azure RTOS FileX system, are also
supported, making it easy to implement file system based applications.

Block Media Framework Module Features
e Supports Block Media Framework interface for NOR flash memory device.

e Supports file system access on NOR flash memory.
e Supports LevelX wear leveling functions transparently to the developer.
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Figure 127: Block Media Framework Module Block Diagram
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4.1.7.2 Block Media Framework Module APIs Overview

The Block Media Framework module defines API functions to open, read from, write to and close the
module. A complete list of the available API functions, an example API call and a short description of
each can be found in the following table. A table of status return values follows the APl summary
table.

Block Media Framework Module APl Summary

Function Name Example API Call and Description

open g_sf block _media_Ix_nor0.p_api->open(g_sf bloc
k_media_Ix_nor0.p_ctrl,

g_sf block_media_Ix_nor0.p_cfg);

Open LevelX flash device for read/write and
control. This function initializes the LevelX driver
and hardware the first time it is called out of
reset. The underlying flash needs to either be
erased or already initialized with LevelX.

read g_sf block_media_Ix _nor0.p_api->read(g_sf bloc
k_media_Ix_nor0.p_ctrl, p_dest, start_sector,
sector_count);

Read data from flash using LevelX.

write g_sf block_media_Ix_nor0.p_api->write(g_sf bloc
k_media_Ix_nor0.p_ctrl, p_src, start_sector,
sector_count);

Write data to flash using LevelX.

ioctl g_sf block_media_Ix_nor0.p_api->ioctl(g_sf bloc
k_media_Ix_nor0.p_ctrl, command, p_data);
Send control commands to Block Media LevelX
NOR driver.

close g_sf block_media_Ix_nor0.p_api->close(g_sf bloc
k_media_Ix_norQ.p_ctrl);
Close an open Block Media LevelX NOR driver.

versionGet g_sf_block_media_Ix_nor0.p_api->versionGet(&v
ersion);

Return the version of the firmware and API using
the version pointer.

Note
For more complete descriptions of operation and definitions for the function data structures, typedefs, defines, API
data, API structures, and function variables, review the SSP User's Manual API References for the associated
module.

Status Return Values

Name Description

SSP_SUCCESS LevelX flash is available and is now open for
read, write and control access.
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SSP_ERR_ASSERTION p_ctrl, p_cfg or an input pointer is NULL.

SSP_ERR_ALREADY_OPEN The block media LevelX NOR instance has
already been opened. No configurations were
changed. Call the associated Close function or
use associated Control commands to reconfigure
the instance.

SSP_ERR_MEDIA OPEN_FAILED LevelX NOR or the underlying flash failed to
open. The underlying flash needs to either be
erased or already initialized with LevelX.

SSP_ERR_NOT_OPEN The block media is not open.

SSP_ERR_READ_FAILED Data read failed.

SSP_ERR_WRITE_FAILED Data write failed.

SSP_ERR_UNSUPPORTED This module does not support requested
command.

SSP_ERR_SECTOR _RELEASE_FAILED Sector release command failed.

Note

Lower-level drivers may return common error codes. Refer to the SSP User's Manual API References for the
associated module for a definition of all relevant status return values.

4.1.7.3 Block Media Framework Module Operational Overview

The Block Media Framework on sf_block_media_Ix_nor framework module provides a high-level API
for interfacing with QSPI NOR flash memory devices while supporting wear leveling and file system
operations. Wear leveling is implemented, transparently to the developer, using the Azure

RTOS LevelX component within the SSP. File system support is implemented using the Azure

RTOS FileX component, integrated with the SSP. These components work together to make it easy to
support embedded applications that require QSPI NOR Flash file system operations.

The Block Media Framework provides API functions for reading, writing and controlling the QSPI NOR
Flash memory. In addition to these functions, all FileX related API functions become available once
the Block Media Framework module is successfully opened and initialized. Refer to the FileX User's
Manual for a complete description of these functions.

The Block Media Framework module uses a standard interface that is common to other SSP media
modules. For example, the modules that support SDMMC, SPI Flash and SDRAM/RAM memories use
the same API calls, so the programming interface remains the same for any media driver. These
modules can be interchanged with one another easily. Device adaptation drivers, such as r_gspi, are
accessed through the Memory Framework interface and provide device specific code needed to
perform media I/O operations. Configuration and control structures passed through memory
interface function calls are generally device specific as well.

Block Media Framework Module Important Operational Notes and Limitations

Block Media Framework Module Operational Notes

The media must be erased and formatted before using sf_block_media_Ix_nor for creating, writing
and reading files.

Block Media Framework Module Limitations
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Refer to the most recent SSP Release Notes for any additional operational limitations for this module.
4.1.7.4 Including the Block Media Framework Module in an Application

This section describes how to include the Block Media Framework Module in an application using the
SSP configurator.

Note
This section assumes you are familiar with creating a project, adding threads, adding a stack to a thread and
configuring a block within the stack. If you are unfamiliar with any of these items, refer to the first few chapters of
the SSP User's Manual to learn how to manage each of these important steps in creating SSP-based applications.

To add the Block Media Framework to an application, simply add it to a thread using the stacks
selection sequence given in the following table. (The default name for the Block Media Framework is
g_sf block_media_Ix_nor. This name can be changed in the associated Properties window.)

Block Media Framework Module Selection Sequence

Resource ISDE Tab Stacks Selection Sequence
g_sf block_media_Ix _nor0 Block | Threads New Stack> Framework>
Media Framework on File System> Block Media
sf block_media_Ix_nor Framework on

sf_block_media_Ix_nor

When the Block Media Framework on sf_block_media_Ix_nor is added to the thread stack as shown in
the following figure, the configurator automatically adds any needed lower-level modules. Any
modules needing additional configuration information have the box text highlighted in Red. Modules
with a Gray band are individual modules that stand alone. Modules with a Blue band are shared or
common; they need only be added once and can be used by multiple stacks. Modules with a Pink
band can require the selection of lower-level modules; these are either optional or recommended.
(This is indicated in the block with the inclusion of this text.) If the addition of lower-level modules is
required, the module description includes Add in the text. Clicking on any Pink banded modules
brings up the New icon and displays possible choices.
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Figure 128: Block Media Framework Module Stack

4.1.7.5 Configuring the Block Media Framework Module

The Block Media Framework Module must be configured by the user for the desired operation. The
available configuration settings and defaults for all the user-accessible properties are given in the
properties tab within the SSP configurator and are shown in the following tables for easy reference.
Only properties that can be changed without causing conflicts are available for modification. Other
properties are locked and not available for changes and are identified with a lock icon for the locked
property in the Properties window in the ISDE. This approach simplifies the configuration process and
makes it much less error-prone than previous manual approaches to configuration. The available
configuration settings and defaults for all the user-accessible properties are given in the Properties
tab within the SSP Configurator and are shown in the following tables for easy reference.

Note
You may want to open your | SDE, create the module and explore the property settings in parallel with looking over
the following configuration table settings. Thiswill help orient you and can be a useful *hands-on’ approach to
learning the ins and outs of developing with SSP.

Configuration Settings for the Block Media Framework Module on sf block_ media_Ix_nor

ISDE Property Value Description
Parameter Checking BSP, Enabled, Disabled Selects if code for parameter
checking is to be included in
Default: BSP the build.
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Name g_sf block_media_Ix_nor0 Module name.

Note
The exampl e settings and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the Block Media Framework Lower-Level Modules

Typically, only a small number of settings must be modified from the default for lower level drivers
as indicated via the red text in the thread stack block. Notice that some of the configuration
properties must be set to a certain value for proper framework operation and will be locked to
prevent user modification. The following tables identify all the settings within the properties section
for the module.

Configuration Settings for the LevelX NOR Common Instance

ISDE Property Value Description

Name g_Ix_nor0 Module name.

Note
The exampl e settings and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the LevelX Common Instance

ISDE Property Value Description
Thread Safety Enabled, Disabled If Enabled, this makes LevelX
thread-safe by using a ThreadX
Default: Disabled mutex object throughout the
API.

Note
The example settings and defaults are for a project using the Synergy S7TG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the Port LevelX Framework Module on sf_el_Ix_nor

ISDE Property Value Description
Parameter Checking BSP, Enabled, Disabled Selects if code for parameter
checking is to be included in
Default: BSP the build.
Name g_sf el Ix_nor0 Module name.
Event Callback NULL Name of the function to call
when an event occurs.

Note
The exampl e settings and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.
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Configuration Settings for the Memory Framework on sf_memory_qspi_nor

ISDE Property Value Description
Parameter Checking BSP, Enabled, Disabled Selects if code for parameter
checking is to be included in
Default: BSP the build.
Name g_sf memory_gspi_nor0 Module name.
Write of Erase Timeout (in ticks) | 30000 Timeout ticks for waiting on
write or erase to complete.

Note
The example settings and defaults are for a project using the Synergy S7TG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the QSPI HAL Module on r_qgspi

ISDE Property Value Description
Parameter Checking BSP, Enabled, Disabled Selects if code for parameter
checking is to be included in
Default: BSP the build.
Name g_qspi0 Module name.

Note
The example settings and defaults are for a project using the Synergy S7TG2 MCU Group. Other MCUs may have
different default values and available configuration settings.
Block Media Framework Module Clock Configuration
The Block Media framework module uses the QSPI peripheral which uses PCLKA as its clock source.
To change the clock frequency at run-time, use the CGC Interface.
Block Media Framework Module Pin Configuration
To use the Block Media framework module, the port pins for the QSPI peripheral must be set as
needed. The following table illustrates the method for selecting the pins within the ISDE

configuration window:

Pin Selection for the Block Media Framework Module on sf_block_media_Ix_nor

Resource ISDE Tab Pin selection Sequence

QSPI Pins Select Peripherals>
Storage:QSPI QSPIO

4.1.7.6 Using the Block Media Framework Module in an Application
The typical steps in using the Block Media Framework module in an application are:

1. Initialize the media using the FileX API function fx_system initialize (sf_el fx calls it automatically).
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2. Initialize the LevelX NOR using the API function Ix_nor_flash_initialize (g_common_init calls it
automatically).

3. Format the media using the FileX API function fx_media_format (sf_el fx calls it automatically if
"Format media during initialization" property is set to Enabled). This Format media is optional if
media has already been formatted. Anything on the media will erase while media format. (Optional)

4. Open the media using the FileX API function fx_media_open (sf_el fx opens the media
automatically).

5. Read the media as required using the sf block_media_api_t::read API function (Block Media
Framework) or one of the FileX API functions, for example, fx_media_read(), fx_file_read().

6. Write to the media as required using the sf block_media_api_t::write API function (Block Media
Framework) or one of the FileX API functions, for example, fx_media_write(), fx_file_write().

Note

1. After a successful fx_media_open call, all FileX APIs can be used (not just read and write).

2. If the media has been formatted by FileX without LevelX earlier, erase it using the
gspi_api_t::erase API function before initializing the file media. The erase size should be not
less than the size of the memory FileX uses. Users can disable the "Format media during
initialization" property in the project configuration, erase the FileX media and then format it
in the application.

These common steps are illustrated in a typical operational flow diagram in the following figure:
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User’s Manual

1. Initialize the media
fx_system intiialize

'

2. Initialize the LevelX NOR
Ix_nor_flash_initialize

'

3. Format the media
Ix_nor flash sector read

'

4. Open the media
fx_media_open

'

5. Read the media
read, fx_media_read, fx_file read

'

6. Write to the media
write, fx_media_write, fx_file_write

Figure 129: Flow Diagram of a Typical Block Media Framework Module Application

4.1.8 Block Media Framework on sf block_media_qspi

4.1.8.1 Block Media QSPI Framework Module Introduction
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The Block Media Framework Module can implement the QSPI channel for reading, writing and
controlling the QSPI Flash memory peripheral through the r_gspi driver. The driver has all the
functionality needed to interface with a file system through a block media interface.

Block Media QSPI Framework Module Features

e Supports QSPI channel interface for QSPI flash memory device.
e Support file system on QSPI flash memory.

Application

Framework
Block media QSPI Framework
sf_block_media_qgspi
ThreadX®
RTOS HAL Drivers
QSPI
R_QSPI

BSP

Figure 130: Block Media QSPI Framework Module Block Diagram

4.1.8.2 Block Media QSPI Framework Module APIs Overview

The Block Media QSPI Framework module defines APIs to open, control, read and write to the media.
A complete list of the available APIs, an example API call and a short description of each can be
found in the following table. A table of status return values follows the APl summary table.

Block Media QSPI Framework Module APl Summary

Function Name Example API Call and Description

open g_sf block_media_gspi0.p_api->open
(g_sf block_media_qspiO.p_ctrl,

g_sf block_media_gspi0.p_cfqg);

Open a device channel for read/write and
control.
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read g_sf block_media_qgspi0.p_api->read
(g_sf block_media_qspiO.p_ctrl, p_dest,
start_block, block_count);

Read data from a media channel.

write g_sf block_media_qgspi0.p_api->write
(g_sf block_media_qspiO.p_ctrl, p_src,
start_block, block_count);

Write data to a media channel.

ioctl g_sf block_media_qgspiO.p_api->ioctl
(g_sf block_media_qspi0.p_ctrl, command,
p_data);

Send control commands to and receives the
status from the media port.

close g_sf block_media_qgspi0.p_api->close
(g_sf block_media_qspi0.p_ctrl);
Close the open media channel.

versionGet g_sf block_media_qgspi0.p_api->versionGet(&ver
sion);

Return the version of the driver using the
version pointer.

Note
For more complete descriptions of operation and definitions for the function data structures, typedefs, defines, API
data, API structures, and function variables, review the SSP User's Manual API References for the associated
module.

Status Return Values

Name Description

SSP_SUCCESS API Call Successful.

SSP_ERR_INVALID_ARGUMENT Parameter has invalid value.

SSP_ERR_INTERNAL An internal TheadX error has occurred.

SSP_ERR_NOT_OPEN Unit is not open.

SSP_ERR_ASSERTION The parameter p_ctrl or p_sample is NULL.

SSP_ERR_IN_USE Peripheral is still running in another mode;
perform Close first.

SSP_ERR_UNSUPPORTED Command not supported.

Note

Lower-level drivers may return common error codes. Refer to the SSP User's Manual API References for the
associated module for a definition of all relevant status return values.

4.1.8.3 Block Media QSPI Framework Module Operational Overview
The Block Media Framework Interface is simply an abstract interface using function pointers instead

of direct function calls. Functions are called between FileX and the SSP block media drivers, such as
the SDMMC, SPI Flash and SDRAM/RAM. The interface remains the same for any media driver so all
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media drivers appear functionally identical at file I/O layer and can be interchanged with one another
without changing code. Device adaptation drivers, such as sf_block_media_qspi, are accessed
through the Block Media Framework Interface and provide device specific code needed to perform
media I/O operations. Configuration and control structures passed through block media function calls
are generally device specific as well.

Block Media QSPI Framework Module Important Operational Notes and Limitations

Block Media QSPI Framework Module Operational Notes

e The media must be formatted at least once before you can begin creating, writing and
reading files.

Block Media QSPI Framework Module Limitations

e Refer to the most recent SSP Release Notes for any additional operational limitations for
this module.

4.1.8.4 Including the Block Media QSPI Framework Module in an Application

This section describes how to include the Block Media QSPI Framework Module in an application
using the SSP configurator.

Note
This section assumes you are familiar with creating a project, adding threads, adding a stack to a thread and
configuring a block within the stack. If you are unfamiliar with any of these items, refer to the first few chapters of
the SSP User's Manual to learn how to manage each of these important stepsin creating SSP-based applications.

To add the Block Media QSPI Framework to an application, simply add it to a thread using the stacks
selection sequence given in the following table. (The default name for the Block Media QSPI
Framework is g_sf block_media_gspi0. This name can be changed in the associated Properties
window.)

Block Media QSPI Framework Module Selection Sequence

Resource ISDE Tab Stacks Selection Sequence
g_sf block_media_qgspiOBlock Threads New Stack> Framework>
Media Framework on File System> Block Media
sf_block_media_qspi Framework on

sf_block_media_qspi

When the Block Media QSPI Framework on sf_block_media_gspi is added to the thread stack as
shown in the following figure, the configurator automatically adds any needed lower-level modules.
Any modules needing additional configuration information have the box text highlighted in Red.
Modules with a Gray band are individual modules that stand alone. Modules with a Blue band are
shared or common; they need only be added once and can be used by multiple stacks. Modules with
a Pink band can require the selection of lower-level modules; these are either optional or
recommended. (This is indicated in the block with the inclusion of this text.) If the addition of lower-
level modules is required, the module description include Add in the text. Clicking on any Pink
banded modules brings up the New icon and displays possible choices.
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New &) New Stack >
Thread
Stacks ¥ Remove

4 g_sf_block_media_gs
pi0 Block Media
Framework on
sf_block_media_qspi

A
|

@ g_qspi0 QSPI Driver
on QSPI

Figure 131: Block Media QSPI Framework Module Stack

4.1.8.5 Configuring the Block Media QSPI Framework Module

The Block Media QSPI Framework Module must be configured by the user for the desired operation.
The available configuration settings and defaults for all the user-accessible properties are given in
the properties tab within the SSP configurator and are shown in the following tables for easy
reference. Only properties that can be changed without causing conflicts are available for
modification. Other properties are locked and not available for changes and are identified with a lock
icon for the locked property in the Properties window in the ISDE. This approach simplifies the
configuration process and makes it much less error-prone than previous manual approaches to
configuration. The available configuration settings and defaults for all the user-accessible properties
are given in the Properties tab within the SSP Configurator and are shown in the following tables for
easy reference.

Note
You may want to open your | SDE, create the module and explore the property settings in parallel with looking over
the following configuration table settings. This will help orient you and can be a useful 'hands-on' approach to
learning the ins and outs of developing with SSP.

Configuration Settings for the Block Media QSPI Framework Module on
sf_block_media_qspi

ISDE Property Value Description
Parameter Checking BSP, Enabled, Disabled Enable or disable the parameter
checking.
Default: BSP
Name g_sf block_media_qgspi Module name.
Block size of media in bytes 4096 Block size selection.
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Note
The example settings and defaults are for a project using the Synergy S7TG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Configuration Settings for the Block Media QSPI Framework Module Lower Level Modules

Typically, only a small number of settings must be modified from the default for lower level drivers
as indicated via the red text in the thread stack block. Notice that some of the configuration
properties must be set to a certain value for proper framework operation and will be locked to
prevent user modification. The following tables identify all the settings within the properties section
for the module.

Configuration Settings for the QSPI HAL Module on r_qspi

ISDE Property Value Description
Parameter Checking BSP, Enabled, Disabled Enable or disable the parameter
checking.
Default: BSP
Name g_qspi0 Module name.

Note
The exampl e settings and defaults are for a project using the Synergy STG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Block Media QSPI Framework Module Clock Configuration

The Block Media QSPI Framework module uses the PCLKA as its clock source.

To change the clock frequency at run-time, use the CGC Interface.

Block Media QSPI Framework Module Pin Configuration

To use the Block Media QSPI Framework module, the port pins for the peripheral inputs and outputs

must be set in the pin configurator in the ISDE. The following table illustrates the method for

selecting the pins within the ISDE configuration window:

Pin Selection for the Block Media QSPI Framework Module on sf _block_media_qspi

Resource ISDE Tab Pin selection Sequence

QSPI Pins Select Peripherals>
Storage:QSPI> QSPIO

4.1.8.6 Using the Block Media QSPI Framework Module in an Application

The steps in using the Block Media QSPI Framework module on sf_block_media_qgspi in a typical
application are:

1. Initialize the media using the FileX API fx_system_initialize (sf_el_fx calls it automatically).

2. Format the media using FileX API fx_media_format (sf_el_fx calls it automatically if "Format
media during initialization" property is set to Enabled). This Format media is optional if
media has already been formatted. Anything on the media will erase while media format.
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(Optional)

3. Open the media using the FileX API fx_media_open (sf el fx opens the media
automatically).

4. Read the media as required using the sf block_media_api_t::read API (Block Media
Framework) or one of the FileX APIs, for example, fx_media_read(), fx_file_read().

5. Write to the media as required using the sf_block_media_api_t::write API (Block Media
Framework) or one of the FileX APIs, for example, fx_media_write(), fx_file_write().

These common steps are illustrated in a typical operational flow diagram in the following figure:

1. Initialize media
fx_system_initialize

'

2. Format media
fx_media_format

I

3. Open media
fx_media_open

'

4. Read media
read, fx_media_read, fx_file read

'

5. Write media
write, fx_media_write, fx_file_write

Figure 132: Flow Diagram of a Typical Block Media QSPI Framework Module Application

4.1.9 Block Media Framework on sf_block_media_ram
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4.1.9.1 Block Media RAM Framework Module Introduction

The Block Media Framework Module can implement the file system on RAM for reading from, writing
to and controlling the read/write region of the RAM memory. The framework has all the functionality
needed to interface with a file system through a block media interface.

Block Media RAM Framework Module Features

e Enables FileX to be run on linear memory-mapped devices.
e Temporary and fast storage of data on RAM.

Application

Framework
ThreadX®

RTOS Block Media Fralmework
sf_block_media_ram

BSP

Figure 133: Block Media RAM Framework Module Block Diagram

4.1.9.2 Block Media RAM Framework Module APIs Overview

The Block Media RAM Framework module implements APIs to open, read from, write to and close the
module. A complete list of the available APIs, an example API call and a short description of each can
be found in the following table. A table of status return values follows the APl summary table.

Block Media RAM Framework Module APl Summary

Function Name Example API Call and Description

open g_sf block_media_ram0.p_api->open
(g_sf block_media_ram0.p_ctrl,

g_sf block_media_ram0.p_cfqg);

Open device for read, write and control.

read g_sf block_media_ram0.p_api->read
(g_sf block_media_ram0.p_ctrl, p_dest,
start_block, block_count);

Read data from RAM buffer.

write g_sf_block_media_ram0.p_api->write
(g_sf block_media_ram0.p_ctrl, p_source,
start_block, block count);

Write data to RAM buffer.
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ioctl g_sf_block_media_ram0.p_api->ioctl

(g_sf block_media_ram0.p_ctrl, command,
p_data);

Send control commands to and receive status of
RAM buffer.

close g_sf block_media_ram0.p_api->close
(g_sf block_media_ramO0.p_ctrl);
Close the framework.

versionGet g_sf block_media_ramO0.p_api->versionGet(&ver
sion);
Retrieve the API version with the version pointer.

Note
For more complete descriptions of operation and definitions for the function data structures, typedefs, defines, API
data, API structures, and function variables, review the SSP User's Manual API References for the associated
module.

Status Return Values

Name Description
SSP_SUCCESS API Call Successful.
SSP_ERR_UNSUPPORTED Command not supported.
SSP_ERR_NOT_OPEN Unit is not open.
SSP_ERR_ASSERTION A parameter is NULL.
SSP_ERR_IN_USE Framework is already open.
SSP_ERR_INVALID BLOCKS Invalid block passed.

Note
Lower-level drivers may return common error codes. Refer to the SSP User's Manual API References for the
associated module for a definition of all relevant status return values.

4.1.9.3 Block Media RAM Framework Module Operational Overview

The Block Media Framework Interface is simply an abstract interface using function pointers instead
of direct function calls. Functions are called between the FileX and the SSP block media drivers, such
as the SDMMC, SPI Flash and SDRAM/RAM. The interface remains the same for any media driver, so
all media drivers appear functionally identical at the file I/O layer and can be interchanged with one
another without changing code. Device adaptation drivers, such as the sf block_media_ram, are
accessed through the Block Media Framework Interface and provide device specific code needed to
perform media I/O operations. Configuration and control structures passed through block media
function calls are generally device specific as well.

Block Media RAM Framework Module Important Operational Notes and Limitations

Block Media RAM Framework Module Operational Notes

The media must be formatted before you can open the media and begin creating, writing to and
reading from files. The memory area used must be directly readable and writable by the core.
Internal SRAM or SDRAM size should be sufficient for the Block Media RAM and there will be no
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persistence of data across the power cycles. Block count must be assignhed by considering the boot
record, FAT area, root directory and directory sector. If the File System is used on RAM then the
minimum block count must be 4, as the first 3 sectors are reserved for boot record, FAT area and
root directory and the 4th sector is used for data sector. The "Format media during initialization"
property needs to be enabled to use RAM for FileX. The "File System is on block media" property
needs to be true inorder to configure the block count and block size from the block media RAM.

Block Media RAM Framework Module Limitations
Refer to the most recent SSP Release Notes for any additional operational limitations for this module.
4.1.9.4 Including the Block Media RAM Framework Module in an Application

This section describes how to include the Block Media RAM Framework Module in an application
using the SSP configurator.

Note
This section assumes you are familiar with creating a project, adding threads, adding a stack to a thread and
configuring a block within the stack. If you are unfamiliar with any of these items, refer to the first few chapters of
the SSP User's Manual to learn how to manage each of these important stepsin creating SSP-based applications.

To add the Block Media RAM Framework to an application, simply add it to a thread using the stacks
selection sequence given in the following table. (The default name for the Block Media RAM
Framework is g_sf block_media _ram0. This name can be changed in the associated Properties
window.)

Block Media RAM Framework Module Selection Sequence

Resource ISDE Tab Stacks Selection Sequence
g_sf block_media_ramO Block Threads New Stack> Framework>
Media Framework on File System> Block Media
sf block_media_ram Framework on

sf_block_media_ram

When the Block Media RAM Framework on sf_block_media_ram is added to the thread stack as
shown in the following figure, the configurator automatically adds any needed lower-level modules.
Any modules needing additional configuration information have the box text highlighted in Red.
Modules with a Gray band are individual modules that stand alone. Modules with a Blue band are
shared or common; they need only be added once and can be used by multiple stacks. Modules with
a Pink band can require the selection of lower-level modules; these are either optional or
recommended. (This is indicated in the block with the inclusion of this text.) If the addition of lower-
level modules is required, the module description includes Add in the text. Clicking on any Pink
banded modules brings up the New icon and displays possible choices.
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New &) New Stack >
Thread
Stacks ¥ Remove

4 g_sf_block_media_ra
m0 Block Media
Framework on
sf_block_media_ram

Figure 134: Block Media RAM Framework Module Stack

4.1.9.5 Configuring the Block Media RAM Framework Module

The Block Media RAM Framework Module must be configured by the user for the desired operation.
The available configuration settings and defaults for all the user-accessible properties are given in
the properties tab within the SSP configurator and are shown in the following tables for easy
reference. Only properties that can be changed without causing conflicts are available for
modification. Other properties are locked and not available for changes and are identified with a lock
icon for the locked property in the Properties window in the ISDE. This approach simplifies the
configuration process and makes it much less error-prone than previous manual approaches to
configuration. The available configuration settings and defaults for all the user-accessible properties
are given in the Properties tab within the SSP Configurator and are shown in the following tables for
easy reference.

Note
You may want to open your | SDE, create the module and explore the property settings in parallel with looking over
the following configuration table settings. This will help orient you and can be a useful 'hands-on' approach to
learning the ins and outs of developing with SSP.

Configuration Settings for the Block Media RAM Framework Module on
sf_block_media_ram

ISDE Property Value Description

Parameter Checking BSP, Enabled, Disabled Enable or disable the parameter
checking.

Default: BSP

Name g_sf block_media_ramO Module name.

Block size of media in bytes 512 Block size of media in bytes
selection.

Number of blocks to allocate 16 To make use of file system,
block count must be assigned
by considering the boot record,
FAT area and root directory.

Enter the valid section for RAM | noinit Enter the valid section for RAM

buffer allocation buffer allocation.
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Note
The example settings and defaults are for a project using the Synergy S7TG2 MCU Group. Other MCUs may have
different default values and available configuration settings.

Block Media RAM Framework Module Clock Configuration

The Block Media RAM Framework module uses the ICLK as the source for the internal RAM.
Block Media RAM Framework Module Pin Configuration

The Block Media RAM Framework module uses internal RAM so no external pins are required.
4.1.9.6 Using the Block Media RAM Framework Module in an Application

The steps in using the Block Media RAM Framework module on sf _block_media_ram in a typical
application are:

1. Initialize the media using the FileX API, fx_system _initialize (sf_el_fx calls it automatically).

2. Format the media using FileX API, fx_media_format (sf_el_fx calls it automatically if "Format
media during initialization" property is set to Enabled). This Format media is optional if
media has already been formatted. Anything on the media will erase while media is
formatted. (Optional)

3. Open the media using the FileX API fx_media_open (sf el fx opens the media
automatically).

4. Read the media as required using the sf_block_media_api_t::read API (Block Media
Framework) or one of the FileX APIs, for example, fx_media_read(), fx_file_read().

5. Write to the media as required using the sf block_media_api_t::write APl (Block Media
Framework) or one of the FileX APIs, for example, fx_media_write(), fx_file_write().

These common steps are illustrated in a typical operational flow diagram in the following figure:
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User’s Manual

1. Initialize media
fx_system_initialize

'

2. Format media
fx_media_format

I

3. Open media
fx_media_open

'

4. Read media
read, fx_media read, fx file read

I

5. Write media
write, fx_media_write, fx_file_write

Figure 135: Flow Diagram of a Typical Block Media RAM Framework Module Application

4.1.10 Block Media Framework on sf block_media_sdmmc

4.1.10.1 Block Media SDMMC Framework Module Introduction

The Block Media Framework module can implement the SD/MMC bus protocol for reading from,
writing to and the control of SD cards and eMMC embedded devices through the SDHI (SD Host
Interface) peripheral and the SD/MMC media driver. The driver has all the functionality needed to
interface with a file system through a block media interface.

Block Media SDMMC Framework Module Features

e Supports SDHI host interface for SD/MMC.
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e Supports SDSC (SD Standard Capacity), SDHC (SD High Capacity) and eMMC (embedded).
e Supports 1, 4 or 8-bit (eMMC only) data bus.

Application

Framework
Block Media Framework
sf_block_media_sdmmc
HAL Driver
Threadx®
SDMMC
RTOS R_SDMMC
P
P N
HAL Drivers
Transfer Driver Transfer Driver
R_DMAC Software R_DTC Software
Activation Activation 1

BSP

Figure 136: Block Media SDMMC Framework Module Block Diagram

4.1.10.2 Block Media SDMMC Framework Module APIs Overview

The Block Media Framework defines APIs for opening, reading from, writing to, controlling and
closing the SDMMC. A complete list of the available APIs, an example API call and a short description
of each can be found in the following table. A table of status return values follows the APl summary
table.

Block Media SDMMC Framework Module APl Summary

Function Name Example API Call and Description

open g_sf block_media_sdmmc_api->open(g_sf block
media_sdmmc.p_ctrl,

g_sf block_media_sdmmc.p_cfg);

Open device for read/write and control.

read g_sf block_media_sdmmc_api->read(g_sf block
media_sdmmc.p_ctrl, &destination, startsector,
sectorcount);

Read data from SD/MMC.
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write g_sf block_media_sdmmc_api->write(g_sf block
_media_sdmmc.p_ctrl, &source, startsector,
sectorcount);

Write data to SDMMC channel.

ioctl g_sf block_media_sdmmc_api->ioctl(g_sf block
media_sdmmc.p_ctrl, command, &data);

Send control commands to the SD/MMC port and
receive the status of the SD/MMC port.

close g_sf block_media_sdmmc_api->close(g_sf block
_media_sdmmc.p_ctrl);
Close open device port.

versionGet g_sf_block_media_sdmmc_api->versionGet(&ver
sion);
Get version of Block Media SD/MMC driver.

Note
For more complete descriptions of operation and definitions for the function data structures, typedefs, defines, API
data, API structures, and function variables, review the SSP User's Manual API References for the associated
module.

Status Return Values

Name Description
SSP_SUCCESS API Call Successful.
SSP_ERR_INVALID ARGUMENT Parameter has invalid value.
SSP_ERR_IN_USE The channel specified has already been opened.

No configurations were changed. Call the
associated Close function or use associated
control commands to reconfigure the channel.

SSP_ERR_ASSERTION The parameter p_ctrl or p_sample is NULL.

SSP_ERR_WRITE_PROTECTED SD or MMC card is Write Protected.

SF_INFO_NOT_AVAILABLE Information is not available possibly because
card has been removed or is defective.

SSP_ERR_NOT_OPEN The channel is not opened.

Note

Lower-level drivers may return common error codes. Refer to the SSP User's Manual API References for the
associated module for a definition of all relevant status return values.

4.1.10.3 Block Media SDMMC Framework Module Operational Overview

The Block Media Framework Interface is simply an abstract interface using function pointers instead
of direct function calls. Functions are called between FileX and the SSP block media drivers, such as
the SDMMC and the SPI Flash. The interface remains the same for any media driver, so all media
drivers appear functionally identical at the file I/O layer and can be interchanged with one another
without changing code. Device adaptation drivers, such as sf block_media_sdmmc, are accessed
through the Block Media Framework Interface and provide device specific code needed to perform
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media I/O operations. Configuration and control structures passed through block media function calls
are generally device specific as well.

Block Media SDMMC Framework Module Important Operational Notes and Limitations

Block Media SDMMC Framework Module Operational Notes

¢ The media must be formatted at least once before you can begin creating, writing and
reading files.

Block Media SDMMC Framework Module Limitations

e Refer to the most recent SSP Release Notes for any additional operational limitations for
this module.

4.1.10.4 Including the Block Media SDMMC Framework Module in an Application

This section describes how to include the Block Media SDMMC Framework Module in an application
using the SSP configurator.

Note
This section assumes you are familiar with creating a project, adding threads, adding a stack to a thread and
configuring a block within the stack. If you are unfamiliar with any of these items, refer to the first few chapters of
the SSP User's Manual to learn how to manage each of these important stepsin creating SSP-based applications.

To add the Block Media SDMMC Framework to an application, simply add it to a thread using the
stacks selection sequence given in the following table. (The default name for the Block Media
SDMMC Framework is g_sf block_media_sdmmcO0. This nhame can be changed in the associated
Properties window.)

Block Media SDMMC Framework Module Selection Sequence

Resource ISDE Tab Stacks Selection Sequence
g_sf block_media_sdmmcO Threads New Stack> Framework>
Block Media Framework on File system> Block Media
sf block_media_sdmmc Framework

When the Block Media SDMMC Framework on sf _block_media_sdmmc is added to the thread stack as
shown in the following figure, the configurator automatically adds any needed lower-level modules.
Any modules needing additional configuration information have the box text highlighted in Red.
Modules with a Gray band are individual modules that stand alone. Modules with a Blue band are
shared or common; they need only be added once and can be used by multiple stacks. Modules with
a Pink band can require the selection of lower-level modules; these are either optional or
recommended. (This is indicated in the block with the inclusion of this text.) If the addition of lower-
level modules is required, the module description include Add in the text. Clicking on any Pink
banded modules brings up the New icon and displays possible choices.
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New & New Stack >
Thread
Stacks ¥ Remove

4 g_sf_block_media_sd
mmc0 Block Media
Framework on

@ sf_block_media_sdm
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gﬁ:‘ g_sdmmc0 SD/MMC
Driver on r_sdmmc
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|

%1 Add Transfer Driver
(DMAC or DTC)
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Figure 137: Block Media SDMMC Framework Module Stack

4.1.10.5 Configuring the Block Media SDMMC Framework Module

The Block Media SDMMC Framework Module must be configured by the user for the desired
operation. The a